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Lifelong Connections.

You've got the quality customers connect with. And Kodak can help you share that 

quality by exposing your work to more people than ever before. Just sign up for our 

pro photographer locator. W ith this online tool, customers can easily find you when 

they're looking for a trusted professional photographer. After all, we’ve been 

connecting professional images and people for more than 100 years. To find 

out more, go to www.kodak.com/go/premiumpropass

Kodak Professional
Imaging Solutions

http://www.kodak.com/go/premiumpropass


HAVE 5 MINUTES?
DESIGN A BOOK!

Our new stand alone software will save you valuable time in designing 
your photo books and other press products.

• Software is FREE and PC-based • Create books and other products in minutes
• Highest quality press output in the industry • Easily create your own templates

• Images are individually color corrected • Largest selection of press products available
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W ith  a degree in th e a te r and experience w o rk in g  w ith  graphics,

Susan Stripling is well versed in v isua l a rt. "I th in k  w h a t sets m e apart is m y a b ility  to

illu s tra te  the  re la tio n sh ip  betw een  tw o  people  in a clean, s tra ig h tfo rw a rd , ye t p re tty  manner.
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ON THE COVER: "This was quite a day, and quite a 
bride,"' says Doug Gordon of Mila, a fashion publicist. 
They combed Manhattan for fashionable urban settings. 
Spotting this bright blue door in the graffiti-coverer 
wall, "I looked at Mila and she said, 'Forget about it. 
It's filthy,” ' After much pleading, the bride gave in.
” 1 shot her all over the wall. Her husband was going 
crazy, she felt like a rock star,” he says. But keeping 
the dress clean was a promise Gordon couldn't keep 
” 1 wound up in her bridal suite with a toothbrush, Ivory 
soap, a cup of water and 22 bridal party members 
watching me clean the gown like I'm painting a Picasso.' 
Gordon did manage to remove the stain, and the 
bride was thrilled with her images. Shot with a 
Canon EOS-1 Ds Mark II and 70-200m m  lens in 
available light at f/2 .8  for 1/125 second.
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FINDING BEAUTY IN 
UNUSUAL OBJECTS IS A GIFT.
GETTING THE RIGHT GEAR 
TO SHOOT IT IS ESSENTIAL.
When Jeff Dow was hired to shoot a Siemens turbine for an annual report, he was presented with two challenges: the 

reflective surface of the turbine, and its hulking 30 foot frame. With his unique creative vision and a little help from some sophisticated rigging, Jeff 

uncovered the beauty in that turbine, and what he captured brought tears to the art director's eyes. "As a photographer you have two things: your 

personality and your imagination," Jeff says. And Jeff's live-on-the-edge personality fuels his imagination for award-winning work. It’s what helps 

him land tough clients like Porsche and BMW, which is when he turns to Calumet. Jeff counts on us to 

understand his vision and present him with options. "One thing that's never a challenge is getting the right 

equipment. Calumet always has what I need,” he says. Read about Jeff's photographic challenge turned 

opportunity and see some of his breakthrough images on our website at www.calumetphoto.com/dow

CALUMET
P H O T O G R A P H I C  
IT'S WHERE THE PROS GO

1.800.CALUMET [225.8638] www.calumetphoto.com
New York Boston P h ilade lph ia  Chicago San Francisco Los Ange les Santa B a rb a ra  Santa Ana San Diego 

Be lfas t G lasgow B irm in gh am  L iverpoo l London M anchester A m ste rdam  R otterdam  A n tw erpen 'B e rth *  Oossetdorf Essen H am burg M unchen

VISIT US AT W PP I * BOOTH #259  • MARCH 24-29, 2007

http://www.calumetphoto.com/dow
http://www.calumetphoto.com


IT'S ALL HERE.
White House Custom Colour, Your Professional Photographic and Press Printing Partner



PRINT FULFILLMENT
Our Print Fulfillment program is perfect for small print orders that you want drop 

shipped directly to your client. We’ll make processing and producing orders from your 

online shopping cart easy and profitable, with the quality and turnaround you have 

come to expect from WHCC. With no minimum order size, each order simply has a flat 

$5 shipping and handling charge.

Visit pro.whcc.com/go/Start today to open your WHCC account.

White House Custom Colour is a full service, professional photographic and press printer.
For a more complete view of our services and pricing, visit our website.

www.whcc.com

http://www.whcc.com


E D IT O R IA L

Working smarter
SOUNDS GREAT... BUT HOW TO BEGIN?

Your studio’s workflow  is a personal thing. L ike the kind o f  car you 

buy or the shade o f  French blue you paint your kitchen, the choices 

you make depend somewhat on what you like, but m ore on who you 

are and the kind o f  environment that inspires and energizes you.

We all know someone (O K , a few  someones) whose life seems a 

bit more chaotic than the next guy’s. ( “ Poor Friedrich,” w e  cluck, “he 

never seems to get on top o f  things.") But 

mast o f  us live in the realm  and at the 

pace o f  our choosing, and where w e 

end up is ultimately where we’re the 

most com fortable. It could be that 

Friedrich craves a little Code Blue in 

his day-to-day doings to  keep things 

interesting; the extra adrenaline helps 

to coax out his best work.

For many o f  us though, work ing on an 

even keel is a more desirable prospect; it’s the actual organizing that 

tends to  elude. 1 may be madly in love w ith having tim e to spare as 

a deadline approaches, but the TYapper Keeper m indset that it 

requires is a treacherous lover.

I f  you think you’re ready for a little peace o f  m ind but have yet to 

find the tools to make your w orkflow  flow, turn to  “G o  W ith  the 

Flow,” p. 78, and get a leg up from  some boys wonder.

Kditor-at-I.arge Jeff Kent asked four o f  the most clever photog­

raphers w e know—thus m onth’s cover artist Doug Gordon, G eo ff 

W hite, David Jay and Kevin Kubota— to share their very best work- 

flow  ideas, tips and insights. (B v  the way, 1 don’t  think it’s a coinci­

dence that all four o f  these guvs are also producing gorgeous w ork.)

Creating a habitat and routine that works fo r your studio isn’t 

about trying to nab the Gold Star fo r organization; it’s about creat­

ing more tim e in your life to  nurture your creative flowers into 

bloom . Photography is one o f  the most imaginative and expressiv e 

fields in the world; a llow  yourself the tim e and space ( i f  that's what 

you c ra w ) to  reach your fullest potential. ■

Cameron Bishopp 

Director o f  Publications 

cbishopp@ pfKi.com

-I PROFESSIONAL n
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A  PRINTER WITH ELEVEN INKS A N D  ONE ENHANCER 
(BESIDES YOU, THAT IS.)

All too often, printing color is on awkward compromise between the quality you expect and the quality your printer 

con deliver. Not with the new HP Designjet Z3100 Photo Printer series. It has a built-in spectrophotometer that 

keeps colors accurate and consistent print to print, media to media. Uniquely, the Designjet Z3100 even features 

eleven Vivera pigmented inks, including quad-black inks, for superior color gamut and black and while prints, plus 

a gloss enhancer for exceptional gloss uniformity. And the output stays fade-resistant for more than 200 years'. 

Choose a printer that can print your vision. Not just an approximation of it.

HP PHOTOSMART PRO B9180* 

13" x 19" 8 Vivera pigmented 

inks desktop printer

HP DESIGNJET Z2100 ' 

2 4 " -  44 " pedestol printer 

with 8 Vivera pigmented inks

HP DESIGNJET Z3100* 

24“ -  44 " pedestol printer 

with 12 Vivera pigmented inks

Get up to $1,000 cash back and up to $500 in free media when you purchase
a new HP Designjet Z  Series Photo Printer with HP Extreme Upgrade!" Details at www.hp.com/go/extreme47
© 2006 itai M. T&afflat ftsdonons, <Hw.mrpKirimiaft.tnn
fcnri m WNnttxnth tan n ,  ( «  la M Mk> fa sMa mum. fa i t  HP h n l  hi KUO. boari at is** m a m  Map into gte mp HP Mauri fh«ri«a.»MKnwrgpa.eiUmmj»Saig*
fire Ik Pops and #  M maft tain (fepta) panwaK • »  aMtaari Wntanwaia) paw. Waaptari pafanow to* HP Unaai IS* Pt*v.win*tomntoMtolP>KOTnHritoMptH.M¥Pa>H»a««Mtda«200totoi6|i
**tonlr»9i«|te*rti.ta t.rsri Kf 20 r «o  v rm t on o rtmt̂  ol HP oatat trt mt* uing HP Dtnjrto! 22100/23100 |*Wo pattor Fa riot* ta*//™ * nm /p/a^tu/pim m im m u 'ItaariKUrtawMt.
"US iHidstotMCc*SripttofedtvmtoHKtofeMjatatoto^puttatonodefftoay 1.2002l*iaqhMop31.2002.FitonMbMrifldltolfcanitKlK! MStood wtotWK npfR, M  tow pnMbutri, tetri, a «-.»« ! 6* k» to ***/«$ 
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At DURY'S, we stake our 
125 year reputation 

on our promise of offering 
only high quality products 

to our customers.

TAmROn
Professional Photographers 
of America
229 Peachtree St., NE, Suite 2200 
Atlanta, GA 30303-1608 
404-522-8600; 800-786-6277 
FAX: 404-614-6400 
www.ppa.com

Tamron delivers on that promise.

The SP AF17-50mm F/2.8 is a 
lightweight, compact, fast standard 
zoom lens designed exclusively for 
digital SLR cameras, expanding the 
product concept o f the popular SP 

AF28-75mm F/2.8 zoom lens.

$439.99
after rebate

DURY'S
701 Ewing Avenue, Nashville, Tennessee 

800-824-2379 www.durys.com
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DEBORAH BUFF 
photo by Paul Buff 200620° G rid  - $ 6 0 .0 0  

Gels / Filters - $ 2 9 .9 5 both shot with one ABR800 and Moon 
Unit with mask shown (ISO 100, f22)

.com

A L IE N B E E S  GOES W H ER E  
NO S TU D IO  FLA S H  HAS BEFORE.
Enter the ABR800 Self-Contained Studio Ringflash System.

The ringflash concept is simple: surround the lens with a large, circular flashtube so 
that light wraps around the subject at all angles to  provide essentially shadow-free 
lighting. Low power ringflashes attach to  the lens and are used fo r shooting close, 
small objects, but are not suitable fo r studio work. Industrial ringflashes are in vogue 
fo r elite fashion photographers, but they cost thousands and have limited function. 
Most weigh around five lbs., require a power pack, and have no modeling lamps o r 
fans. W ith  the camera, the weight and bulk inhibits hand-held use and the lack o f 
accessories or design ingenuity limits creative use.

A B R 8 0 0 S P E C S

VARIABLE FLASHPOWER: 
from 10 to 320 real ws 
(5 f-stop ronge)

FLASHTUBES / MODELING 
LAMPS: 2 semi circle flash 
tubes: 8 modeling lamps (total 
output comparable to a ISO 
W att lamp), full, o ff  or track

ACCURACY: l / I O f  stop typical 
repeatability accuracy

OUTPUT (ISO 10 0 .10 ): f  16 
with standard reflector: fB to 
f l  I with Moon Unit

T.S FLASH DURATION:

112000 sec. a t full power

COLOR TEMP: S500°K at mid 
power. + /- 200° at other levels

RECYCLE; I sec. recycle to full, 
proportionally faster a t reduced 
power settings

SIZE: 1 0 x 6  inches with the 
reflector; 4-inch center hole

TheABR 800 Ringflash - 

$ 3 9 9 .9 5
The MU30 Moon U n it - 

$ 5 9 .9 5

Set o f Masks - $ 3 9 .9 5  
MU30 & Masks - $ 8 9 .9 5

O ur ABR800 addresses these issues with a low-cost, self-contained ringflash that 
incorporates all o f the features needed for fashion, product and architectural work. 
Plus, it goes well beyond pre-conceived notions about what a ringflash is and what it 
can do. And it’s Vagabond-compatible for outdoor use and portable power needs.

The ABR800 weighs just 2.5  lbs. (with the built-in power supply) and incorporates 
eight high intensity, proportional modeling lamps and a cooling fan for rapid, all-day 
shooting. A t 3 2 0  high-efficiency real wattseconds, the ABR800 achieves f l I -f22 
exposures in most studio uses, while its 5 f-stop variable power range allows it to  be 
dialed down fo r low-aperture shots for limited depth o f field. Standard AlienBees 
controls allow full remote capability, slave-syncing, modeling lamp control and more. 
The unit ships with a universal camera mounting system that supports virtually 
all popular digital SLR and prosumer cameras. Also standard are the diffuser / gel 
holder, our 80° reflector an umbrella holder fo r off-camera use as well as the power 
and sync cords, modeling lamps and flashtubes. Available accessories include our 20° 
donut-shaped honeycomb grid, a set warming and diffusion gels and filters and...

The Astonishing Moon Unit.

Snap on this unique accessory and your ABR800 becomes a rotating, 30-inch round 
softbox o r octabox that you can shoot your lens through. Its minuscule depth and 
weight allow hand-holding right along with your camera or you can use it as a off- 
camera compact softbox. Take o ff the diffuser and you have a gold o r silver aim- 
through bounce umbrella. Remove the reflector for a halo o f softer light surrounding 
the bright direct ringflash. N ow  add our exciting Mask Set to  alter the shape o f the 
light to  create a giant ring o f stars, clouds, half-moons and a host o f other shapes 
including your own custom creations. Some are designed to  produce more light at 
the top  than at the bottom  to  produce subtle modeling shadows that define facial 
features in a brand new light. Then there are the catchlights. Instead o f the time-worn 
rectangular o r round eyelights that appear in uncontrollable positions, you can have 
any shape that you want, perfectly placed. Indeed, this is not your father's ringflash.

PAUL BUFF 
photo by Deborah Ruff 2006

AlienBees is a division o f PAUL C. BUFF, INC. • 2725 Bransford Avenue • Nashville,TN • 37204 • Local 6 15-383-3982 • Fax 615-383-0676 • E-Mail info@alienbees.



a n d
Monday, June 25 - Wednesday, June 27, 2007

1 he W estin  &  Sheraton G rand Bahama
Connected to the conference center, casino, spa, and a fabulous beach

( ( a n d  | j a  l l a m a  J d

Wmm k  f

vv>vw.ourlucava.cotn

white past attendees have said:

“ ( (  hicks W h o  C lick ) motivates and inspires me to be the most 
and best I can be at everything, not just w ork .”

It covers all the bases - a real homerun!

It’s a great investment lor m y business and what I do !”

I he most amazing group o f wom en! So inspirational!”

Register by June 11, 2007 for only $249 ($299 after June 11) 
Special Student Rate $75

Register online at http://events.ppa.com or call 800-786-6277

FUJIFILM K

http://events.ppa.com
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PPA ’s Retreat fo r  W om en  in  P h o to g ra p h y

R e d isco ve r. R e c o n n e c t. R e ch a rg e . R e lax

Join som e o f  the m ost spectacu lar and  insp iration a l w o m en  at the 2 007  C h ick s  W h o  C lic k ®  retreat and  
you ’ll leave w ith  lessons an d  m em ories that w ill forever im pact y o u r  life  an d  y o u r business.

W hen: M onday -  Wednesday, June 25 -  27, 2007

W here: Conference Center adjacent to the W estin and Sheraton Hotels.

Reserve y o u r ro o m  by M a y 29, 2 0 0 7  to  guarantee th is  special rate. Room s are o ffered a t th is  d isco u n te d  rate 3 days p r io r  and 3 days a fte r 
the  co nve ntio n  dates...so  come early and  stay late!

Sheraton G ra nd  Baham a Is land  O u r  l.ucaya Resort W estin  G rand Baham a Is land O u r  I.ucava Resort

G rand  Bahama Is land  Bahamas •  Phone (2 42) 373  1444 G ra nd  Bahama Is land Bahamas • Phone (2 42) 3~3  1333

R oom  rate: S109 - $16 9  w ith  an Is land  V iew  Room  rate: $ 13 9  - $199  w ith  an Is lan d  V iew

S I 89 — $ 2 4 9  w ith  an Ocean V iew  $ 21 9  -  $27 9  w ith  an Ocean V iew

Sneak Peek at Classes
I ’m B rin g in g  SexyBack!

M a ry  F isk-Taylor. M.Pbotng.Cr.. CPI’ A lii, API 

Monday, June 25, 2007 

8:00am - 9:00am

Learn the steps M ary has taken to b ring  SexyBack 

to her studio, photography and overall a ttitude.

You’ll see and learn m arketing tips, advertising 

ideas, beautiful images, and fun n y  stories through 

her innovative journey.

Th e  A r t  o f  R e in ven tion  

M o n ica  S igm on, Cr.Photog., CPP 

Monday, June 25, 2007 

9:30am - 1 1:00am

Monica w ill o ffer realistic solutions fo r issues that 

often paralyze both new business owners and 

established photographers. She w ill address niche 

marketing, how to p u t yourself in the m ind  o f  your 

client, and how  to achieve and m aintain the business 

image that best represents your w ork.

The B ou tique S tud io  R evo lu tion  

A nn M o n te ith , M.PhotogCr.Hon.M.Phorog., CPP. A III 

Monday, June 25, 2007 
4:00pm - 6:00pm

Ann w ill explore the characteristics that make 

boutique studios” successful: creating a focused busi­

ness concept w ith  a clear p roduct and brand message; 

know ing the studio's ideal client; developing p ho to ­

graphic products that excite the market and 

literally sell themselves; and b u ild in g  repeat business.

T h e  D ream  Team

Kay E skridge, M.Photvg.Ci.. CPP &

M a ry  F isk-Taylor, M.Phocog.Cr.. ( / ’/ ’ &

Stacey C a nfie ld , M.Photog.C CPP 

Tuesday, June 26, 2007 

6:30am - 11:00am

See how Stacey photographs a high school senior; 

M a ry  photographs a bridal couple; and Kay 

photographs a fam ily...all in a live demo on the 

beach. Compare how they interact w id i clients, 

the equipm ent they use from  camera to lens 

selection, the ir unique posing and ligh tin g  

techniques, and the methods they use throughout 
each step o f the ir studio w orkflow .

As att added bonus: chose coining back early from  die 

break w ill also see Kay, Mary, and Stacey’s different 

sales

techniques, as well as the marketing ideas and materi­

als

r lm r use to keep their studios busy all year round.

D ig ita l A rtis try—- A  W om an ’s Touch 
Helen Yancy. \1.Phorog.M.Arrist.MHI.( r I Itm.M.PIunng., ( 77.' 
API
Tuesday, June 26, 2007 

4:00pm  - 6:00pm

Helen’s style combines the magic of d ig ita l 

photography w ith  the trad itiona l methods o f  a 

portra it painter. I .earn how you can create h igh-end 

products to enhance your business image and fu lf il l 

yo ur creative passion.

D istingu ish  Your S tud io  W ith  C rea tive  

Use o f  T ech n o logy  

Jane Conner-Ziscr < r.Photog.. API 

Wednesday, June 27, 2007 

8:00am - 10:00am

Jane shares how to  use technology to o ffe r expanded 

portra it lines, innovative new products, and creative 

services. Using Photoshop and Painter, plus a host of 

p lug-ins, Jane w ill dem onstrate how to blend eye­

catching images and classic p ortra it arts in to  lucrative 
products for your business.

T h e  O n e  and O n ly  

I.iana Lehman

Wednesday, June 27, 2007 

2:00pm  - 4 :00pm

I.iana knows i t ’s the delicate balance o f  the 

extremes— photography and business -that breeds 

success. Learn how understanding yo ur own 

strengths and weaknesses in both photography and 

business w ill a llow  you to  live your own dreams and 

take your photography business to the next level.

P ro lon g  the Passion 

I.i/.beth Guerrina M.I’luitogA it.
Wednesday, June 27, 2007 

4 :3 0 pm  - 6 :30pm

Refresh your creative energy! I.i/.beth discusses 

balancing the personal w ith  the professional in the 

field o l professional photography. A fte r all, you arc an 

artist. Revel in your unique g ift— the o p p o rtu n ity  to 

live a creative lifestyle.

Registration

Cancellation &  Refund Policy
Registrations cancelled before June 4, 200“’ w ill be charged a $25 
cancellation fee and the balance w ill be refunded. No refunds w ill 
be given for registrations cancelled after June 4, 2007.

Online: http://cvents.ppa.com
By Phone: 800-786-6277
By Mail: go to http://cvcnts.ppa.com, click on the Chicks Who ( lick
registration form, f ill in and p rin t the form, and mail w ith payment to:
PPA hvent Registration
229 Peachtree Street, Suite 2200
Atlanta, GA 30303
Please make checks payable to PPA.

http://cvents.ppa.com
http://cvcnts.ppa.com


Culled from the files of the PPA Loan 
Collection, Folio is a monthly sample of 
award-winning photography by PPA 
members. The Loan Collection is a select 
group of some 500 photographs chosen 
annually by the PPA print judges from 
more than 5,000 entries.

BETH PACHTER 
At the end of a family portrait 

session, Beth Pachter, M.Photog.Cr., 
CPP, of Pachter Photography /  

Candidly Beth in Ballston Spa, N.Y., 
coaxed this 2-year-old into showing 

off some ballet moves. Shooting 
with a Canon EOS-1D Mark II digital 

SLR and Canon 24-70mm f/2.8 EF L 
USM lens, Pachter exposed "I'm 

Only Two-Two" for 1/180 second at 
f/8 , ISO 200. A 2.500WS 

Photogenic PowerLight 2500DR 
flash behind a 36-inch soft box 

provided the main lighting, and a 
400WS Norman flash and 13x40- 

inch Larson Soff Box provided fill. A 
second 400WS Normal flash and 

soft box served as hair light.

iatthe indlO’P ::I3oy. haven't wo all been here? A delicate little

subject unwilling to participate any longer. Great storytelling image. I applaud the placement o f the subject 

am! the image in the presentation. 1 he pinks of the tutu are repeated in the background, which adds that 

much more impact to this image. I feel this image would he improved by just a few things. First, the 

background offers two very different patterns, thanks to this high angle. This could have been improved by

lowering the camera angle slightly. 1 his image-maker has a great eye and is to be commended for seeing 

this wonderful little Story and portraying it.” - T im  Walden, M.Photog.Cr., F-ASP. and PEC Committee member.
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W h a t w as C anon th inking w hen  th e y  developed th e  only 
c a m e ra s  available w ith  a 3 5 m m  F u ll-F ram e C M O S  S e n s o r? *

Exactly w h a t I w as  thinking

|  S m  Bruce Dorn One of the most important aspects of portrait shooting is communication.
'■ JB w  Establishing a rapport and understanding what the subject wants is the first step to a great shot, 

it s very much the same thing that Canon does. They listen to photographers like me, and they respond to 
my need for capturing incredible detail. And with the full-frame CMOS sensor in the EOS-IDs Mark II and the 
EOS 5D, I get the resolution needed for making big, beautiful prints, just like my old medium-format cameras. 
Mot to mention the fact that with no conversion factor, my favorite portrait lens, the EF 24-105mm f/4L IS USM 
acts exactly as it should. And with the smaller, lighter EOS 5D, that technology goes wherever l go. And, when 
you add a PIXMA Pro printer into the workflow, well, now you're tolking.

mogcANYWARE

PULL-FRAME CMOS SENSOR • 12.BC5DV16.7(1 Ds Mark II) MEGAPIXELS • DiGICil IMAGE PROCESSOR • 3501/4(108 Mark ill FRAMES-PER SECON f

To learn more about the full-frame CMOS sensor, visit the Canon Digital Learning Center at www.photoworkshop.com/canon

ArfrShtc3000 ,nc Canon- ^  and DtGICare registered trademarks and PIXMA is a trademark cf Canon Inc. in ttte United States arid may also be registered trademarks or trademarks m other countries, }MAGEA?JVYVAP£ is a trftjema** o*
' .  9  reserved. For more information, visit us at www.usa.canon.com/consumer or cai! 1-800-OK-CANON * As of May 2006

http://www.photoworkshop.com/canon
http://www.usa.canon.com/consumer


©Andie Goodman

ANDIE COODMAN
Her attention caught by the unusual color of this 
water lily at Longwood Gardens in Kennett 
Square, Pa., Andiq Goodman, of Goodman & 
Associates in Lancaster, captured "Purple 
Passion." Shooting with a Fujifilm FinePix S602 
Zoom digital camera with a built-in Fujinon 35- 
210mm f/2.8 lens, Goodman exposed the image 
for 1/60 second at f/8 , ISO 160. Goodman used 
Adobe Photoshop to clean up the water around 
the lily and slightly darken the image. In addition 
to its place in the Loan Collection, the image has 
been sold on note cards and as wall art.

ELAINE MCDONALD 
Elaine McDonald of Four Winds Photo Art in 

Colorado Springs, Colo., stumbled across this 
colorful scene while testing a new lens on a visit 

to Tucson, Ariz. Armed with a Nikon D200 
digital SLR and Nikkor 18-200mm f/3.5-5.6 ED- 

IF AF-S VR DX Zoom lens, McDonald exposed 
"Crayola Town Passage" for 1/250 second at f/8 , 

ISO 200. She performed minor retouching in 
Adobe Photoshop. "I was struck by the colors 

and the lines," says McDonald.

18 • www.ppmag.com
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“ Show big, sell big. Let your needs, not the limitation 
o f your printer, dictate size.”

Bruce Dorn brings a fresh, dramatic look to portraiture, enriched by his diverse professional experience in 
photojournalism, advertising photography and filmmaking. “ The imagePROGRAF iPF9000 printer delivers 
the speed, consistency and reliability I need, ” said Dorn. “It happily accommodates a seemingly limitless 
variety o f commercial grade and fine art media, and it covers immense acreage in very short order. ” 
Canon’s FINE (Full-photolithography Inkjet Nozzle Engineering) ultra-high-density dual print heads help 
ensure large-format output with exceptional detail and tonality at very fast printing speeds. The heads

are user-replaceable, so maintenance 
is easy. Dorn adds, “Like musicians 
and their instruments, digital artists 
must achieve ‘oneness’ with the tools 
we wield. For my purposes, none are 
finer than those offered by Canon.”

imagePROGRAF iPF9000
EOS 5D

Ask professional photographers who depend on Canon. With reputations and livelihoods on the line 

/ l a s l e w  W'th evcry choice ,hey make. Canon innovation speaks directly to their needs and desires for better 
tools. The imagePROGRAF iPF9000 is part of Canon’s total workflow system, a system of tools that puts 

leading-edge technologies at the service of creative expression, and brings joy, efficiency and quality to the journey from 
concept to print. Find out more at the Canon Digital Learning Center: http://photoworkshop.com/canon

mageANYWARE
r ?utPut 'ma8e simulated.

1-.C'AI1 nghts reserved- Canon and EOS are registered trademarks, and imagePROGRAF is a trademark of Canon Inc. in the United States and may also be registered trademarks or trademarks in other countries. IMA6EANYWARE is a 
iraoemanc of Canon. Visit us at www.usa.canon.com/consumer or cali 1-800-OK-CANON

http://photoworkshop.com/canon
http://www.usa.canon.com/consumer
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Frederika wanders across the field at dusk looking fo r the moon, 2005

m e r ic a n Duane M ichals ’ 

double life

o n
B Y  E L L I S  V E N E R

Both images ©Ouane Michals/Courtesy Pace/MacGill Gallery, New York
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Duane Michals has led a double life fo r the 

past 40-odd  years. Internationally known as 

an art photographer with an impish wit, he also 

has a long history as a w ell paid advertising 

and editorial photographer. He is immensely 

proud o f  that body o f  work. W hether it’s art 

or commerce, he keeps it simple: a Canon 

35mm camera, a tripod, a couple o f  lenses, 

the available light, and bunches o f  ideas.

A t the 2006  Lucie Awards, where he was 

honored fo r Achievem ent in Portraiture, he 

told jokes rather than using his allotted 20 

minutes to pontificate on the sublime grandness 

o f  his art. In conversation he is a funny, charm­

ing guy. Only later do you feel that he moved

like a boxer in conversation, fein ting and 

weaving while checking you out. Get past the 

jokes and the visual puns and you find a man 

who is very serious about art and why it matters.

A s an artist he owes explicit debts to 

Belgian surrealist painter Rene Magritte, to 

the Greek poet Constantine Catavy, and even 

m ore to  the Am erican poet W alt W hitm an. 

An honest man, he acknowledges those debts 

often and explicitly. He says lie’s not interested 

in what som ething looks like but in why he 

responds to  it the way he does. I le's openly 

interested in spirituality and the quest for 

enlightenment. “ I'm curious about everything.”

W ith his latest book, “Koto Follies: I low

Photography Lost Its V irginity on the W ay to 

the Bank,”  he bites the hand o f  the art world 

that feeds him. W ith precision, he punctures 

the ostentations o f  certain artists, critics, dealers 

and collectors, calling them “Fartsters... who 

confuse fashion w ith art." In “Tattle Tales 

from  Th e  Land o f  Fauxtography,” Michals’ 

alter ego, Dr. Dtianus, tells us, “An  gxlO-inch 

photograph by Robert Frank can be heroic. 

An  8x l0 -foo t [A n d re a s ] Gursky is just a 

billboard with pretensions.” And he wonders 

i f  “ Richard Prince is the new art royalty, 

where is Robespierre when we really him ?"

W hat makes photography matter for 

Michals is honesty, not irony; humor not camp.

M agritte  w ith  Hat, 1965
March 2007 • Professional Photographer • 21
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In a tony neighborluxxl in W ilm ington, Del., 

I .aura Novak Photography stands alone. Not 

the building. It's nestled am ong other 

boutique shops o f  all stripes in the largely 

residential area. But it is the only boutique 

photo studio in W ilm ington, a niche 

proprietor I ju r a  Novak anchors with 

focused marketing and vogue interior design 

for her studio o f  tine art portrait and 

wedding photography. In the Novak 

business model, everything that comes in 

contact with clients is branded and refined, 

from shopping bags and W eb site to 

furnishings and studio location.

Creating the studio was no small feat.

The century-old building had been a dentists 

office, then was abandoned. It was in such bad 

repair that one misstep could land you in the 

basement. There were no interior walls, no 

ceiling. An unattached toilet sat in the middle 

o f  the space, and that was it. "But 1 saw the 

potential and loved the location," Novak says.

Nam ed one of kodak's Emerging Photog-

22 • www.ppmag.com

raphers to Watch in 2007— one o f  only two 

nationwide— Novak hits been shooting for 

just four y ears. Yet her work has won prizes and 

garnered national and international attention, 

including exposure in Modern Bride, The 

Sere York Times and The Knot. Business is 

so g<xxl she's rapidly outgrowing the barely 

one-year-old studio space. In fact, this 

spring Novak w ill m ove her shooting room 

several blocks down the street to the heated 

garage o f  an historic mansion so she can 

expand the studio's production workspace.

Professional Photographer asked Novak 

to share some o f  her strategic marketing and 

interior design ideas.

Professional Photographer: 11 ho designed 

pour logo?

1 aura Novak: 1 did. although 1 did collaborate 

with a designer. I wanted it to feel a little 

vintage but also m odern and clean, some­

th ing easily identifiable. I use the scroll

(continued on p. 2 4 )
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You: Shoot.
Sort, rotate, categorize, and post your images, launch 
the site, notify your customers that the site is live, 
present your images in a beautiful and easy-to- 
navigate interface, give your customers the ability 
to easily share the site with family and friends, make 
ordering professional photographs online simple, 
handle all online credit card transactions, produce 
quality prints on Kodak ENDURA™ paper, ship images 
to your studio or your customers, and provide 
friendly and knowledgeable customer service.

You: Get paid every Friday.

Introducing Collages.net's Full Service workflow
Whether you want complete control or complete peace o f mind when it comes to your 
workflow, Collages.net is the business partner you can depend on to get it all done.

At no additional cost, Collages.net's Full Service workflow enables you to spend less 
time in front o f the computer and more time behind the lens.

Visit online or call today: (877) 638-7468.

YOUR TOTAL WORKFLOW AND PRINTING SOLUTION collages.net
©2007 Collages.net Inc. All rights reserved.
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(continuedfrom />. 22) 

everywhere— letterhead, cards, stickers, and 

inside the studio. For example, 1 had the 

scroll stenciled on the h a lf wall in reception 

area and on the table in the kiddie nook. It ’s 

branding that people can see. W hen things 

look and feel the same inside and outside 

the studio, it reinforces the professionalism 

and makes people feel as though they are 

connected to the business they’re investing in.

Did you do the interior design yourself '?

Yes. When it came to  purchasing decisions, I 

chose my battles wisely. The desk in my office 

cost $150, whereas the seating room furniture, 

which I bought in Georgetown in Washington, 

D.C., was expensive. Everything related to 

presentation was expensive, but I saved 

money on areas clients rarely see. I chose the 

brown and blue color scheme because I wanted 

both cool and warm. Th e  cool makes it 

modern and the brown makes it comfortable. 

For fun, 1 put little tangerine accents through­

out, like the p illows on the brown chairs in 

the reception area. And chocolate is such a 

nice background for color photos. In the 

long, narrow hall leading from  the front to 

the back, I have five 24x36 standouts hung 

on the chocolate wall. People love them.

1I 7io/ is your design philosophy ?

I created this place so that if  i were a client,

1 would want to purchase som ething here. 1 

think the experience people have when they 

walk in the door is very important. Customer 

service is also important, but what people 

see anil feel are equally important.

It 7x// urre your biggest design challenges? 

The space is long, narrow and small, only 

1.200 square feet. To make it lixik larger, 1 

used an old design trick. We placed horizontal 

dark blue stripes painted on the light blue walls 

in the front to elongate the studio, making it 

feel bigger. Because the reception and produc­

tion areas share the same space, 1 wanted to

separate but not isolate them. I had a ha lf 

wall built and then hung from  the ceiling 

above it 10 6-foot-long fishing lines with 

wallet-size metallic photos hanging from  

each. This keeps the separation translucent.

There's innovative wallpaper in the bathroom. 

117tats up with that?

(Laugh ing) Yeah, 1 created a photo collage 

o f  m agazine features I've done on the wall. 

There are layouts from  lots o f  magazines, 

like Tin Knot, Philadelphia Elegant 

Wedding%v\ Modern Bride. I don’t have a 

b ig enough ego to fram e all the magazine 

features, but it was self-deprecating enough 

fo r  me to put them in the john  so people can 

see them.

I f  you had it to do m rr  again, what would 

you do differently?

I designed for beauty, but not storage. I ’d 

definitely have installed more shelving!

To see Laura Novak’s photography, visit her 
web site at utL-ic.novakphotography.com.

Loma Gentry is a freelance xcriter in Atlanta.
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m n

After 73 years, we decided that our products 

are not so "general" after all. They're actually 

quite specific. So we're changing our name 

from General Products to GP Albums. It's a 

whole new look with the same great quality.

albums
800.888.1934

e-mail: inquiry@gpalbums.com 
www.gpalbums.comYour Photos. Your Life.

mailto:inquiry@gpalbums.com
http://www.gpalbums.com
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A  world of photography
PPA continues commitment t o  international relations b y  j e f f  k e n t

I t ’s no secret that the international busi­

ness landscape has changed dram atically 

over the past few  years. Im proved tele­

communications, the proliferation o f  the 

Internet and the rapid advancement in 

digital information delivery have enabled a 

truly global marketplace. Professional 

photography is at the forefront o f  the 

trend. Photographers are no longer bound 

by narrow geographic boundaries. Those 

w illing to engage the new technology and 

ply the global waters can truly sell their 

services worldw ide.

Professional Photographers o f  Am erica 

(P P A ) has long encouraged such outreach 

by strengthening the ties w ith its inter­

national affiliates and other photography 

organizations worldwide. Partnerships among 

these organizations are vital to  the future

prosperity o f  pro photographers every­

where, not just those in the Un ited  States.

A s the g lobalization o f  the industry 

continues, success fo r photographers o f  

all nationalities w ill be built on  open 

in form ation  sharing and coordinated 

efforts on beha lf o f  the profession.

“We want to help raise professional 
standards throughout the industry, 
across the planet. The idea is to raise 
the awareness and get people from 
different countries to sit down and talk.”

-R O N N IE  NORTON
PROPRIETOR OF THE DUBLIN, IRELAND, NORTON ASSOCIATES

OurPPA.com
A free online community for all professional photographers

o
o

Want to know what other photographers are doing to get their existing 
customers to return? OurPPA.com is the place for you.

Thinking about buying a new camera and want some real-life feedback 
from photographers who are already using it? Opinions ore just a dick 
away at OurPPA.com.

o Ready to redesign your website? Get ideas and input at OurPPA.com.

Looking for ways to find new customers? Learn what other photographers 
are doing at OurPPA.com.

You're really missing out if you're not a member of the growing community at 
www.OurPPA.com. Home to thousands of organic conversations that change 
minute-by-minute, it's free to join and offers discussion threads on a wide 
variety of topics.

Already a member?  Log on today to catch up on the latest conversations.

Not a member yet? It's free -  go to www.OurPPA.com today to start 
chatting, asking questions, sharing ideas and posting image galleries in this 
robust community that serves the entire photography industry.

Q p Q  OcRPPACOM (1rt, _  . ■

Professional Photographers o f  Am erica

www.OurPPA.com
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“W e want to  help raise professional 

standards throughout the industry, across 

the planet,” explains R onnie N orton , 

proprietor o f  the Dublin, Ireland, N orton  

Associates and the first non-Am erican  

mem ber o f  the PPA  board o f  directors.

“The idea is to  raise the awareness and get 

people from  different countries to sit down 

and talk. There ’s always been a fear bv PPA  

members that we com e on too  strong 

outside o f  our jurisd iction, that P P A  

shouldn’t force its way abroad. But PPA  

has a great deal to  offer, and photographers 

from  other counties are eager fo r  access to  

those resources.”

A t the January 2 007  Im aging  USA in 

San Antonio, I’ PA's global outreach was 

recognized at a special international 

reception. Groups from  several nations 

were in attendance, including a first-tim e 

visit by a special delegation  from  China. 

Don M acGregor, chairman o f  the PPA 

International Com m ittee, extolled the 

virtues o f  international partnerships and 

encouraged PPA  to  continue its efforts.

PPA is very open to input from  around 

the world,” he com m ented. “W e want to 

ensure that it remains an extrem ely open 

association,”

PPA CEO  David Trust agrees w ith those 

sentiments, and adds that PPA’s efforts to 

im prove international relations are far 

from over. “Our board o f  d irectors has led 

the way in the association’s drive to  be 

more international,” he says. “They  care 

very deeply about the welfare and success 

of photographers— not just photographers 

in the United States, hut photographers all 

around the world.”

I'or more information on the international 
reception and to hear comments by 
the Chinese delegation, visit 
h ttp://i usatv. i  magi ngusa.org.

Your monitor,
Your GTI viewer, & You...

The basic ingredients for Perfect Color.
On!'y GTI can guarantee tight-tolerance viewer to viewer 
visual compatibility based on ourefprietary 
Graphiclitft 100 Color Viewing Lamps.

-because you 
& your clients 
demand the best!

GTI Graphic Technology Inc.y  qltyP:888.562.7066 . f .845-562-2543 
'L ight  www.gtilite.com • sales@gtilite.com

o to ge n ic
ofessional o  ligh t ing

w w w .P h o to g e n ic .c o m  • (8 0 0 )  6 8 2 -7 6 6 8 \*  S a le s@ P ho tog e n ic .co m

’Mane'” by Joseph & Louise Stmone

l  0  • 125. 5 0 0  or 1 0 0 0  watt-seconds 
• Optional Built-In R adio Receiver.

For Wireless Trigpeting
• O p tion a l w ire le s ir l i in r . t io o  . a i m #  

(fo r DR m o d © IfJ .
A cce p ts  a ll G u ic ^ h a n c je rw A cce sso .o « if

Reliability.
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Quantum's Latest:
Qflash 5d-R/FreeXwire® System
Now TTL-Ratio Control For Digital Cameras!

I M H

BREAKING
Call 631-656-7400, visit www.qtm.com or your professional photo dealer for more information.

To help you to accomplish that, Professional 

Photographers o f  Am erica (P P A ) and the 

Society o f  Sport &  Event Photographers (SE P ) 

have created the Sweepstakes Marketing Qxrper- 

ative (Co-op). Developed specifically fo r PPA 

and SEP members, the marketing co-op 

gives you access to  three national sweep- 

stakes run by a third-party' contest 

administrator. W hen you jo in  the co-op, you 

have the option o f  buying into any or all o f  

the three sweepstakes tor a m ere S100 each.

The idea behind the sweepstakes is simple: 

It ’s all about incentives, and the com bined 

purchasing power o f  PPA  and SEP enables 

co-op members to offer high-quality prizes 

they could not easily afford to offer otr their 

own. H igh school senior or high school sports 

and events photographers can give their clients a 

chance to win a Jeep Wrangler Sahara. Wedding 

photographers can offer clients a chance to  

w in a Caribbean cruise fo r  two. An d  portrait 

photographers can offer a deluxe Disney family 

vacation. There are 15 lesser prizes attached 

to each sweepstakes, such as video iPods, Sony 

video cameras, and American Express gift cards.

For each sweepstakes your studio par­

ticipates in, you receive a M arketing Toolkit, 

designed to  be a marketing campaign in a 

box, with details on how to develop and conduct 

promotions with prizes. The kit contains sug­

gested marketing materials and design ideas, 

as w ell as tips on how  to sell clients on get­

ting into the sweepstakes. The kit also provides 

logos, design elements, sample ads and sample 

marketing copy that can be integrated into 

an existing marketing campaign.

Only PPA and SEP member photographers 

are eligible to participate. For more information 

or to  jo in  the Sweepstakes M arketing 

Cooperative, visit vvxvxv.lmageSvveepKtakes.com.

Give yourself the ultimate location lighting advantage 
of maximum flash power, dedicated wireless control 
to 500ft. and full TTL-Ratio capability.

Compact, portable Qflash 5d-R provides 150 to 400 watt-seconds of studio 
quality lighting.
FreeXwire radios link wirelessly to as many remote Qflash as needed. 
Quantum's QTTL® adapters support virtually all dedicated, camera-flash 
functions including Manual, TTL, Auto, Auto-fill and now, TTL-Ratio. 
Compatible factory upgrades also available for Qflash 4d and 5d models.

Sweepstakes for your customers
New marketing cooperative gives photographers a leg up

Thinking up unique, creative promotions that 

will propel customers through your door Is chal­

lenging. Add the expense o f  launching a multi-

media campaign and your head struts spinning. 

Bottom line is you have to reach your customers 

and give them  a good reason to visit you.
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Life
(what)

matters

Printit:
Life is Yours, Make it Matter. Download PrintitONLINE 

and the Entire PrintltSUITE at 
BurrellProLabs.com or call us at 800.348.8732

A
Burrell

Professional



Incredible Color:
collagesColor is a full service, state-of-the-art, professional 
color lab backed by over 50 years of printing experience.

• Exceptional print quality • Rapid turnaround time
• Extensive lab options • Competitive pricing



Incredible Offer

Let us print eight 8x10s from your images FREE. 
See the coliagesColor difference for yourself.

Since 1999, Collages.net has worked to provide you with the best. Ten thousand professional 
photographers, eight best-in-class awards, and countless key industry partners later, 
Collages.net is providing you with coliagesColor -  our very own full service, state-of-the-art, 
professional color lab backed by over 50 years o f printing experience.

Visit www.collages.net or call today: (877) 638-7468.

YOUR TOTAL WORKFLOW AND PRINTING SOLUTION collages.net
Limit one coliagesColor print promotion per customer.
* ■2007 Collages.net Inc. Photographs 2007 BLR Life Photography (left).TriCoast Photography (right). All rights reserved.

http://www.collages.net


PPa=

PROFESSIONAL PHOTOGRAPHERS OF AMERICA GUIDES PHOTOGRAPHERS
North, south, east or west; life comes at you from all directions. Sometimes it's all you can do just to keep 

your business pointed in the right direction. PPA’s business classes help photographers find their way out 

of the woods and into clear pastures. Knowing your craft will only get you half way there; knowing how to 

sell it is what makes you a success.

Stop going aiound in circles. Become a member of the largest photographic association in the world and 

gain access to benefits that will make your business succeed, your talents grow and give you the peace of 

mind of knowing you're not in it alone.

Let us help. Visit us at www.ppa.com or give us a call at 800-786-6277.

[ p H a i
- J  a  j Professional Photographers o f  Am erica 
™  T H E  V A L U E  O F  M E M B E R S H I P

http://www.ppa.com


Professional Photographer p r e s e n t s  Business, Marketing and Sales Strategies

March 2007 • Professional Photographer • 33



P R O F IT  CENTER

Kay Bi own makes the Baby Plan profitable by getting the 
word out, offering incentives, and keeping up the buzz

Baby, how you’ve grown
Kay Krmvn o f Pace, Fbu, a s|xxrialLst in children’s 

|x>rtniits, started her career in wedding photog­

raphy 2.‘ )years ago. “The wedding business 

flourished, but as i started to photograph 

children, I realized I needed niv Saturdays free 

lor my working moms." says Brown, although 

she still enjoys shooting a handful o f  

weddings every year.

The schools in Brown’s area, just outside 

Pensacola, were "brim m ing over with little 

|ieople who needed |X)rtraits made on a regular

basis,” she says. A  canvass o f  mothers revealed 

that some had jo in ed  a baby plan with other 

photographers, paid the fee, got the album to 

take home—and them it sat, empty. Aha! Blow n 

thought. Thin is how rev cun set ourselves 

apart; w ell keep the albums up to date.

Part o f  her strategy for doing so is to illustrate 

how quickly and dramatically children change 

in their fiist tew years, and make sure the maxi­

mum number o f  people s ir  those illustrations. 

“Our only form  o f  advertising is hanging our

portraits in the offices o f  the parents’ work 

places,” says Brown. O f  course, tons o f  people 

also see the Baby Plan albums in friends’ 

homes and children’s portraits on the studio’s 

W eb site (www.kaybrownphotography.com ). 

Th e  Baby Plan accounts for about 65 

percent o f  the studio’s business. (Gross sales 

last year were about 8515,000.)

It took a little effort at fiist, but “ It wasn’t 

long before new clients were telling me, “When 

w e m oved to  this area, 1 saw your portraits 

all over town, ” Brown says. “T h e  albums are 

proudly displayed on coffee tables in homes, 

and they beg to  lx- looked at when our families 

entertain. Th e  guests see our work and look 

forward to  updates in their friends’ albums.”

Brown’s Baby Plan portraits are made at 

ages 3, 6. 9 ,12,18 and 24 months. Newborn 

portraits are catching on, t(x>. “W e have some­

thing planned fo r each stage o f  the child ’s 

life. The  Baby Plan Brochure has suggestions 

for each session, and we have new backdrops 

at Faster and Christmas and specials 

throughout the year. The moms are welcome 

to  add the specials to  their album to enhance 

the variety o f  the book,” Brown says.

She also offers an attractive referral 

incentive, awarding points toward prints or 

products fo r each referred customer. A s a 

reward fo r paying fo r a sitting in full, clients 

get a free brag book. “This has greatly 

increased our cash flow, and the m om s are 

extremely happy to get som ething they value 

as an add-on," says Brown.

Referrals create “buzz” Brown says, and 

the Daily New s and Freebies page on the 

studio’s W eb  site keeps it going. T o  draw 

customers to  the door, “W e  try to  g ive away 

som eth ing new  every week. It could be a 

small item or as large as a l 6.\20-inch 

print,” she says.’ “You have to create the 

fee ling that your business is interactive and 

constantly changing."
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the X-Series X800 Flash Unit $399.00
• Power Output: 330 True Wattseconds

• Stepless 5 f-stop Flashpower Range (Full to 1/32 power)

• 1 Second Recycle to Full Power

• 1/3600th of a Second Flash Duration at Full Power

• 4 x 4.5 x 12 inches, 4.1 Pounds Total Weight

the X-Series X1600 Flash Unit $479.00
• Dual Power Modes: 660 True Ws (Full), 165 True Ws (Quarter)

• Total 7 f-stop Range: Full to 1/32 (Full), 1/4 to 1/128 (Quarter)

• 2 Second Recycle to Full Power, 0.5 Second Recycle to Quarter Power

• 1 /1600th of a Second Flash Duration at Full Power

• 4 x 4.5 x 12 inches, 4.9 Pounds Total Weight

the X-Series X3200 Flash Unit $669.00
• Dual Power Modes: 1320 True Ws (Full), 330 True Ws (Quarter)

• Total 7 f-stop Range: Full to 1/32 (Full), 1/4 to 1/128 (Quarter)

• 4 Second Recycle to Full Power, 1 Second Recycle to Quarter Power

• 1/900th of a Second Flash Duration at Full Power

• 4 x 4.5 x 15.7 inches, 7.1 Pounds Total Weight

The White Lightning X-SERIES gives you complete control. The back panel on each unit offers clear control of the unit's features, 

conveniently labeled and collectively located for simple and quick adjustment of the flashpower, modeling lamp output and more.

What-You-See-ls-What-You-Get. With matched intensity ratios, light patterns and diffusion, the output of the modeling lamp will match 

the pattern of light you will see on film or digital image - each unit arrives with a bright 250 Watt lamp.

The X-SERIES offers convenience. Each unit has an internal cooling fan for all-day shooting, 

a built-in slave for wireless firing and user-replaceable flashtubes (5600°K daylight-balanced) 

and modeling lamps (250 Watt Quartz). Each unit additionally arrives with our 7-inch field 

reflector (80° beam spread), our 15-foot power and sync cords, our shipping cover, and a 

set of nylon clips for attaching gels and filters.

All White Lightning Flash Units arrive with our 60-DAY Absolute Satisfaction Guarantee 
and our 5-YEAR Factory Warranty! Call us today to learn more!

'hite Lightning is a division of Paul C. Buff, Inc. 2725 Bransford Avenue Nashville. TN 37204 Local (615) 383-3982 \ /

Wh,te Lightning products are sold Factory Direct Please call us or visit us online to place your order! We're here Monday - Friday. 9:00 am 5:00 pm. CST.

all Us Toll Free 1 -800 -443 -5542  WWW. WHITE-LIGHTNING
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Th a t includes the product lineup. 

Through her lab, H & H  C olor I.ab 

(www.hhcolorlab.com), Brown offers 

upscale add-ons such as Gina Alexander 

purses and tote bags.

“Liven though there’s a healthy profit 

built into these products, 1 use them  as 

high-end promotional items,” Brown says. 

“W e might give a .'iO-perccnt-off coupon for 

all orders placed in a certain month, for 

instance. I’d rather place 10 o f  these reduced- 

profit ‘billboards’ in the hands o f  our m obile 

moms than sell a couple for a high profit. W e 

are constantly looking for ways to market 

our business.” And keep existing clients happy.

“Our Baby Plan never ends. I f  we see our 

families once a year after the 2-year shoot, 

the clients still get our Baby Plan prices," she 

says. “W e re looking forward to our first high 

school senior at Baby Plan prices!” ■

MAKING THE BABY PLAN WORK
We book 30-m inute appointments. Period. 

My customers know they have 30 minutes 

and that's it. We advise them to be 15 

minutes early so they can get into the first 

outfit. If they arrive 10 minutes late, they've 

lost one-third  o f the session. We will not 

hold up the next appointment. Often, 

parents book the sessions to  accommodate 

the child's nap time, and I will not penalize 

them  because someone else was late. We 

very nicely offer to  reschedule the 

appointment. We rarely have late people.

We do three poses; w ith one child you 

can have three different outfits. I used to 

book 1 -hour shoots, but often had the 

shots w ith in the first 15 minutes. The 

moms figured they'd paid for a whole 

hour and I should fill it! Now I tell clients 

that a baby w ill last 20  m inutes and
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an older child 15-minutes before they 

become less than ideal subjects. After 20 

years o f doing this, I know that if a baby's 

cranky, nothing but a nap will help. We 

can reschedule the sitting, making sure 

the mom knows we don 't mind the 

inconvenience. It is just part of the job.

The one th ing I hear over and over 

from  dads is, "Wow, that wasn't so bad! 

The last time we took photos, it took 2 

hours.”  I try  to  make it easy on the 

fathers and the infants. Get the photos 

and turn them  loose. The key? Never, 

ever look like you're in a hurry. I talk 

about whatever and tease the kids, but all 

the tim e we’re moving from  one pose to 

another. Twenty to  30 minutes later, 

someone always says, "That was quick!” 

— Kay Brown

Potted 
Babies 

For Sale:
Priceless

http://www.hhcolorlab.com
http://www.ppmag.com


Eye-One Photo ►T« x rite
^  914  347 3 3 0 0

X rite P h o to .c o m

"  If you really w ant your 
images to  look like "your 
images", color management 
comes before everything else. 
Having properly profiled 
monitors and printer/paper 
profiles are a must.
Eye-One Photo is a killer product. 
It's really fast, and makes tru ly 
terrific  color profiles.”
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Two heads are better than one when you can maintain your 
independence and spur production, profits and creativity.

Work partners
Maybe you’ve been shooting weddings fo r a 

while and want to dip into the baby market. 

Maybe you could use some new ideas for sales 

and marketing, or album design. O r maybe you 

just ("eel like your studio needs a breath of 

fresh air. While marketing ta |X 's , seminars, and 

« inventions an- great sources ufinspiration, the 

excitement often fades as so o n  as you get back 

into the daily grind. Sometimes you just need 

the help o f  a respected colleague and friend.

Take for example Georgians Mark Turner, 

o f  Turner Images, and Jennifer Collins, o f  

Jennifer Collins Photography. F inding more 

holes in his Fayetteville Studio Ixxiking calendar 

than lie'll like. Turner reached out to  his 

friend and fellow  PPA  member, Collins, who 

was actually turning clients away in Katonton. 

A fter a few  conversations, the pair quickly 

figured out a way to  help each other out.

“ Vs a small business owner, you’re either 

trying to go out o f  business or you can’t 

breathe because you’re so busy," says Collins.

“ 1 really needed to fill in som e gaps on 

my calendar, and she was calling for help," 

says Turner.

Turner and Collins sat down and identified 

where they needed help, then set up a clear, 

detailed plan for a contractual partnership. 

To protect themselves and their businesses, 

they drew  up an agreement anil established 

everything from  the financial compensation 

to the definition o f  each other’s roles to  the 

amount o f  tim e Turner would spend at 

Collins' studio.

"Between the tw o o f  us, we’re a pretty 

gixxl photographer,” jokes Turner, whose 

studio is about an hour and a ha lf drive from  

Collins. “W e’re so far away from  each other
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that we’re not really competitors, and it’s 

really helped us expand our shooting styles.” 

Two days a week, usually Tuesdays and 

Wednesdays, Turner comes to Collins’ studio 

and helps w ith everything from  shixiting to 

album design, whatever's on the table. Depend­

ing on the session, the two may team up in the 

camera room , or Collins may run the camera 

while Turner helps pnxess images. Regardless, 

they play o f f  o f  each other’s strengths.

“Mark's more technical and I ’m more 

worried about the expressions and emotions 

in the photograph,” say s Collins. “ But we’ve 

got the same philosophy on customer 

service and quality, so w e ’re a gixxl balance.” 

It also helps that both Collins and Turner 

specialize in different areas. Turner’s studio 

handles more weddings, and Collins mostly 

shoots families and children. Down the 

road, Turner hopes to expand Collins’ 

offerings with a few  weddings, which she 

would market and he would shoot.

“ It definitely helps to have one person strong 

in one area when the other one isn’t,” says 

Collins. “An d  it definitely takes motivation 

on txith sides, but it gives us tim e to really 

play w ith new ideas because we learn so 

much from  each other.”

Jerry Kelley, o f  J. W. Kelley Photography- 

in Portsmouth, V’a., hopes to find a similar 

benefit by partnering up with long-tim e 

friend Eva Freyss, o f  Foto by Eva in V irgin ia 

Beach. A  veteran photographer, Kelley spent 

seven years in New Mexico, photographing 

seniors for Lifetouch. In 2005, when family- 

ties brought him  back to his home state o f  

Virginia, Kelley retired from Lifetouch w ith 

the aim o f  starting up his own studio. By

chance, Kelley and Freyss met at a state 

convention, and im m ediately saw the 

possibilities o f  work ing together.

“W hen  I saw Jerry again,” says Freyss, “ I 

thought maybe w e could get together on a 

freelance basis to help jum p start his business. 

I really thought I was just helping him out, 

but now' I ’m realizing that 1 m ight be 

helping m yself out as well.”

Though Kelley and Freyss only recently final­

ized the details, both are very excited about 

what the future will hold. To get an idea o f  how­

to set up ;ui agreement, Kelley and Freyss spent 

a lot o f  tim e researchingwww.ourppa.com , 

reading forums and seeking advice from fellow- 

photographers in similar situations. “ It’s really a 

great PPA resource,” says Kelley o f  the Web site.

“Jerry is a gixxl photographer,” says Freyss. 

“ I think we w ill do very well together because 

he has a lot o f  experience in shooting seniors 

and working outdoors. It will be a gixxl mutual 

relationship, because I ’ll get his expertise 

and he’ll get a gixxl start for his own business.” 

L ike any business venture, a partnership 

like this shouldn’t lx- entered into lightly . Do as 

much research as you can, <uid make sure you’re 

really comfortable with the other person’s abil­

ities. And above all, put everything in writing.

laughs Collins, “ It ’s the closest th ing to a 

marriage w ithout being one. You don’t have 

to  love ’em, but you’ve got to  like the other 

person and trust him.” ■

“Between 
the two of 
us, were a 
pretty good 
photographer.”

http://www.ppmag.com
http://www.ourppa.com


Does anything, anywhere strike fear in the heart o f the Nikon pro?
There are no intimidating assignments when you’re shooting with the new N ikon ’ D2Xs,’"  an evolution o f  the breakthrough 

Nikon D2X, the camera Nikon Pro Joel Sartore called “ the finest camera I ’ve ever worked with.”  The core o f  the Nikon Pro 

D igital System, the new Nikon D2Xs defines performance on demand. For more w ild details, v isit nikondigital.com.

The Nikon D2xs features enhancements in several key areas:

• Advanced Polymer Network viewfinder mask for High Speed Crop Mode. • 1005-pixel 3D Color Matrix Metering il optimized for 
use with High Speed Crop Mode • Sharp, dear 2.5 inch TFT LCD display with 170-degree wide-angle viewing • Broad Color Mode 
options including black and white RGB capture • Improved battery life with EN-EL4a for up to 3800 images per charge

The breakthrough Nikon D2.\s, at the heart o f  the Nikon Pro  D ig ita l System.

Nikon
At the heart o f the image
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Absolutely expect the prospect to engage you on the 
spot, state your guarantee, and book the client.

Say yes
One o f  the most difficult things about the pho­

tography business is the selling. N o  matter 

how good, your work will not sell itself. One 

o f  the most difficult tasks in selling is getting 

the client to make the decision right now.

Here are seven tips fo r  gettin g  the order 

today without pressure, or m anipulation:

1. Build trust and rapport with the prospect 

by asking open-ended questions. Ask short 

questions and listen to the answers, Let the 

prospect do most o f  the talking.

2. Ask the “m agic question” : “ I f  you 

don't m ind my asking, what’s most important 

to you about (the product/semce)?” Selling is

finding out what people want and helping 

them  to get it.

3. End your statements with another ques­

tion. It keeps you in control o f  the conversation, 

and guarantees feedback. M y favorite is 

“H ow  do you feel about that?” That’s feel, not 

th ink. W e’re go ing  fo r emotional responses, 

not analytical ones. It ’s amazingly effective.

4. You must convey how  strongly and sin­

cerely you believe in what you do. You must 

convey that you are the photographer who 

can g ive her what she wants. Convey it w ith 

passion, not ego.

5. Expect the prospect to say yes. I f  every­

th ing you say and do clearly says you expect 

her to  invest w ith  you, she’s likely to sign on. 

Never let anything negative sneak into your 

conversation, body language, tone o f  voice, 

expression. D o this right, and she’ll pick up 

on how  confident you are, that you honestly 

believe she’s going to w ork  w ith you.

6. A sk  fo r the decision outright ! So many 

photographers are afraid to ask the obligating 

question, and as a result, they lose the sale.

7. State your strong, hassle-free guarantee. 

I f  you want the prospect to make the decision 

right now, elim inate every risk factor. The 

client should understand that she cannot 

lose. She w ill be happy w ith her investment 

or you w ill return her money. Adhere to these 

guidelines and you’ ll have very little trouble 

getting the client’s decision today. ■

For more on the business o f photography, 
v is it toww.cjlexvh.com ,

4  4  ; 7
P E R F E C T  L I G H T I N G

1812 Valtec Lane, Boulder, CO 80301 
888.444.1812 303.444.8000
e-mail: salesinfo@ chim eralighting.com  w eb site: www.chimeralighting.com
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The AsukaBook qu a lity  is a p p a re n t in the  very first flip o f its be au tifu l gloss cover. 

While w e  are  fla tte re d  by th e  im itators, th e y  just c a n n o t c o m p a re  to  th e  crisp im ag ery  

a n d  be au tifu l co lo r m a tch in g  th a t on ly AsukaBook has m astered.

Prove it to yourself — order your first book now and receive 50% off!

44071
-AwAPv?
2 0 0 9

Photographer

^  Only the Original AsukaBook W ill Do ^

AsukaBook.com A S U K A B O O K Toll free: 866.330.1530
Coffee Table Book Quality, Cup of Coffee Price.



For more information visit 
www.topflightalbums.com

The Award Winning Premira™ Album
digital speed, professional results

For more information visit www.premiraalbums.com

Slip-Lock™ pages allow you to mount your 
photos outside the album cover and insert 
the page in any order.

patent pending made in USA

Topflight features a complete line 
of albums, proof books and folios.

Our Uni-Lock albums are available in 
a wide variety of cover designs and 
the pages make customizing any print 
configuration fast and easy.

Premira’s innovative Slip-Lock™ page system 
makes album assembly flexible, quick, and 
absolutely foolproof.

P A C K A G I N G  & A L B U M S

Professional presentation has never been easier, as 
elegant, or as compelling. Flora’s Allure albums 
include a hard bound presentation case to protect 
your album for years to come.

Bella albums feature hand crafted quality in a 
traditional library bound style. The ease of loading 
this slip-in album makes it ideal for today’s  digital images.

TAP’s Superior Mount Album sets a new standard for 
quality and impact. Each album has a bonded leather 
cover, substantial feel and library-style binding.

Inside, full-view, edge-to-edge prints adhered on each 
page without overlays or mats. These popular albums 
are available in a wide variety of print sizes from wal­
let to 10x10  and in 10  or 15  page capacity.

For more information on TAP professional 
photo packaging visit www.tap-usa.com for 
a distributor near you. TAP flora For information on Flora albums visit 

www.floraalbums.com

PH EM I HA

http://www.topflightalbums.com
http://www.premiraalbums.com
http://www.tap-usa.com
http://www.floraalbums.com
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YVlial mtlwyimrwirkfliw flow? A vrar
ago I w;ts shooting.I rh t is and cursing 

every moment spent correcting the files 

in Photoshop. My friends convinced me 

to  just try  shooting RAW . just for one 

wedding. I will never go hack. I'm 

pretty simple -I use Adobe Bridge 

and ACR, and I’ rnofMaker script 

(www.photosforlife.ca/seripts/indcx.ht 

m l). These tools make im  workflow

W h a t’s the best equipment investment 

you ever made? M y light meter, many 

years ago. ft taught me, through much 

trial and error, how to realh "see" the light

I.ittJe tiling, blgcftfterence: Adobe Camera 

Raw. 1 hate to he redundant, hut this 

one piece o f  software has given me a 

whole new perspective on editing a take.

W hat s the one piece o f  gear they'd have 

to pry from  your cold, dead fingers?

M y Canon EOS-3. Vcah, it’s a film 

camera. O K , i haven’t touched it in over

a year, m it it holds a really special place 

in iny heart. I want to Tic Buried with 

that camera. And 10 rolls o f  11]’ .').

.Just in case.

IMAGE BY CHARO

W W W .CHAROPHOTO.COM
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THE GOODS P R O D U C T  C L O S E U P S  B Y  M A R T H A  B L A N C H F I E L D

Fun and fresh gift ideas and add-ons can make you the 
popular photographer that all the brides talk about

Wedding ideas and add-ons
HOT METALLIC

Metaliics are hot this season and the 

PICTOBOOKS METALLIC SERIES is 

right on the mark. For a modern and 

distinctive way to present your art to 

clients, try these edgy, au courant 

albums. A trendy alternative to 

traditional leather or fabric-covered wedding albums,

PictoBooks come in eight new metallic covers.

Available in 11x11 or 11x14 format, the albums come 

with 4x4 or 3x7 cameo cut-outs. Choose from Steel Blue, Sea 

Foam Green, Amber Fields, Dust Storm, Petal Pink, Gunmetal Grey, 

Tiny Bubbles or Brushed Aluminum. Prices vary. www.PictoBooks.com

TU R N  PH O TO S IN TO  U.S. POSTAGE

PHOTOSTAMPS are one of the latest ways a bride can personalize her wedding. Photographers 

can offer them in a post-wedding package, along with the bride's personalized photo thank-

you stationery, or send along a set as your own thank-you 

for her business. Simply upload the photo, customize 

it in the PhotoStamps interface, select one of the 10 

border colors, and place your order. The total cost of 

the order depends on the postage value of PhotoStamps 

and the number of sheets; minimum order one sheet 

of 20 stamps, http://photo.stamps.com

SHAKE IT  LIKE A PO LAR O ID

More and more brides are placing a Polaroid instant camera on the guest check-in table, 

alongside an Adesso album. Guests are encouraged to snap a shot, tape it in the album, and 

add a personal message. The elegant ADESSO INSTANT PHOTO GUESTBOOK comes with a 

custom-dyed fabric cover. When paired with the POLAROID ONE 

600 ULTRA CAMERA, wedding guests can 

assemble a living memory book on the 

spot. The Polaroid ONE camera runs 

about $42; the Adesso Instant Photo 

Guestbook for Polaroids $59.95. Also 

consider the Begin Now Kit for 

Polaroids, which comprises the above 

camera and album, plus a Polaroid 600 

Twin Pack (40 exposures) for $139.95. 

www.polaroid.com,

CURIO USLY 

ATTRAC TIVE

Looking for a little 

thank-you gift for 

the bride who's just 

signed a contract? 

Check out the sleek 

silver Magnetic 

Photo Rope, a 43- 

inch cable and eight 

super-strong mini­

magnets to hold 

photos, postcards, 

greeting cards, 

appointment 

reminders— you 

name it. There's a 

loop of cable at the 

top for hanging and 

a weight at the 

bottom so it hangs 

straight. One 

Magnetic Photo 

Rope $12; $20 for 

two; $28 for three. 

Available online at www.

M

w m

ft

'. photojojo.com/store/.

M AKE IT YOURSELF

For some clients, small scale is upscale this year, 

and simplicity is key. That's reflected in the selec­

tions from KOLO  P H O TO  A L B U M S . The 

Newbury album is conveniently small, 8.75x10.25 

inches, and perfect for commemorating a 

single event. It's made with fine European 

book cloth and finished with a grosgrain 

ribbon accent. Built with thick archival board tc 

minimize warping, it has scored sheets that 

allow pages to fold over nicely. The Newbury 

comes with 20 sheets (40 pages) and can be 

expanded to 30 sheets (60 pages) by adding 

Series i refills. Black and Platinum 

Newbury albums 

feature black pages;

all other albums are 

designed with soft 

white pages; $35. 

www.kolo.com
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Hanson Fong &  Profoto ComPact
“I love the quality of light I get from 
Profoto. There’s nothing else like it. ”

I like to make shooting portraits as easy as possible, both for me and 
the client, so I tend to use very few props and sometimes none at all. 

To keep things really simple, I work with Profoto SoftBoxes. I start with 
the fill light then add the main light to get a 3 to 1 ratio, which gives 

me a pleasing, natural light. The hair light and edge light are added 
to provide distinctive separation. To achieve the right perspective, we 
placed the two larger people in the back and used a long lens so the 
people in front would tend to even out. Profoto ComPacts are perfect 

for my kind of work. They are small, light, easy to use and very reliable.

New low price
PLUS
ComPact Kits 
now include 
a free custom ca 
two umbrellas an 
two light stands.

The Light Shaping Company

914-347-3300
Profoto-USA.com



MEMORIES IN THE BAG
Finally, the perfect g ift for bridesmaids: 

personalized photo bags from GINA 

ALEX AND! R, available in a range of styles 

and sizes, from cosmetic clutches to super- 

duper totes. Photographs are set onto the 

fabric through a design process exclusive to 

the company. Most images are processed 

onto heavy bridal satin fabric tha t preserves

the integrity o f the image, and feels smooth 

to the touch. Have the same photo imprinted 

on both sides or, for a slight additional charge, 

use different images. To order, select and 

upload an image file to the company's Web 

site, pick the shape and size, and hit submit. 

Turnaround is four to six weeks. Shown here, 

a classic m edium-size handbag w ith bamboo 

handles, S200. www.ginaalexander.com.

FLIP THROUGH ONLINE
More and more photographers are using tools like the 

|  ! I I PA I B u t series to  create personalized digital photo 

albums. Instead o f a slideshow, some speedy wedding 

photographers are using FlipAlbums to let guests preview 

images before they leave the wedding. Post photos onto 

virtual 3D page-flipping albums, add background music, 

text, video and design themes to personalize the presentation. FlipAlbums also work as online 

shopping pages where the bride can view and select images for her album, or as a location for 

guests to shop for images. Consider FlipAlbum 6 Pro to burn albums onto CD-ROMs that 

? both W indows and Mac users can view. This latest Pro version lets photographers export 

I albums to h igh-quality  MPEG-2 video format to  create SVCDs or DVDs. There are additional 

I security features, as well as a commercial license for photographers that allows them to  sell 

|  photo album CDs and distribute them for promotional use. FlipAlbum 6 Pro also allows users 

I to  add image encryptions, passwords, watermarks and print locks to  CDs. There are three 

i  versions in the FlipAlbum 6 line: FlipAlbum 6 Pro, SRP $159.95; FlipAlbum 6 Suite, SRP 

| $69.95; and FlipAlbum 6 Standard, SRP $39.95. ,v w w .flip a lb u m .c o m

SOMETHING TO ADORN THE W RIST
MY Llf E DESIGNS sells a line of photo-customizable jewelry and accessories. One of the hottest 

items for ladies is a chunky five-photo bracelet in solid sterling silver. It's waterproof and measures 

7.5 inches long. For men, My Life Designs offers belt buckles, money clips, golf accessories, 

cufflinks and a black leather band bracelet w ith a place for an image. Upload photos through the 

company’s Web site, and let My Life Designs do all the production, including cropping, sizing, coloration, 

printing, water sealing and assembly. The ladies bracelet sells for $245; the men's band for $42. 

Professional photographers can call 303-973-6105 for wholesale pricing, www.rnvlifedesigns.com

^  Ifci . iwi i l l
GET THE GROOM INVOLVED
A great g ift for wedding clients,

by Doug Gordon (HarperCollins), has information and advice on handling difficu lt gue 

license, making untraditional choices like a female best man, and more. Gordon, the, 

PlanetGordon.com, is a television producer and writer whose work includes "Moderr 

Channel and "W ho Wants to Be a Millionaire" for ABC. "The Engaged Groom” is ava ila b le ^

major book retailers, $14.95.

"THE ENGAGED GROOM: YOU'RE GETTING MARRIED. READ THIS BOOK,"
btaining a marriage 

b f the popular blog 

for The History 

and

DOUG GORDON
— I

NOW THE BRIDE WILL REALLY GLOW

Enhance engagement and wedding photographs by displaying them 

•n 3 frame. Place a translucent print on the backlit

plate, and the combination o f reflected and transm itted light make the image pop. Special edge 

lighting produces uniform illum ination throughout the photo. The PhotoGlow frame is less than 

1 inch thick, so its profile is virtually the same as a desktop or w a ll-m oun t frame, but w ith  a 

special glow. The price ranges from $79 to $329. Shop online at
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FROSTED FAVOR DIGITAL ON DISPLAY

Every bride wants to place small gifts on the 

guests' tables. FOREVER PHOTO FROSTED 

GLASS COAS : make wonderful gifts.

Packaged in pairs and tied with sheer organza 

ribbon, guests are sure to take them home and 

use them with their own photos. Measuring 

about 3.75x3.75 inches, they hold photos up 

to 2x1 inches. Promote your studio by providing 

ready-to-insert photos bearing your studio's 

name and Web address. One pair, $1.78; 

available at www.theweddingfavorbar.com.

A digital photo frame display lets your clients share and relive memories in pictures. Philips, 

DigitalFoci, EdgeTech and other suppliers sell these frames in many styles, so you can 

pick a look that suits your image. The ones we researched have resolution of 640x480 

pixels, are compatible with several media cards, come with a small remote, and draw power 

through an AC adapter. Some models have sound, onboard memory, and the option of 

battery power or USB connectivity. Load a media card, program a slideshow, re-package it, 

and present it to your client. Prices range from $100 to $300. ■

T h e  5 B  R e p o r te r -  B a g s
g lo b a l D ig ita l C o lle c t io n

The SB Reporter Shoulder Bag Family can easily 
carry and protect a wide range of digital photo and I 
video equipment. The unique design allows each 
individual the freedom of arranging the perfect 
carrying solution for any desired working mode.

Protective
Carrying Solution
www.kata-bajjŝ com \

Thtsr-mo ShwIcJ 
Tochoologm V ;

Kata distributed by: Bogen Imaging Inc. 201 818 9500 www.bogenimaging.us info@bogenimaging.com
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W ith the ability to lock the focus and the 
sweet spot, Lensbaby 3G is ready for 
commercial applications. And its still bin to use.
B Y  S T A N  S H O L I K

Third-times
the charmLENSBABY 3G

Even though the Lensbaby 3G allows a more studied 
approach w ith  its  ability to  lock focus and make 
fine adjustments, it  can still be used like the 
previous-generation Lensbabies for candid 
shooting and quick grabs as w ith  th is photo of 
an aloe flower (f/5 .6  aperture disk).

A fte r two hits with Lensbaby and Lensbaby

2.0 , photographer and inventor Craig 

Strong scores a hom e run with the Lensbaby 

3G. W ith  the latest version, now you can 

make small adjustments in the focus and 

the position o f  the “sweet spot" when your 

film  or digital S LR  camera is mounted on a 

trijxxi, w ithout sacrificing quicker shooting. 

These new finer-tuned, repeatable capabil­

ities make the Lensbaby 3G  ideal for com ­

mercial, macro and landscape photography, 

in addition to  unique, creative image-making.

Th e  Lensbaby 3G  is based on the same 

concept as the first Lensbaby, now called the 

“Original Lensbaby.” Both the focus and the 

position o f  the focus are adjusted by com ­

pressing and distorting the accordion bellows 

behind the lens element, a llow ing you to 

blur portions o f  the image while keeping an 

area— the sweet spot— in focus. The aperture 

is adjusted by inserting precisely drilled 

aperture disks at the front o f  the lens.

The Original Lensbaby, which is still 

available, features a single, uncoated optical 

glass element o f  50m m  focal length that's 

reasonably sharp w ith the f/5.6 and f/8 

disks inserted, hut becomes softer and slightly 

diffused at f/4, and more diffused and impres-
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sionistic at the maximum aperture, f/2.8. 

The  rubber gasket that holds the aperture 

disk in place makes changes som ething o f  a 

chore, but at w ide apertures it produces soft, 

beautifully impressionistic images with a bit 

o f  color fringing, which cannot be duplicated 

by m odem  multi-element, multieoated lenses.

T h e  still-available Lensbaby 2.0 , maximum 

aperture f/2, features a coated doublet rather 

than a single uncoated element fo r a sharper 

sweet spot. M in im um  aperture is still f/8, 

but w ith the aperture disks held in place 

magnetically, changes are far easier to make.

The Lensbaby 3G  has the same basic 

operating principle and lens design its the

2.0 , as well as the same focusing range, 

about 18 inches (fu lly extended) to infinity 

(fu lly compressed). But there the sim ilarity 

ends. Aperture now ranges from  f/2 to  f/22 

in full stops, with the diam eter o f  the sweet 

spot increasing as the aperture decreases. 

(W ith  seven aperture disks available now, 

identifying the one you’re looking for would 

be handier i f  the aperture number were 

printed or engraved onto each disk.)

The dramatic difference with the Lensbaby 

3G  is the ability to lock focus and sweet spot 

position with the press o f  the small locking

http://www.ppmag.com


button on the front focusing collar. The 

front element locks into place on three 

focusing posts equally positioned around the 

Lensbaby. The three focusing guide knobs 

between the focusing posts enable fine 

focusing to clean up any shifting that m ight 

occur when you press the locking button.

The three focusing posts not only provide 

locking elements, but are also screws that allow 

you to fine-tune the position o f  the sweet spot; 

turning them moves the front element forward 

or back. Because they’re positioned 120 degrees 

apart, adjusting one or m ore o f  them fine- 

tunes the sweet spot within a small area.

W ith the earlier models, you have to hold 

the lens in position while pressing the shutter 

release. This works fine fo r  candid shooting 

and quick grabs, and you can still shoot in 

this manner with the Lensbaby 3G. But i f  you 

decide to change any camera settings, such as 

the ISO or white balance, you have to start 

the whole focusing process over again.

W ith the Lensbaby 3G  locked and the 

camera on a tripod, you can change camera 

settings, even change the aperture disk, 

without disturbing the focus. For the first 

time, I felt confident enough to  use a 

Lensbaby in the studio w ith a commercial 

shoot. (W ith  no electrical coupling between 

lens and camera, your m etering technique 

will depend on the camera m odel you ’re 

using with the Lensbaby 3G.)

I he assignment was to shoot food  fo r the 

new CookMe.com , set to  com e online this 

summer. For a shot o f peanut butter cookies,

I asked the client to allow me to do something 

different with the Lensbaby 3G. A fter locking 

focus and making a shot, w e  looked at the 

image on the monitor. The fork  marks on 

the cookies weren’t quite as sharp as I like, so 

I made an adjustment with the barrel 

focusing ring. Th e  ring has a small turning 

range and is fairly loose, so it tcxik a few  

exposures to get the focus perfect. The client 

loved the effect. W e did several m ore food

shots with the 3G, which w ill be the lead 

photos on the site, and w ill be used in the 

client’s promotions, for which they’ll pay extra.

W h ile  the Lensbaby 3G w ill likely be a 

big bit with photographers, there’s room  for 

further improvement, such as having a cost- 

effective way to mount aperture blades and 

an aperture control ring in the unit. That

would solve several minor shortcomings, such 

as having to ju gg le  a set o f  aperture disks. It 

wou ld also a llow  you to  focus at full 

aperture and shoot at a small aperture. I 

found it difficult to  judge optim um  focus 

with the f/l i or smaller aperture rings in 

place. But m ore important, it would a llow  

you to  adjust the size o f  the sweet spot to

LENSBABY ACCESSORY LENSES

Lensbabies LLC makes two accessory lens kits for all Lensbaby models: the Lensbaby Wide 

Angle/Telephoto Kit and the Lensbaby Macro Kit, both available directly through the company.

The Lensbaby Macro Kit features one +4 diopter lens and one +10 diopter lens. They can 

be screwed onto the front o f a Lensbaby lens individually or together. W ithout a macro lens, 

the Lensbaby will focus to  about 18 inches; w ith the +4 mounted, 6  to  14 inches; w ith the 

+10, 3 to  6  inches; w ith the +4 stacked on top of the +10, 2 to  3 inches.

With the ability to lock focus, the Lensbaby 3G and macro lens kit make a great creative 

macro photography team. Macro lenses from the major lens makers are optimized for 

maximum sharpness across a flat field at a specific aperture; the 3G and Lensbaby macro 

lenses take the opposite tack, delivering good sharpness in small areas w ith surrounding soft 

streaks. Changing the aperture and adjusting the focus and sweet spot opens possibilities 

for the creative interpretation of the photographer. Lensbaby Macro Kit, $33.

The Lensbaby Wide Angle/Telephoto Kit includes a 0.6X wide-angle conversion lens and a 1.6X 

telephoto conversion lens. When mounted on a Lensbaby, they change the effective focal length 

to 3 0 - or 80m m , respectively. The Lensbaby 0.6X lens has a unique optical design that widens 

the field o f view while keeping the size of the sweet spot constant relative to  the size of the 

photo. Standard wide-angle conversion lenses shrink the sweet spot when used with a Lensbaby.

Mounted on the 3G, both lenses somewhat limit your ability to adjust the position of the 

sweet spot. Major adjustments to the bellows can cause vignetting. The wide-angle conversion 

lens creates something of a fisheye effect at the edge of the field, which may or may not be 

appealing, depending on the subject. Lensbaby Wide Angle/Telephoto Kit, $89.

The Lensbaby +4 and +10 macro accessory lenses and a carrying case are included in the Macro Kit.
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specs:
Lensbaby 3G coated 
optical glass doublet

FOCAL LENGTH: about 50mm

FOCUS TYPE: Manual/Fingertip with 2 
additional types of fine focusing

APERTURE TYPE: interchangeable magnetic 
aperture disks

APERTURES: f/2, f/2.8, f/4, f/5.6, f/8 , f/11, 
f/16, f/22

MINIMUM FOCUS: about 18 inches (50 cm) 
Maximum Focus: infinity

SIZE: 3 inches (76 cm) x 3.25 inches (9 cm) 

WEIGHT: 5.7 ounces (161.59g)

No electronic communication between the lens 
and the camera body

Available in mounts for virtually all digital and 
film SLR cameras, including Canon EF (EOS), 
Nikon F, Minolta Maxxum/Sony Alpha A, 
Pentax K /  Samsung GX, Olympus El /  
Panasonic Lumix DMC, Leica R, Olympus OM, 
Canon FD, Minolta Manual, Contax/Yashica, 
and Screw mounts

Automatic light metering is possible by 
shooting in aperture priority mode for almost 
all digital and film SLR camera bodies, except 
certain Nikon bodies (including the D50, D70, 
□70S, D80, D100, N50, N55, N65, N70, N75, 
N80), Kodak Professional DCS 14n and DCS 
Pro SLR/n and Fujifilm FinePix SI, S2, and S3.

Fin* adjustments to the position of the sweet spot 
are made by adjusting the focusing post knobs.

your liking as you look  through the lens and 

adjust the aperture ring.

I ’d also like to  see an im provem ent in the 

use o f  the Lensbaby accessory macro lenses with 

the 3G (see sidebar). The locking mechanism 

o f  the Lensbaby 3G  makes it ideal fo r  macro 

photography. Even handheld, w ith  the focus 

and sweet s|x>t locked, it's easy to rock hack and 

forth to  achieve sharp focus. W ith  the camera

on a tripod it’s even easier. But the threads 

fo r attaching the macro lenses are too  deeply 

recessed, so it’s difficult to attach and remove 

the lenses. Perhaps the macro lenses need to 

be slightly longer. It ’s not a problem  w ith  the 

larger wide-angle and telephoto accessory Ictuses.

Priced $270, the Lensbaby 3G  is 

available from  select retailers and at 

www.lensbabies.com . ■

W ith the +4 macro accessory lens mounted on the 3G and the camera mounted on a tripod, producing 
Lensbaby signature macro photos with sharp and diffused areas is a pleasure (left). Making small adjustments 
are essential to  macro photography and the Lensbaby 3G is designed to do just tha t (Nikon D2X, f/2 .8  
aperture disk). The Lensbaby +10 macro accessory lens introduces some chromatic aberration to the 
diffusion around the "sweet spot" that adds to  the beauty of the photo (Nikon D2X, f /2 .8  aperture disk).
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CHANNEL

PocketWizard PLUS II
Triggers your flash, camera
or both wirelessly from up to 1,600 feet away 

Auto-Sensing Transceiver Technology 
Automatically Transmits or Receives for 
faster, easier, carefree wireless triggering. 

Auto-Relay mode
Wirelessly triggers a remote camera 
and a remote flash at the same time.

Fast Triggering Speed
Triggers cameras and/or flash units
up to 12 frames per second.

Digital Wireless Radio Technology 
Four 16-bit digitally coded channels 
provide the world's best

The Plus II joins 
the growing system 
of photographic 
products with built-in 
PocketWizard 
Wireless Freedom. 
Ask for these brands.

PocketWizard Sekonic
Plus II L-758DR
MultiMax L-358
Trigger your flash, Choose which
cameras or both ftesh unit to trigger
without wires from the an(t measure
palm of your hand. simultaneously and

even fire your camera.

Profoto. Dyna-Lite, 
Norman Packs and 
Battery Packs

A built-in radio 
receiver provides 
wireless triggering 
from a PocketWizard 
Transmitter and 
wireless metering.

Profoto, Norman, 
and Photogenic 
Monoblocs

A built-in radio 
receiver provides 
wireless triggering 
from a PocketWizard 
Transmitter and 
wireless metering.

PocketW/^arcT
Wireless Radio Triggering 

9 1 4 - 3 4 7 - 3 3 0 0  
PocketWizard.com
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Three excellent and diverse plug-ins for Photoshop 
simplify the masking process. A  review o f onOne 
Software Mask Pro 4, Vertustech (Helicon) Fluid 
Mask 2.0 and Digital Film Tools EZ Mask 1.01.
B Y  S T A N  S H O L I K

Masking. I f  you’re involved in digital imaging, 

the mere m ention o f  the w ord can send 

chills down your spine. M asking is essential 

in any im age com positing, but it also plays 

a role in color correction, image enhance­

m ent and practically every other aspect o f  

d igital imaging.

Adobe Photoshop CS2 has several masking 

tools, and Adobe continues to  improve 

Photoshop's masking capabilities. Few

photographers, however, w ill ever feel 

com fortable using the Pen tool to  outline 

complex shapes, draw ing Bezier curves, then 

adding, deleting and converting anchor points. 

Photoshop’s Extract tool is a stab at auto­

m ating masking, but usually the extracted 

layer mask ends up being more o f  a guide 

for additional painting on the layer mask 

than a final product. And  i f  you take away 

too  much with the Extract filter and haven’t
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saved a copy o f  the layer, you have to redo 

the entire extraction process.

I f  creating accurate masks is a frequent 

task in your digital workflow, consider using 

a third-party program  that automates the 

process far better than Photoshop and yields 

far m ore accurate masks the first tim e 

through. It ’s nice to  be able to  create a mask 

quickly, but what’s most im portant is the 

accuracy o f  the final mask, so you don’t have 

to invest tim e in cleaning it up.

Three excellent programs designed exclu­

sively for creating masks are onOne Software 

Mask Pro 4, Vertustech (H e licon ) Fluid 

Mask 2.0 and Digital F ilm  Tools EZ Mask

1.01. (Corel KnockOut does not support 

Photoshop CS2.) They ’re sim ilar to  each 

other and to Photoshop’s Extract tool in some 

basic ways, but each has its ow n  approach 

and algorithms. The best one for you 

depends on the kinds o f  masks you create.

Although these programs are Photoshop 

plug-ins, each o f  them  takes over the screen, 

replacing Photoshop’s menus and tool palettes 

w ith its own, and each needs lots o f  R A M , 

particularly for laigc images or complex masks.

MASK PRO 4
Mask Pro, the granddaddy o f  the three, w as 

developed by Extensis and sold to onOne 

Software in 2005. Version 4 is onOne’s first 

frill revision. As in earlier versions, Mask Pro 

4 operates on the concept o f  keep colors and 

drop colors, as defined by the user. W here 

there’s sufficient contrast between the keep

Masking allows you to  turn  th is  wedding photo 
taken inside the church during the ceremony into 
a portrait tha t could pass as a studio portrait. 
Mask Pro was able to  remove the church back­
ground from  the original image, but still preserve 
the detail and transparency in the bride's veil and 
a soft, anti-aliased edge around the couple with 
no trace o f haloing. Background: Old Masters 
digital background from  Owen's Originals.
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THE PROBLEM:
MOST LABS OFFER ONLY 6 SIZES OF GALLERY WRAPPED CANVAS PRINTS

'

THE SOLUTION.
ONLY FROM ■simply 

canvas .com
ANY IMAGE. ANY SIZE. ON CANVAS...CAN YOUR LAB DO THAT?

What else does Simply Canvas offer 
that most labs don’t?

UV Protection Coating included FREE 
Color Correction of Canvas Prints 

Digitally Stretched or Color Borders
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and drop colors, you can use a highlighter 

tool (like Photoshop’s Extract filter) to 

define them.

In the Color Decontamination setting, 

when Mask Pro 4 finds a  drop color in a 

pixel w ith other colors, it will rem ove only 

that value from  the pixel, leaving a semi­

transparent area and the other colors. This 

proves one o f  Mask Pro’s two great strengths: 

remov ing backgrounds from semi-transparent 

and transparent objects. I f  this is one o f  your 

principal masking needs. Mask Pro is for you.

Its other strength is the M agic Pen tool.

It accurately follows curved surfaces without 

the need for Bezier curves. It snaps to edges, 

and i f  you make a mistake, you can undo it 

by retracing the path to an earlier |>oint, then 

continue from them. When you make a .selection 

with the M agic Pen tool or by converting a 

mask to a selection. Mask Pro 4 provides a 

tool to convert the selection to  a work path, 

along w ith several controls to  ensure the 

path is accurate. It's a real time-saver.

Mask Pro 4 works on the image at full 

resolution in an image window. Every time 

you adjust the mask, the program recalculates 

the entire mask, which can he a slow process 

with a huge image or complex mask. In my test, 

it took about 3 minutes to process a complex 

mask on a 36M B  file. Processing complete, 

you can view the mask itselfor, i f  you’re 

compositing the image :uid the new Ivickground 

w as a layer in the file before you opened it in 

Mask Pro 4. you can view  the composite 

image. W hen you’re satisfied w ith the mask, 

clicking Sav e/'Apply returns you to Photoshop.

Mask Pro 4 is available for W indows XP, 

SP2 and later, and Mae OS 10.4.4 and later, 

running Photoshop CS2. W ith  the intro­

duction o fC S 3 , on ( )nc premises to jx>st a 

free upgrade to allow masking o f  16-bit 

images, at www.ononesoftware.eom . Mask 

Pro 4 M SR P: Sir.9.95.

FLUID MASK 2.0
Fluid Mask 2.0 also operates on the principle 

o f  keep and drop colors, but in a unique 

workflow. After' opening an im age in Photo­

shop, selecting Vertus>Fluid Mask from  the 

filter menu opens a proxy o f  the original image 

in its own workspace. You should work on a 

copy o f  your original; like Photoshop Extract, 

Fluid Mask w ill make permanent changes to 

the image file. As the proxy is opening, Fluid 

Mask automatically finds edges between areas 

of color contrast. When the proxy image ;ip|X-‘ars 

a few seconds later, it looks like a completed 

paint-by-numbers version o f  the original.

The Keep, Delete and Complex tools are 

located in the toolbox. For images with good 

color contrast, you simply select areas that 

you want to delete, then auto-fill the rest o f  

the image with the Keep Global tool selected.

For more complex images, or where there’s 

fine detail between the Keep and Delete areas, 

you can use the Complex Exact tool to paint 

in them. For a quick preview o f  what the 

mask w ill delete, select the camera icon and 

draw a rectangular area. Fluid Mask will do 

a test rendering o f  the proxy and display it 

against a gray and white checkerboard or a 

background o f  the solid color o f  your choice. 

It ’s much quicker and more efficient than the 

Extract filter Preview mode. Unfortunately, 

there’s no prevision to preview  it against 

another image.

W hen you ’re satisfied w ith  the test, you 

render the mask on the whole proxy. It takes 

less than a minute with a ,‘J6M B file. Tabs allow 

you to see the Source, the Workspace and 

the Output view s, but not the mask itself.

You can do additional work by returning to 

the Workspace view. Selecting F ilo S a v e  and 

Apply struts the final full-resolution rendering 

and sends you back to  Photoshop. This task 

takes less than a minute with a 36M B  file. 

Masking is lx>th accurate and fast, but unlike

I ’ve always liked th is fall scene tha t I took in 
Connecticut, but never liked the sky. I used the Fluid 
Mask Region Picker tool to  highlight the upper 
portion o f the image. I deleted the blues from  the 
color palette tha t opened, and Fluid Mask deleted 
nearly all o f the original sky in the areas between 
the leaves o f the trees. I have added a green back­
ground to make th is easier to see. The final image 
shows the sky replaced with a more dramatic one.

the other programs. Fluid Mask doesn’t 

automatically create a layer mask in Photoshop. 

You must take tim e to do this i f  needed.

A  tool unique to  Fluid Mask works well ] 

for replacing dull skies in landscape photo- I  

graphs w ith more dramatic ones when you j
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need to remove small areas between leaves 

and branches before doing so. A fter making 

rough Keep and Delete areas, select the 

problem area with the Region Picker tool. 

This opens a w indow  w ith a palette o f  the 

colors in the Keep, Delete and Complex 

areas, each in separate tabs. Selecting and 

m oving the blues from  the Keep to  the 

Delete tab easily removes all o f  the sky.

Fluid Mask ‘2.0 is available fo r  W indow s 

‘2000 and later and M ac OS 10.2.8 and 

later running Photoshop 7.0 and later 

versions. Fluid Mask 2.0 is available from  

www.vertustech.com fo r  S lop .

EZ MASK 1.01
EZ Mask 1.01 is a newcom er in masking 

software, but its maker, 1 lollywood-based 

D igital F ilm  Tools, is an o ld  hand at 

producing plug-ins for Photoshop, Avid 

Editing Systems, A dobe A fte r  Effects and 

Apple Final Cut Pro, as well as tools fo r the 

m ovie industry'.

W ith  its simple interface, EZ Mask is the 

easiest o f  these programs to master, yet its 

masks arc extremely accurate. It too uses the 

keep/dclete technique, but in its own way. 

A fter opening an image in Photoshop, you 

have to  unlock it by double-clicking, then 

add a layer mask, then click on the color 

image to make it active. I f  you are com ­

positing the image, load it on  a layer beneath 

the foreground image. In the EZ Mask 

program, you can preview the foreground 

image against the background after the 

mask is generated.

A fter preparing the image(s) in Photoshop, 

selecting Filters>Digital Eilm Tools>EZ 

Mask opens a proxy o f  the foreground image 

in the EZ Mask workspace. W ith  simple 

images, you can simply create a stroke 

around the area to keep and a stroke around 

the area to delete, then do a test render. Test
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rendering a 36M B  file takes 10-45 seconds, 

depending on which o f  the three rendering- 

resolutions you choose.

For complex images, such as those with 

hair, feathers or smoke, you paint the 

troublesome areas w ith the Paint Unknown 

brash, then fill the keep and delete areas 

w ith a paint bucket. W hen you ’re satisfied 

with the preview  mask rendering, pressing 

the Done icon takes you back to Photoshop 

with a progress w indow  displayed in the center 

o f  the screen, and final processing begins.

Unless you ’re w orking on a low'-res 

image, it’s tim e fo r a coffee break. EZ Mask 

is slow in rendering the final mask. I often 

thought the program had hung up because 

the progress bar wasn’t m oving and the 

Elapsed T im e display was stopped. You 

must lx- patient. On a 3G H z hyperthreaded 

W indows computer, it took just over 14 

minutes to  rentier a moderately complex 

36M B  file. It did crash Photoshop when I 

tried to render m ore complex masks on 

larger files, but I  had exceeded the 

recommended file size for the amount o f  

R A M  I have installed. 1 hope future updates 

w ill run faster, but accuracy is the real issue.

The reward fo r your patience is an 

extremely accurate mask, w ith none o f  

the solarization-like artifacts or other 

weirdness you sometimes get with masking 

techniques. I f  you have the patience and 

the system resources for the images you 

need to mask, EZ Mask w ill do a great 

jo b  w ithout the complexity o f  the other 

masking programs.

EZ Mask 1.01 is available for W indows 

X P  w ith M icrosoft .N E T  Framework 2.0 

(although it runs fine on my W indows 

2000  machine w ith .N E T  2.0 ) and Mac OS 

10.4 and later running Photoshop 7.0 or 

later. Required R A M  for 8-megapixel 

images or less is 1GB; fo r 12-megapixel

I was curious to see how EZ Mask would handle the 
feathers in th is image if I knocked out the back­
ground. I firs t painted the feathers w ith  the Paint 
Unknown brush, then filled the area I wanted to keep 
and the area I wanted to delete using their respec- 
five paint buckets. The processing time was over 12 
minutes on the 36MB original, but the result is excel­
lent. I have filled the background w ith red to  make 
it easier to  see the quality of the mask. Model: Sarah.

images, 1.5GB; and for 16-megapixel 

images, 2GB. EZ Mask is available at 

www.digitalfilm tools.com  fo r $150. ■

A downloadable m anual and tutoria ls are 
available fo r  eaeh o f  these program s on the 
makers Web sites, and a ll are available fo r  
tria l downloads.

http://www.vertustech.com
http://www.ppmag.com
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Cyan, magenta, yellow and black are all innocent 
enough, but when you have to make a color space 
conversion for a client, they can land you in the hot seat.

CM YK: The devil’s color space

Im aging author David Blanter once told me, 

“(io d  c reated RGB. Man created C M YK . 

W hich would you rather use?”

As more photographers use digital capture, 

it has become com m on for their clients to 

ask for C M Y K  files optim ized for four-color 

reproduction on a printing press. There are 

benefits and pitfalls for photographers who 

undertake the task. I f  you supply RG B  files, 

you have lim ited control over the final 

rendering in print. You risk losing potential 

profits i f  you forgo doing the conversion 

yourself, and provide in-house proofs to 

simulate the final printing conditions. By far 

the most dangerous situation is to make 

incorrect C M Y K  conversions, which results 

in poor color reproduction. I f  you think it 

gets expensive making multiple test prints 

on your desktop inkjet, imagine the expense 

o f  running a printing press that spits out 

5 ,000  color pages an hour!

In the analog film days, a properly exposed 

transparency was all a photographer had to

supply to  the client fo r output. Someone else 

in the production chain handled the scanning 

and conversion from RGB to CM YK. Scanners 

and digital cameras produce RGB data. A  

tricky part o f  this w orkflow  is producing the 

optim al C M Y K  values based upon the 

behavior o f  the intended press or a matching 

contract proof. Invariably, this is the key to 

producing the best quality reproductions 

from  any printing device, even your desktop 

inkjet. The most effective way to produce 

such color space conversions is to use ICC 

device profiles. So, from  the perspective o f  

color management, printing to  a press or an 

inkjet involves basically the same steps. The 

CM Y K  color space is simply different from  

what most photographers are used to.

There ’s a yin-yang relationship w ith  RG B 

and C M Y; they complement each other. 

Converting the correct amount o f  red values 

into cyan values, green into magenta and 

blue into yellow  isn’t all that difficult. It ’s 

adding black ( “ K for key. C M Y K ’s short for

additive color process subtractive color process

Figure 1. Both the additive and subtractive color models are seen here. RGB or additive colors are based 
on the mixing o f light. CMYK colors are based on removing light from  a page by adding colorants.
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cyan, magenta, yellow  and black, or “K ” so 

as not to be confused with the “B” in blue.) 

to  the m ix that makes it a far more complex, 

device-dependant colorspace (F igu re 1).

Black is necessary because the colored 

inks used on a printing press are impure, 

and when m ixed to  full density do not 

produce black but a muddy brown. The 

solution is to add black ink to the mix, but it 

complicates the process. M any different 

combinations o f  all four inks can produce 

the same colors. For example, it is possible 

to  produce grays and many dark colors with 

d iffering percentages o f  C M Y  and K  inks. In 

addition, the total amount o f  ink hitting the 

paper plays a role in how  w ell the press will 

reproduce the expected colors. (M ore  later 

on black generation and total ink coverage.) 

But you can sort this out i f  a client demands 

a jo b  delivered output-ready in C M YK .

Sim ply providing RG B  documents is no 

guarantee that the conversion w ill be 

handled properly and the print job  wall turn 

out well, so it's advisable to supply a written 

notice or contract clearly stating that you are 

not responsible for w ork conducted on your 

digital files by those outside your control. 

Some output devices, including most desk­

top inkjet printers, are geared fo r the docu­

ment to be printed to  be in a defined RGB 

color space. Expecting RG B  data, they 

perform  a proprietary color space conversion 

for the number o f  inks used in the printing 

process. For a printing press, C M Y K  data is 

almost always the norm. There are a 

number o f  press processes that can use 

additional inks, such as orange and green, to 

extend the color gamut. This rare and 

expensive printing technique is sometimes 

called hexaehrome printing, although the 

term  is correct only when referring to 

Pantone inks and processes (F igu re 2).

How does one convert the RG B  date to

http://www.ppmag.com
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Figure 2. The gamut of hexachrome is greatly 
extended, thanks to the use of orange and green ink.

C M Y K  fo ra  four-color process based upon a 

specific printing press? First, obtain an ICC 

profile fo r this printing condition and use it

just as you would an RGB printer profile fo r 

your inkjet. Set up a soft p roo f in Photoshop 

using this profile while v iew ing the original 

RG B  image. Edit as necessary. Then use the 

correct profile in the Convert to  Profile 

com m and and save a copy o f  the document 

for the print shop. W h o  said making color 

separations is difficult?

I f  on ly w e  lived in a perfect world, we’d 

have such profiles at our disposal. What 

about the C M Y K  ICC profiles that ship with 

Adobe Photoshop? For example, why not 

just use the one called U.S. W eb Coated 

(S W O P ) v2? I-ike all printer profiles, it’s 

designed to work with a press perform ing in 

a well defined way. Unless we know for certain 

that the printers are using this process, 

selecting random print profiles is about as 

effective as throw ing darts blindfolded.

In the photographic world, we have stan­

dards fo r film  processing. Your film  can be 

developed by any number o f  service providers. 

Process control and calibration are essential 

in analog and digital color reproduction. 

This kind o f  process control is necessary 

w ith a printing press or any output device.

W here does that leave S W O P  and 

Photoshop’s C M Y K  profile? S W O P  stands 

fo r specifications fo r  web offset publications, 

specs written in the early ’70s by an organi­

zation o f  printers to define the ideal behavior 

o f  a web press ( “web” refers to  the giant rolls 

o f  paper used in these presses). I f  hundreds 

o f  printing companies using a web press 

conform ed to  S W O P  standards, every print 

shop could supply an identical ICC profile to 

their customers. But many print shops do 

not conform  to those standards. That’s why 

we need custom profiles. O f  note, the U.S. 

W eb Coated (S W O P ) v ‘2 profile that ships

Sell your used 
camera equipment
We Pay Top Dollar
• We purchase m illions o f dollars in camera gear every year 
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with Photoshop is built upon a tightly defined S W O P  behavior 

called TROO l. The S W O P Com m ittee went to  great lengths to  

set up multip le presses to conform  to their published standards, 

and then printed and measured 938 solid color patches from  

the press sheets. The averaged measured spectral data o f  this 

S W O P  behavior is known as SW O P  TROO l. I f  a press or, even 

better, a proofing system conforms to TRO O l specifications, the 

U.S. W eb Coated (S W O P ) v 2 profile will produce superb color 

separations. The farther the press or p roo f deviates from  this 

expected behavior, the farther the color reproduction w ill 

appear from optim al using this ICC profile.

I f  you are asked to supply C M Y K  data fo r a print jo b  and 

you know it will be printed on a web press, ask i f  the press 

conforms to SW OP. I f  so, ask i f  the press conforms to TROO l 

SWOP. I f  the answer is yes, you have your profile; use U.S. W eb 

Coated (S W O P ) v2 and m ove on. I f  the answer is suspiciously 

vague, you’ll probably have to find another profile. Ask the staff 

at the print shop fo r such a profile (good  luck w ith  that), build 

your own or have a service build one fo r you once the client 

agrees to pay fo r this service as w ell as for conversions and 

possibly proofs.

Another com m on printing process is sheet-fed. Some 

organizations have attempted to define standard conditions for 

printing on sheet-fed presses. The final draft for profiles based 

on G R A C oL  (general requirements fo r application in 

commercial offset lithography) conditions em erging now  are 

known as CO ATS D T R  004  or G R A C oL  7.

W ith  printing companies that conform  to the standards, 

there should Ire few  problems in producing excellent C M Y K  

conversions based on well-built ICC profiles. Otherwise, short o f 

having a profile provided by the print v endor, building a custom 

C M Y K  profile is the ideal solution. I'll explore how to  do this 

and discuss the options that make this process a b it more 

complicated than m aking an RG B profile next month.

For now, i f  you are asked to supply C M Y K  files for a print 

job . you have few  viable options i f  you can’t  target the ultimate 

output devices that w ill be used. M y advice is to avoid any color 

space conversions, provide documents in sRGB to avoid color 

management confusion from  outsiders, and have paperwork 

that frees you from  any issues that may show up on press. ■

Look fo r  Part 2 ofX 'M Y K : The deviPs color space’  in the ne.ti issue.
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Collage. 
portrait

Key com m ands th at d iffe r between M a c  a n d  W indow s are  

noted as cm d/ctrl (co m m a n d  o r  c o n tro l) a n d  opt/alt 

(o p tio n  o r  a lt )  in  th is tu to r ia l. Go to  the W eb  E xclusives  

section a t xcww.ppmag.com J b r  extensive instruction s on  

p rep a ra to ry  steps, p a in t in g  w ith  the L iq u id  M e ta ! 

D y n a m ic  P lu g in , a d d in g  a p a in ted  border, and  

en hancing  the f in a l  im p a ct o f  y o u r  im age by a p p ly in g

THE ART OF MAKING "SAN FRANCISCO HEART 
WITH COREL PAINTER X b y  j e r e m v  s u t t o n

brushstrokes to  the p r in t  xcith d e a r G loss A c ry lic  M e d iu m  

£5 Varnish a n d  opaque colored  a cry lic  pa in ts.

Figure 1 (top): "San Francisco Heart." Figure 2 (le ft): The foundation image, the Golden Gate Bridge from  Point Funston. Figure 3 (center): The secondary 
image, heart sculpture at Chenery House. Figure 4 (right): Multip le source images in the Painter X browser window.
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Figure 5: Resiling the foundation image

I created “San Francisco Heart” (Figure 1), a collage portrait o f  San 

Francisco, using the recently released Corel Painter X . The principles, 

strategies, w orkflow  and techniques 1 used can be applied to 

creating any collage portrait, and I want to  inspire you to  create your 

own. “Collage portrait” means a painting in which one main image o f  

the subject is interwoven with many related subsidiary' images, all 

contributing to  the w'hole in a harmonious and meaningful way.

The process begins with an inspiration, a vision that becomes and 

idea, which leads to  researching the elements that w ill be included. 

Take your time. A llow  the idea to gestate as you acquire imagery', then 

ch(x>sc a main compositional image and supporting images ;unl textures.

“San Francisco H eart" was inspired by m y experience o f  living in 

San Francisco, and wanting to express my appreciation o f  the beauty, 

diversity; creativity, excitem ent and richness o f  this City by the Bay.

1 chose an im age o f  the Golden Gate Bridge as m y foundation 

image (Figure 2). It acts like a com positional anchor fo r the 

artwork, setting the m ain fram ew ork onto which m any layers o f  

im agery can be added.

For m v secondary image, I selected a San Francisco heart, 

created when local artists w ere invited to paint large hearts that 

were placed around the city and then auctioned o f f  to  raise funds 

fo r charity (Figures). A  variety o f  subsidiary images reflects m y 

personal experience and v iew  o f  the city.

Figure 6: Subsidiary image pasted into the working image template

Movie Window Help

Free Transform

Orientation ►

Fill... 86F
Tonal Control ►
Surface Control ►  j
Focus ►

R o ta te -
Scale...
Distort...
Flip Horizontal 
Flip Vertical 
Free Transform X 38T

Figure 7: Choosing Effects > Orientation > Free Transform

CREATE A WORKING IMAGE TEM PLATE
The working image template keeps the canvas size consistent 

throughout the project, elim inating confusion through the use o f  

different sizes or resolutions in the source files. Open the foundation 

image in Corel Painter X  and choose Canvas > Resize. Change the 

units from  pixels to inches, uncheck Constrain File Size, and adjust 

the image size to  match the desired end result ( Figure 5).

I normally print at 150 dpi, but chose to  work at lower resolution 

to constrain the size o f  m y files. I used a resized version o f  the founda­

tion image to generate the working image template. The goal Ls to estab­

lish a template size that y ou maintain for the remainder o f  the project

To enhance the image fo r painting, choose Fffects > Tonal 

Control > Equalize (cmd/ctrl-E), followed by W indow  > Show 

Underpainting > Photo Enhance > Saturate. Increase the tonal 

contrast and saturation o f  the foundation image beyond the point 

you’d  stop i f  y ou wanted to make a photographic print.

Choose File > Save .\s (shift-cmd/ctrl-S) and name your 

working image template with this nam ing convention: short project 

name, two digit version number, short description o f  what this 

version contains or the effect / brush applied. Save as an R IF F  file
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(th e  native form at o f  Pa in ter) to  preserve all data and m axim ize 

fo r future ed iting in  Painter. Use Save A s  regularly throughout the 

process, saving sequential version numbers as you go. “San 

Francisco H eart" ended up w ith  (SO saved versions.

ADD SU BSID IARY IMAGES
1. Open the subsidiary im age in Painter.

2. Choose Select > A ll (cmd/ctrl-A).

3. Choose Edit > Copy (cmd/ctrl-C).

4. Make the w ork ing im age template the active image in Painter.

5. Choose Edit > Paste (cmd/ctrl-V).

(S. Th e  subsidiary image pasted over the w ork ing image template 

is now an image layer listed in the Layers palette (Figure 6).

7. D ouble-dick on the im age layer name in the Layers palette.

8. Renam e the layer in the Layer Attributes d ia log to describe 

what it is.

RESIZE AND ROTATE TH E LAYER USING THE 
FREE TRANSFORM EFFECT

1. Select the layer in the Layers palette, m aking sure that the lock 

symbol does not appear next to the layer name.

2. Choose Effects > Orientation > Free Transform (Figure 7). This 

converts the Im age la y e r  into a Reference la y e r  w ith faintly visible 

control handles (small squares) in the com ers and half-way along the 

sides. I f  the layer is larger than the background canvas, the control 

handles might appear beyond the edge o f  the image. To  see the 

handles, you m ight need to  put your im age in Screen M ode 

(cm d/ctrl-M ) and zoom  out (cmd/etrl- - ) (Figure 8).

3. To resize the layer w ith the same aspect ratio, hold dow n the 

shift key w h ile dragging in a control handle.

4. T o rotate the layer, hold down the cmd/etrl key while dragging 

in a comer handle.

Repeat this process for the other subsidiary images. I f  you have 

more than four layers and wish to see them in the Layers palette all 

at once, hold dow n the tip o f  your cursor on the last row  o f  pixels 

along the bottom  o f  the layers  list and then drag down.

CO NTRO L LAYER V ISIB ILITY  WITH LAYER MASKS
1. Click on the layer w ith the Layer Adjuster tool (top  right in 

Toolbox), provided Auto Select la y e r  is checked (le ft o f  Property 

Bar), or click on the layer in the Layers palette.

2. Choose Effects > Orientation > Com m it Transform. Th e  layer 

changes from  a Reference Layer hack to an Image laser, which you 

can paint on.
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3. Click on the Create Layer Mask icon (last icon on right o f  row  

o f  six icons at the bottom  o f  the Layers palette). A  black square 

against a white background w ill appear im m ediately to the right o f  

the layer thumbnail in the Layers List (Figure <)).

4. In the Brush Selector, choose Airbrush category > Digital 

Airbrush variant.

5. In the Color palette, take the Value-Saturation Triangle cursor 

to the bottom  left com er to  select pure black as your main color 

(front square).

6. Make sure that the Layer Mask is active (it  w ill have a bold 

black box around it in the leavers List), then paint black onto the 

visible part o f  the layer in your image. Th e  layer im age w ill 

disappear (Figure 10). I f  you see black appear on the layer, undo the 

brush stroke and reselect the Layer Mask. I f  you want to bring back 

any o f  the layer, make white your main color.

7. Repeat this process w ith all your layers (Figure 11).

To group lavers together, hold down the shift keyr, select them in 

the I .avers List and choose Layers > Group. Select a closed group 

and choose Layers > Collapse to  collapse a group o f  layers into a 

single layer. To lock a layer, select it in the layers  List and click once 

on the right-hand end o f  the layer to toggle the lock icon on and off. 

Composite M ethods (in  the drop-down menu in the upper left o f  

the Layers palette) controls the way colors in a layer are affected by 

colors in the layer beneath. Experiment w ith  these Com posite 

M ethods (Figure 12).

Periodically flatten your layers (Layers > Drop A ll) to keep your 

file size manageable and to ensure that you’re always able to  see all 

the layers at once in the Layers palette. F lattening your im age also 

allows you to use bmshes to  paint over, blend, smear and distort 

your im agery on a single flat background canvas. I used David Gell’s 

wonderful Grainagashi brush variant on the heart after flattening 

the image (l-igure 18).

CREATE A PAPER TEXTURE TEMPLATE
Paper Textures in Painter are a versatile w ay to integrate imagery o f 

all kinds—photos, maps, logos, musical scores, handwriting— into 

your collage.

1. W ith  the current W ork ing Im age active, choose File > Clone to 

make a flat clone copy. The w orking im age clone copy w ill become 

the Paper Texture template.

2. Open the image you will incorporate ;is paper texture. I used a San 

Francisco map. Copyright laws apply to collage art. so if you use someone 

ekes copyrighted material, even small parts, be sure to get permission.

3. Ch<x>se Select > A ll (cmd/ctrl-A).

Figure 13: Painting over the flattened image

Figure 14: Map layer at 5 0%  opacity
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Figure 16: Captured Paper Texture o f map

4. Choose Edit > Copy (cmd/ctrl-C).

5. N ow  make the working image clone copy tire active image in Painteir.

6. Choose Edit > Paste (cmd/ctrl-V).

7. You w ill now  see your texture im age pasted over the working 

im age clone copy listed as an im age layer in the Layers palette.

8. Low er the layer opacity w ith the Opacity slider in the Layers 

palette. N ow  you can see through the texture im age and observe 

how  it relates to  the underlying collage (Figure 14).

9. I f  the layer needs to be resized or rotated, use Effects > 

Orientation > Free Transform.

10. Once satisfied with the scale and position o f  the layer, return 

the layer opacity to 100%  and save this file as a R IFF.

11. Choose Layers > Drop.

12. Choose Effects > Surface Control > Express Texture.

13. Experiment w ith the Express Texture sliders until you get a 

high-contrast image with the details preserved (Figure hi).

14. Choose Select > A ll (cmd/ctrl-A).

15. Choose W in dow  > Library Palettes > Show Papers.

16. Choose Capture Paper from  the Papers Palette pop-up menu 

(small solid black triangle in top right corner o f  palette). N am e and 

save the custom paper. N o w  it appears in the Papers palette preview 

window (Figure 1 6 ).

Return to your work ing im age and paint texture into a layer.

1. Choose the Chalk Brush Category > Square Chalk 35 variant.

2. Choose Layer > N ew  layer. Th is is your paper texture layer. 

Nam e the layer.

3. Pick a color and start painting the texture into the paper 

texture layer.

4. Click on the Invert Paper icon in the Papers palette (icon  on 

the right o f  the tw o icons to the right o f  the preview  w indow ).

Experiment with painting into the negative space o f  the paper 

texture (Figure 17).

Th e  most im portant aspect o f  your collage portrait is not your 

choice o f  media and techniques, but w hat you say in your art, what 

you express about y our subject, the story behind the painting, the 

passion you share. ■

Jeremy Sutton studied drawing, sculpture and print making at the 
Ru.skin School o f  Fine A rt and Drawing, O.iford University, while 
earning a degree in physics. Sutton's artworks are in private and 
public collections worldwide. He is the author o f  fo u r  books 
including the Painter Creativity: D igital Artist's Handbook" series. 
His l)\ D  tutorial “Er/xtnding Tour Creativity: The A rt o f  Collage 
Portraiture”covers the techniques described here. 
wicw.jeremysutton.com and xcicw.paintercreatwity.com
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WACOM

“I gave it a whirl.”
- Adale Brewer Van Dam, Photographer

Adale is a professional photographer and an artist in Northern 
California. Several years ago, she picked up a Wacom pen for the 
first time at a conference and decided to give it a whirl. That’s 
when she realized that it was a tool she couldn’t live without.

\
Adale purchased an lntuos3 9x12 and has since found that 
the pen provides her with an increased level of control, 
improves her workflow efficiency, and helps her work more 
comfortably. The pen has helped Adale harness the full 
power of applications like Adobe" Photoshop and Corel 
Painter " to get the finished look she wants.

Around the world, millions of photographers, designers and 
artists have converted to the Wacom pen. In fact, 98% of 
people who tried it for the first time quickly discovered 
how much they preferred the pen over a traditional mouse. 
It’s easy to fall in love with the control, comfort and 
speed that our pens give working professionals everyday.

We’ll buy you a gift.

Try a Wacom pen today and we’ll buy you a set of four 
Digital Innovator'" DVDs C99.95 value) showcasing leading 
creative professionals in the areas of photography, 2D 
animation, industrial design, plus more. These videos give 
you an inside look at the tools, philosophies, and practices 
of the pros who are using technology to improve their 
digital workflow.

Visit www.i3fast.com today to learn more about your g ift 
and read the rest of Adale’s story.

www.i3fast.com I 1.800.392.2018

Intuos®
six sizes, from s229
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3 SWEEPSTAKES

ONE BIG
IMPACT

Escape  to  Paradise:
Newlywed Cruise Sweepstakes

Fam ily  D e stin a tio n — D isney: 
Family Vacation Sweepstakes

G raduate in the D river's Seat  

Senior Portrait Jeep Sweepstakes

One lucky couple gets a week- 
long adventure with Princess 

Cruise Lines to the southern 

Caribbean. Second and third- 

level prizes are AM EX gift cards. 
Contest start date is April 1, 
20 0 7  and awards will be made 

next January.

One family receives a weeklong 

vacation for four at a premier 

Disney resort in Orlando, 
Florida. Second-level prizes are 

Sony video cameras. Third-level 
prizes are AM EX gift cards. 
Contest start date is April 1, 
2007  and awards will be made 

next January.

One lucky winner will drive away 

in a 200 7  Jeep Wrangler Sahara. 
Second-level prizes are Dell 
Laptops. Third-level prizes are 

video iPods. Contest start date is 

April 1, 2007  and awards will be 

made in October.



"I'M IN!" Sign  up deadline: March 31, 2 0 0 7
Only $100 per sweepstakes!

What are you waiting for?
© 3 sweepstakes campaigns targeted at 3 of the biggest photography markets 
© Great prizes that will "wow" your customers
© A Sweepstakes Marketing Tool Kit with everything you need to get started

How Do You Stand Out From Your Competition?
Thinking up unique, creative promotional programs that have enough of a ’’wow!" factor to bring custom ers in your door 
is challenging. Add in the expense of such a campaign and your head may start spinning. But the bottom line is you have 
to give custom ers a reason to visit you.

Look no further than the Sweepstakes 
Marketing Cooperative!
This exciting new program for members of Professional 
Photographers of America (P P A ) and the Society of Sport 
& Event Photographers (S E P ) will give your marketing 
program the adrenaline it needs to increase your sales and 
customer base. Join the co-op and you get access to three 
national sweepstakes developed by PPA and S E P  and run 
by a third-party contest administrator.

The combined purchasing power of PPA and S E P  makes it 
possible for co-op members to offer custom ers the chance 
to win am azing prizes targeted at three of the biggest 
photography markets: weddings, family & children por­
traits, and high school seniors. Grand prizes that include a 
Jeep Wrangler Sahara, Caribbean cruise, and a deluxe

Disney World family vacation, provide a strong call to 
action for your custom ers and prospects.

For each program you join, we'll send you a customized  
Marketing Toolkit -  basically a marketing campaign in a 
box -  that shows you step-by-step  how to develop and 
run your promotions. The marketing kit includes ideas for 
marketing materials and tips on how to tell your cus­
tomers about the sweepstakes. You'll also receive a CD  full 
of logos, design elements, sample ads and sample market­
ing copy that can be integrated into an existing marketing 
campaign.

Tim e is running out -  March 31, 2 0 0 7  is the last day you 
can join the Sweepstakes Marketing Cooperative. Visit 
www.lmageSweepstakes.com to sign up today.

Be the next photographer to say: "I'm in. Are you

P H A
r l  _  . _  V is itwww.lmageSweepstakes.com
b O P  SEP members, call 877-427-3778

PPA members, call 800-786-6277

http://www.lmageSweepstakes.com
http://www.lmageSweepstakes.com


Mastering your studio workflow isn’t just easier on the schedule; it translates 
into bigger profits. But as technology advances, the task becomes more 
complicated. Here, four experts share their best advice on keeping apace.

By Jeff Kent

orkflow  is the hot topic in 

m odem  professional photog­

raphy. Th e  m ore capabilities 

photographers add to  their 

repertories, the m ore pitfalls they 

find in their operational systems.

Four experts w ho seem to have tackled 

and triumphed in these tricky waters have 

mapped the journey fo r you. W e  asked 

Kevin Kubota, David Jay, G eo ff W h ite  and 

Doug Gordon to share their findings on 

im proving speed and efficiency in the studio.

KEVIN KUBOTA
In addition to practicing professional photog­

raphy, Kevin Kubota, CrJPhotog., o f  Bend, Ore., 

presents seminars on digital workflow and 

image management. IIe sells his men line ( f  soft­

ware and digital imaging tools through Kahota 

Image Tools, rcme.knbotaimagetools.com.

Kubota: Don ’t try to figure out workflow  

on your own! Use the experience o f  people 

w ho have. Spend your tim e doing the 

creative w ork  you love.

There are many software packages that 

take the tedium  out o f  w ork ing with large 

files and the R A W  format. To bu lletproof 

your workflow, become fam iliar with mass 

storage options, like R A ID  systems, hot-swap 

hard drives and servers, and im plem ent an 

efficient file storage and retrieval system.

Go with the flow
5 TIPS FROM KEVIN KUBOTA:

1. Shoot RAW . It's faster, better and more 

secure than shooting JPEG .

‘2. Use presets. In Adobe Bridge and ligh t- 

room. and Apple Aperture, you can create pre-

I low to heat the system and win the workflow game.
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you could do. Artists don’t like to  hear this, 

but efficient workflow is often about g<xxl 

enough. Som e photographers w ill spend 

tim e perfecting every' single image from  a 

job , most o f  which w ill never be printed. Use 

the automation too ls  available to  get your 

images to a state where you know your clients 

w ill lie excited about them. Then move on.

I’ve heard o f  professionals working with 

amateur hardware and software, and I think 

that is a big part o f  their frustration. W ith  

the file sizes o ftoday ’s images, you can’t afford 

to use suli-par tools. Specialization and
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DAVID JAY
David Jay o f  Santa Barbara, Calif, in a 

successful wedding photographer xvith an eye 

fo r  efficiency. So many photographers asked 

him fo r  help xcith their workflow that he 

created a line o f  time-saving enhancement 

and presentation tools called Shmcit. 

xncic.daxndjay.com; xcwxc.shaxvitfast.com.

Jay: M y strongest recommendation is to 

focus on what you should do instead o f  what

sets for your frequently used image adjustments.

3. Spend tim e learning and refining 

effective editing techniques. Photographers 

constantly tell me they spend too  much tim e 

editing. That shouldn’t  be the case.

+. Have an assistant help you. A fter 

shooting a job , I pick out m y favorite images 

and give them  a three-star rating in Adobe 

Bridge. Then an assistant does an edit; lie’s 

free to edit out anything but my three-star 

images. Being less biased than the 

photographer, the assistant is m ore likely to 

eliminate images that won ’t sell. I f  I’m too 

attached to images, I ’ ll waver, which adds 

time. W ith  my absolute favorites starred, I ’m 

assured that my key images are preserved.

5. A  faster computer means spending less 

time in front o f  it.



21 IDEAS FOR EASIER 
WEDDING WORKFLOW
We asked our four experts to  give us tips 

for specific areas o f wedding workflow.

PREPARATION
Build a job database to  help organize and 
track details of every job. Assign job 
numbers to  each job and attach them to  
every image file and client order. It's a 
foolproof way to  file and track each job 
from  capture to  billing.— Kevin Kubota

Set up a file system on your computer and 
use it  to  structure every event. — David Jay

I always go in w ith a plan. I know what seg­
ment o f the wedding is coming up. Working 
with the images later on, I know the sequence 
because they all f i t  into the system. This 
improves efficiency for everything from 
editing to  album design. — Doug Gordon

Sync the clocks on the cameras at the 
event. This simple step makes image

editing much easier because the images 
will be in chronological order. — Geoff White

Acquire enough memory cards to  get 
through a wedding w ithout needing to 

stop, download and reformat. I format all 
my cards in my camera before the event. I 
never delete a card full o f images because I 
have to  reformat things on the fly. It m in i­
mizes mistakes and helps me work more 
efficiently at the event. — Geoff White

CAPTU RE
Shoot RAW. It gives you so much latitude. 
Also, different cameras process JPEG 
images differently, so if you're using a 
couple different cameras at an event, 

the results could be inconsistent.
— Geoff White

W ith  RAW, all the camera settings can be 

changed after capture, except the ISO, 
so you can use auto settings w ithou t 
w orrying about being stuck w ith  the 

results. Auto w hite  balance, contrast and 
other features w ill usually get you very 

close, and then you can fine -tu n e  in the

raw software if needed. — Kevin Kubota 

Make sure the subject is always in even 

lighting w ith  no hot spots. If you expose 
well w ith  even light, you have less 
corrective work to  do later. — Doug Gordon

Be consistent. Once in a particular lighting 

condition, take a few test shots to  get you 
exposure dialed in, then don 't touch it. It's 
easier to  color-correct batches of the same 

off-exposure than to  make changes to 
individual images because you were changing 

your settings for every shot. — David Jay

I use a system o f flow  posing where I can 

work through 35 poses in 5 minutes. It 
gives me a wide range of looks, and then I 
have all those posed images in one sequence 

from  tha t one 5-m inute segment o f the 
wedding. During editing, I know exactly 

where to find them. — Doug Gordon

PRO CESSIN G
Use tools that allow batch processing for image 
conversions. I set up batch conversions and 
let them  run overnight. How much time are 

you spending on each image to  adjust



w

commitment— including b igger financial 

commitment— is required to keep the photog­

rapher’s computers and software up to speed.

5 TIPS FROM DAVID JAY:

1. Organize. Set up a file system on the com­

puter and use it to structure every event Work- 

flow is not supposed to be a creative process!

2. Automate. Take advantage o f  the tools 

in Adobe Light room  or A pp le  Aperture. Set 

up an editing process with com m on presets 

and use them for all o f  your weddings.

3. Batch process. Color correct for lighting 

conditions, not individual images. N ow  that 

we have the ability to make an adjustment just 

once and apply it to every image in a batch, 

it’s better to do mass corrections fo r groups 

o f images shot in the same lighting conditions.

4. Avoid repetition. I f  there’s a part o f

your w ork flow  that you’re doing twice, 

you ’re do ing som ething wrong.

5. M ove on. I f  you are prone to  tinker 

w ith each im age and spend days editing a 

wedding, have somebody else do your editing, 

make those tough decisions. Th e  ultimate 

goal is your clients’ happiness, not yours.

GEOFF WHITE
Now a bus-i) wedding shooter. Geoff White of 

Redwood City, Calif, is intimately fa m ilia r  

with digital issues from  his form er job. 

running his own computer engineering 

company. His approach focuses on shaving 

off even) possible second, which saves him 

hours, (men days, zehen added up over the 

course o f  the year; mmc.geofftch ite.com.

White: M any people focus on the tools for 

the workflow, but have never written down the

steps. W e made a checklist o f  every single ele­

ment in our workflow, then recorded how much 

tim e w e spent on each step over the course 

o f  several weddings. W riting it out helped a 

great deal toward structuring our workflow.

Standardization is critical. I f  you tell your 

clients you can do anything they want, then 

everything becomes a custom job . You end 

up spending too much time learning new 

software, sy stems and products to accom ­

plish all that customization. I f  you have 

established standards, vour w orkflow  not 

only goes faster, hut assures your images 

come out cleaner and m ore consistent.

My w ife and partner, Ia ra , stresses that 

it's important to organize your workflow  from 

a businessperson’s perspective rather than 

an artist’s. W ork flow  isn’t just the movement 

o f  images from  the camera to the printer; it's

density and color? Add up the seconds.
Batch processing has saved me more than 

60 man-hours a year. — Geoff White

Color-correct for lighting conditions, not 
individual images. — David Jay

EDITING
Shorten your workflow  by lim iting your 

captures. The fewer images you have, the 
less time it takes to  edit the job. You also 
spend less tim e having to  make those 
difficult editing choices. — Geoff White

im a g e  e n h a n c e m e n t
Resist the tem ptation to  over-retouch. 
When you over-work your images, they can 
look worse than if you did no retouching at 
all. Proper retouching should look natural 

and transparent. Minimal retouching also 
saves you time. — Kevin Kubota

Record your processes so you can do them 
over and over again. I create actions and plug 
them into the Actions palette. When I look 
at an image, I already know w hat’s going to 
look best on it, and I have the process

automated and ready to go. — Doug Cordon 
Be careful not to look at each image as a 
blank slate. Instead, come up with standard­
ized looks, or flavors, that define your work. 
We just don’t  have tim e to  play w ith  new 
looks w ith every image. Once you've defined 
your treatments, automate them as actions. 
You can always go back and make individual 

fixes if you have to. — Geoff White

Try a programmable keyboard so tha t every 
action is mapped to  one key. A product called 
X-keys from  P.l. Engineering does th is very 
well (www.ymouse.com). It has a few dozen 
programmable keys on a grid tha t you can 

label. I have the actions programmed on the 
keyboard in the order o f our workflow. It 

speeds up the retouching and also makes 
our images more consistent. — Geoff White

PRESENTATION  
I use Showit Effects to  quickly add the 
special effects to  my images, then Showit 
Web to present the images through an online 
slideshow (www.showitfast.com ). W ith 
Showit Web, I can get a slideshow timed 

to  the beat o f the music and up on the

Web in less than 10 minutes. — David Jay 
Consider taking a chunk o f tim e from  

your retouching and spending it on 
presentation instead. If you spend less 
tim e on retouching and more on 
presentation, your sales w ill probably 

go up. — Geoff White

O U TPU T
Find a lab th a t really understands color 
management and w ill work w ith  you to  

get you dialed in. When you have a good 
lab, they d on 't mess up your images.
They are consistent and predictable.
If you spend a little  e ffo rt calibrating 
your m onitor and learning the essential 

bits o f color management, then 
predictable color o u tpu t should come 

easy. — Kevin Kubota

If you have to  tweak your w orkflow  a little  

to  jive w ith  your lab, it's  w orth  it. When 
it comes to  the best use o f your tim e, 
it's im portant to  find a lab tha t you can 
rely on, rather than bouncing around 
to  different labs or try ing  to  p rin t on 

your own. — Geoff White

http://www.ymouse.com
http://www.showitfast.com


WORKFLOW

all thi' things that go into running your 

business and making money. I f  you want to 

make a profit, both your business w orkflow  

and your image workflow  must he e ffic ien t

5 TIPS FROM GEOFF WHITE

1. Address the general rather than the 

specific, fiuild your workflow  around the 

common factors rather than the exceptions.

o. Outsource any part o f  your w ork flow  

that can he segregated and doesn’t require 

much creative input. T h e  biggest tim esaver 

for me was figuring out my processing w ork- 

flow, then train ing som eone else to do it.

:i. Don’t get overly involved in the technical 

details. Do you really need to know the tech­

nology Ix'hind making an image sensor 

work? You’re better o f f  focusing on the 

details o f  the business.

4. When you’re at a wedding, foetus on your 

photography, not your digital workflow. Get 

your digital issues ironed out ahead o f  time so 

\ou urn concentrate on creating beautiful images.

5. S im plify It s too easy to make things 

complicated. Look for ways to simplify every 

step o f  your process.

DOUG GORDON
Doug Gordon. Cr.Photog.. CPP. ofPatken 

Photography in Lindenhurst, S.T.. says 

that efficiency is king. It has to be. The A rte  

York wedding photography powerhouse has 

multiple locations and dozens o f  photog­

raphers covering hundreds o f  weddings a 

pear. Gordon is always designing faster 

and better workfhne systems for himself and 

his staff: wicw.iHitkrnphotographer.com.

Gordon: The best tip I out give amtxxly Is 

to set up s\stems. Everything 1 do—hum shoot­

ing to Photoshop work to album design— is 

based on a system. Eveiything has a sequence.

There are for too many opportunities during 

(continued on p. 85)
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IT ’ S N O T  J U S T  b u s i n e s s ; I T ’ S

P E R S O N A L .  W H E N  YO U T A K E  P H O T O G R A P H S  OF  P E O P L E ,

IT S A B O U T  T H E I R  IM A G E S  A N D  Y O U R  IM A G E  AS A

P R O F E S S IO N A L  P H O T O G R A P H E R . P P A  U N D E R S T A N D S  T H A T .

It  p r o v i d e s  t h e  b a s e  f o r  w h a t  w e  d o . I t ’ s  w h e r e  w e

f  GO W H E N  W E  N E E D  H E L P ,  W H E N  W E N E E D  S U P P O R T ,  W H E N

WE N E E D  M O R E  E D U C A T IO N ,  W H E N  W E  N E E D  TO M E E T MOR E

PEOP LE IN O U R  F I E L D .  I H O N E S T L Y  B E L I E V E  T H A T  I W O U L D

NOT HA V E  M A D E  IT T H I S  FAR  W I T H O U T  P P A .  I DO N T EV EN

T H IN K  I W O U L D  H A V E  B E C O M E  W H O  I AM W I T H O U T  T H E

A S S O C IA T IO N .  IN  A S E N S E ,  P P A  IS L IK E  T H E  

M O T H E R  O F  O U R  P R O F E S S I O N .
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a wedding to miss something i f  you’re not set up 

in a system. Don’t wander around wondering 

what you’re going to shoot next or you’ll miss 

something critical. By sticking to a system, I ’m 

able to guarantee that I get the shot even time.

In the digital workflow, it’s all about Photo­

shop actions. W e use over 250 actions that 

deal with every type o f  image, and we run 

them in an established sequence. W e can’t 

take the tim e to  w ork on every' image 

individually, but w e can make every image 

look like it received personal attention.

The best way to reduce backend workflow is 

to expose correctly in-camera. Too many photo­

graphers think that i f  they shoot in R A W  for­

mat, they can just fix everything later in Photo­

shop. But i f  you have to spend 20 hours cor­

recting images from  a job, you’re losing money.

Ultimately, I want our systems to be 

manageable. 1 don’t want them to be overly 

technical. I don’t  want to  over-think things. 

That just creates m ore work!

5 TIPS FROM DOUG GORDON:

1. Create a system.

2. Find a program  that helps you manage 

images quickly and efficiently. Photographers 

create work fo r themselves i f  they’re not 

ttsing an image management program.

3. Know  the shortcuts. Learn every 

shortcut Photoshop has to offer.

4. Create version folders for modified 

images. That way you can easily jum p to 

different places in your w ork flow  and find 

images at the various stages o f  the process.

5. K now  your lab and get calibrated 

with them. ■
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MAKE M O R
I N  P H O T O G R A P H Y

The Make More Money in Photography Conferences have been renovated for 2007! You can attend one or all of the 
programs and the three-day tradeshow...it only depends on what you are looking for. In addition, every night has a 
special Business Basics program that offers beginning photographic instruction. And don’t forget the tradeshow from 
July 30 -  August 1, 2007.

To whet your appetite, here’s a peek into what the Make More Money in Photography Conferences are offering:

SUNDAY, JULY 29 
SCHOOL PHOTOGRAPHY
Learn how this industry segment can add to your 
income, from nursery schools to high school seniors and 
sports. Speakers include: Randy Brister, Tom & Cookie 
Elwell, and others.

MONDAY, JULY 30 
WORKFLOW
Learn how to make digital photography fun and easy, 
how to increase your sales through projection, and how 
to incorporate Photoshop into your studio. Speakers 
include: Bob Lloyd, Ron Nichols, and A1 Audleman.

SUNDAY, JULY 29 -  TUESDAY, JULY 31 
BUSINESS BASICS
Learn the basics of marketing & sales, getting to know 
your clients and what they will pay, and looking at 
turning your studio into a boutique setting. Speakers 
include: Audrey Woulard, Michael Redford, Sarah Petty, 
and Tim & Beverly Walden.

TUESDAY, JULY 31 -  WEDNESDAY, AUGUST 1 
MARKETING & FINANCE
Learn from interactive sessions specifically designed to 
address the major business challenges you face. Ask 
questions and get the answers you need. Speakers 
include: Ann Monteith, Scott Kurkian, Carol Andrews, 
Sarah Petty, Tim & Beverly Walden, and a case study 
panel with Lonnie Hoke, Geoff White, Ed Zemba, 
Frank Donnino, and Jerry Borwick.

«  Excellent speakers, tons of info, just the spark I needed!

This was an amazing week of info and experiences that will forever 
have a positive impact on me and my business.



July 29-August 1, 2007 | The Peabody Hotel | Memphis, TN

brought to  you by I p H a I

Held in the magnificent and historic Peabody Hotel, in the heart of “Blues City,” the Make More Money in 
Photography Conferences are sure to impress with their locale as well as their programs. The Peabody Hotel opened 
its doors in 1925 and is listed on the National Register of Historic Places. Having recently completed an expansive 
guestroom restoration, The Peabody Memphis continues to carry the distinction as the “South’s Grand Hotel." In fact, 
it is one of Memphis’ most popular attractions.

Check online for details on all hotel and travel information. You can find out how to reserve discounted rooms, where 
to park, and other important information. Visit http://events.ppa.com to find out more.

To guarantee the convention rate, you must mention that you are with “Professional Photographers of America,” and 
reserve the room by the June 28th cut-off date. After this date and time, the hotel will continue to accept reservations 
based upon their room and rate availability. Hotel Cut-off Date: June 28, 2007 at 5:00 p.m.

The Peabody Hotel
149 Union Avenue 
Memphis, TN 38103 
901-529-4000

www.peabodymemphis.com 
Sleeping Room Rate:
Single: S i35
Double: $145
Triple: $155 /Quad: $165

Pre-register by July 25, 2007 and attend all four conferences for only $129! 
Register online at http://events.ppa.com or call 800.786.6277

cc This was the best investment 1 made this year.

I would be crazy not to attend! The retreat was educational, inspiring, 
entertaining and useful -  totally worth the time and money.

sponsored by:

F U J.F IL M

■ •''Kodak
p c * «*

PPA members will receive up 
to two merits for attending.

all phoios courtesy o f 
Memphis C Convention and Vistors Bureau

http://events.ppa.com
http://www.peabodymemphis.com
http://events.ppa.com


Invigorated by the rush o f walking into a wedding day cold, Charo 
Donohue is a photographer who flies by the seat o f  her pants— 
and loves every minute o f it. Her clients adore her upbeat approach.

DDINGS By Stephanie Boozer

ne thing Charo Donohue isn’t 

afraid o f  is a challenge. The 

w edding photographer, w ho 

prefers to go by her first name 

alone, says just about anything 

can happen at a wedding, from  

being asked to acknowledge a life-sized 

cardboard cutout o f  Kenny Chesney as a 

guest, to experiencing the com plete failure 

o f  practically every piece o f  photographic 

equipment. Its  the adrenaline rush o f  the 

unknown that fuels Charo’s enthusiasm for 

w edd ing photography. In  her favorite 

wedd ing scenario, she’s m eeting the bride 

and groom  for the first tim e face to face, at a 

location she knows nothing about.

“ I low  it when I have no idea what to expect,” 

says the Hawaiian native, who now lives in 

W ilm ington , N.C. “W hen  there are no pre­

conceived notions, 1 have to  stay on my toes 

the entire time. I would rather shoot only 15 

weddings a year, all at different locations, 

than have triple that amount at the same 

place," says Charo.

Though her interest in photography 

dates to  her teen years, Charo’s career 

began oddly enough w ith  photographing 

radio-controlled car races, a hobby o f  her 

now ex-husband. “That’s how  I started 

learning about different kinds o f  film," 

says Charo, who now  has an all-digital 

setup. “ It also prom pted m e to  upgrade 

m y equipm ent and really start expanding 

my knowledge.”

W hen  a coworker asked Charo to  photo­

graph her wedding, she was reluctant at 

first. H er one experience assisting a weddingThe natural
A  gift for storytelling infuses Charo’s work and touches her clients
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i have no idea
what to expect. 
When there are no
preconceived
notions, I have to 

stay on my toes.





photographer had been less than pleasant. 

But she could not ignore the challenge.

“1 also had the classic disappointment in 

my own w edding photos,” says Charo. “They 

were technically gorgeous, but just not 

interesting. 1 fe lt I had this opportunity to 

do what 1 wished I ’d had. Even w ith that,

1 still didn’t like shooting that first wedding- 

very much. 1 charged $200  and spent 

about $600.”

Charo continued to  pursue photography 

and jo ined a photographer who shot girls’ 

softball tournaments in the area. She photo­

graphed the teams on weekends and sold 

prints onsite. It wasn’t quite what she was 

looking for.

“ It ’s k ind o f  funny now, but I actually 

wound up getting fired from  my day job,” 

says Charo. “And my then-husband just said,

‘W ell, now ’s your chance, ju st start your 

photo business.’ And that’s what I did."

That was back in 2001. Chare’s photo­

graphic style and fun personality quickly 

attracted clients. H er approach was com ­

pletely new  fo r the W ilm ington  area, and by 

2003  she was in high in demand. “M y 

approach is extremely laid back,” Charo 

explains. ” 1 think one reason 1 get such great 

cooperation out o f  m y clients is that 1 don’t 

assume anything and that just puts them at 

ease.”  W ord o f  mouth spread like w ildfire 

not only to brides in coastal N orth  Carolina, 

but also to  brides nationwide w ho were 

planning destination weddings along the 

East coast.

Charo doesn’t spend a  lot o f  tim e direct­

ing the bride and groom ; she feels she’s 

there to  simply document the events o f  the

NEW ACTIONS MU
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WEDDINGS

day, good, had, or ugh’. “ I concentrate on the 

story o f  the day,” she says. “M ost o f  my 

clients tend to  he on the artsy, m ore liberal 

side, and they let me do what 1 want.”

Charo doesn’t do much form al marketing 

beyond her W eb  site, though she does 

advertise in a Cape Fear, N.C. wedding 

guide. “ I guess my real marketing secret is 

having my [on lin e ]] b io as flippant as it is," 

she laughs. “M y clients love that I say I ’m 

crazy, and m y follow -up pricing package has 

a lot o f  humor in it as well. 1 usually find 

brides who trust me w ith everything, and 

connect w ith m y personality.”

Cham's wedding package prices range 

from $ ‘2.8()() to $4,500, which draws the 

kind o f  clients she finds ideal. “ It seems 

that the sweet spot fo r me, where I connect 

most w ith my clients, is the m iddle market," 

she explains, as her clients tend to have a 

creative bent. “ I fy o u ’re a little strange, 

somew hat kooky , i f  people often don’t know  

what to make o f  you... we’ll probably get 

along famously.” reads a passage on her 

W eb site.

It looks like this w ill Ik- an exciting year 

fo r Charo. One o f  the upcom ing weddings 

w ill feature flamenco dancers. For another, 

the groom  has com plete access to a college 

football stadium in the area. ‘ Besides the 

ceremony, the couple is interested in lots o f  

pictures in the stadium, on the rooftop, by 

the lockers, everywhere,” she says. “ I think 

it’s going to be really fim.”

Charo plans to continue making weddings 

the core o th e r  business, but she wants to 

expand her portrait photography ; she really 

enjoys shooting teens and area musicians. 

“ I'm just going to keep doing what I ’m doing 

and six* where it takes me.” ■

1 lew  more o f Charo s work online at 
xetnc.diam photo.ann.

the classic lisappointment in
weddings photos; they were tech­

nically )I  I S ,  but just not inteij
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Deliver more than just great prints. Simply upload your images 
to Mpix and order any of our popular wedding products! Prints 
typically ship the same day, products in two.

Available

Shoot Today. Upload Tonight. We Ship Tomorrow.



Daiyl I lawk thrives on the challenge o f managing the business and creative 
aspects o f his multiple specialties—weddings, portraits, corporate, 
editorial, travel. “ I don't get burned out doing any one thing,” he says.

By Jeff Kent

or some photographers, profes­

sional photography isn’t  about 

specialization, it’s about diversifying, 

about m ilking a bid to address every artistic 

inspiration. That’s certainly been the case for 

Daryl I lawk o f  Connecticut w ho photographs 

weddings, portraits, commercial, editorial 

and travel assignments.

As H aw k grew  up, he was fascinated by 

the stories o f  explorers in National Geographic, 

amazed by the images o f  far-flung places, 

diverse cultures and unfam iliar creatures.

I Ic dreamed o f  m aking explorations o f  his 

own, and docum enting his travels in the 

style o f  that iconic publication.

N o  surprise then when Hawk gravitated to 

photography. Since age 10, he’s kept scrap­

books o f  his journeys, ever-increasing the scope 

o f  his travels ;is he matured. A t Connecticut 

College, Hawk majored in English, thinking 

he’d  be a travel writer, but as he sought to 

express h im self in words, he kept returning 

to  the m edium  he truly loved: photography.

In his early 20s, H aw k became a photo- 

journalist. He did som e documentary jobs, 

got his work into a fe w  publications, and 

started making a name for himself. W henever 

he scraped together som e cash, he’d set o ff 

on personal trips throughout North America.

By his m id-20s. Hawk was thinking more 

about the long term  and a sustainable ciireer 

in photography. Documentary work was fun, 

but it was sparse and it didn’t pay well. Hawk 

began doing portraits. H is skills transferred 

nicely, and he was able to  produce poignant, 

appealing portraits that found an immediate 

nvirket in Connecticut and suburban N ew  York.Two worlds
Daryl I lawk finds his groove between wedding and PJ work
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Hawk expanded into weddings. As an early 

practitioner o f  the photojoumalistic approach, 

he found weddings were a natural fit. "It 

stays true to my prevailing them e and my 

great love: telling stories and doing docu­

mentaries,” explains I lawk. “The most enjoyable 

thing about photographing a wedd ing is 

being able to  tell the story o f  the greatest day 

o f  tw o people’s lives. I enjoy that in the same 

way that I enjoy telling the story o f  a remote 

kingdom hidden away in the Himalayas.”

Hawk’s business grew, and it wasn’t long 

before he was m anaging a busy studio with 

a jam m ed appointment book. W ith  the help 

o f his wife and partner, I leidi, I lawk developed 

the business steadily over the years, eventually 

taking on a couple o f  associate photographers 

and booking 100 weddings a year.

Portraits and weddings paid the bills, and 

Hawk continued to do documentary travel 

photography. 11 is expanding travel portfo lio  

prompted interest from  corporate clients 

who wanted his dramatic images for a variety 

o f commercial applications. 1 lawk also began 

to show his work in fine art exhibitions 

and sell it as wall decor. As his reputation

-___________________________________________________________________

spread, his travel images went from  loss 

leader to profitable revenue source.

These days, in addition to his portrait 

and wedding work, Hawk maintains a 

healthy corporate client base and publishes 

work regularly in a selection o f  magazines.

I Ie conducts slideshow presentations for

When Hawk
to a bride, he limits his
conversation to wedding

When he discusses a 
travel with a
client, he doesn’t mention 
weddings or portraits, 
and to support his

marketing
approach, he has two 
distinct
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organizations and gives seminars on 

shooting techniques. H e even hosts a cable 

television show. The Unconventional 

Traveler, featuring interviews with other travel 

photographers and explorers.

The challenge fo r many photographers 

with multiple specialties is managing the 

business—and the creative focus—so that 

one area doesn’t detract from another. Hawk 

gladly takes on the challenge. “ I'm  able to 

manage my creative focus because I do so 

many different things," he says. “ I don’t  get 

burned out doing any one thing. 1 am  able 

to bring in income from  all these separate 

areas. I f  all my eggs were in one basket. I’d 

be much too stressed out. Spreading things

out has been a key to my success, both as a 

businessman and as a creative person.”

I lawk relies on segmenting his business 

organization and marketing efforts. W hen 

he talks to  a bride, he limits his conversation 

to wedding photography. W hen he discusses 

a travel project with a client, he doesn't 

mention weddings or portraits. To support 

his two-fold  marketing approach, he has 

tw o distinct W eb sites. For wedding and 

portrait business, he steers clients to 

www.hawkphotography.com. For travel, 

commercial and fine art assignments, he 

directs clients to www.darylhawk.com.

Some photographers m ight be hesitant 

to mix personal and professional passions.

but fo r Daryl Hawk it’s the only way to 

work. “ I ’ve always worn  a lot o f  different 

hats, but I think that’s what makes my life 

so interesting and so enjoyable," he says.

“ I can say that 25 years after I started in 

this business, my love fo r photography is 

just as strong as it was the day I did m y first 

professional assignment I d o  something 

different every day, and people are always 

amazed at the variety o f  work I take on. I 

have learned to hone in on what’s im portant 

and that has made all the difference." ■

See more from  Daryl Hawk at 
www.hawkphotography.com and 
www.darylhawk.coim
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M onte Zucker: 
A  lifetime o f 
contributions

BY JEFF KENT





Image try vclayfolackmore.com

For more than fiv e  (/mules, the fieree/y principled, decidedly 

in d iv id u a l Monte /acker. M.Photog.Cr.Hon.M.Photog., has created 

images that explore the souls o f  h is subjects. A n authority on posing, 

lighting, composition a n d  ju st about every other element o f  classical 

photography, his teachings have been the foun dation  o f  some o f  the 

industry's most successful photographers.

Recently, /a c k e r learned that he has pancreatic cancer. His doctors 

struggled to f i n d  hope f o r  his su rv ival, but reached the consensus that 

/a c k e r  h ad less than a y ear to live.

Nat's ( fh  is illness sent a w a ie  o f  sorrow thnmghout the photographic 

community. But /ack er isn't one to wallow in self-pity. He has rem ained 

engaged, continued to appear at photographic events, continued to 

m ake h im self available to fe llo w  image-makers. A lw ays one to celebrate 

life, now in the fin a l chapter o f  his life, /.acker rem ains gra tefu lfo r the 

satisfaction a n d  rewards photography has brought him.

He has founded an organization com mitted to p ro v id in g  artistic 

motivation f i r  at-risk youths, the Monte /a c k er Foundation f o r  Photo­

graphic Inspiration, /a ck er hopes photography can show young people 

that life can hold unending rewards, i f  one ju s t  knows ichere to look.

hen M onte Zucker began 

photographing weddings in 

the late 1940s, and fo r many 

veal's afterwards, form al bridal 

portraits and wedd ing photog­

raphy were two different things. 

Portraits were created in the 

controlled environment o f  a studio; wedding 

photography took place on location.

W h y  couldn’t the two lx- combined, Zucker 

wondered. A fter all, everyone was there on 

the wedding day, dressed in their finest. 

W hat better opportunity to  make memorable 

portraits?

Zucker began to carry a full lighting kit, 

backgrounds and other accessories to  the 

weddings he covered. He’d photograph the 

couple and the families, capture everyone in 

their Sunday best as they celebrated. His 

new  approach caught on immediately, and 

ultimately changed the way wedding 

photography was done.

“ Part o f  the appeal was that I provided 

something for the parents and grandparents, 

not just the couple,” says Zucker. “The parents 

had the desire and the m oney to purchase 

fam ily portraits from  the wedding. These 

were images that would last fo r generations, 

a fam ily history.”

Zucker has always concentrated on faces 

and feelings. I lis goal is to  create images 

that people w ill treasure long after the details 

o f  the event fade from  memory. “ I don ’t 

photograph the world as it is; 1 photograph 

the w orld  as I would like it to  be.” he says. 

“So I editorialize a little. Through my photog­

raphy, I have tried to  tell people how  lucky we 

are to be aliv e, how lucky we are to be together 

in one b ig family, how  lucky w e are to live in 

a w orld  that accepts variance and diversity.”

Zucker has acquired an array o f  awards 

and commendations. He’s had dozens o f  

prints accepted into the prestigious PPA
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“When I was 16, my father took me to a 
Monte Zucker seminar. It was unforgettable.

I remember looking at the slideshow and crying because 
of the beauty o f his images.” —Doug Gordon



Loan Collection, and in 2002  he was named 

Photographer o f  the Year by the United Nations.

He’s proud o f  these accomplishments, 

but says what pleases him most is having 

had a hand in launching the careers o f  other 

photographers. “ I'm  most proud that I ’ve 

been able to  teach people to do what they 

love and make good m oney do ing it," he 

says. “ I ’ve always wanted to  show others 

good technique... to help them express 

themselves w ith  images, to be able to 

interpret a situation and put it on paper for 

others to  share in their vision."

“ He’s one o f  the most influential people I 

have ever met," says Doug Gordon, Cr.Photog., 

CPP, owner o f  Patken Photography and one 

o f  Zucker’s most successful students. “W hen 

1 was 16 and had just started shooting, my 

father t(x>k m e to a M onte Zucker seminar.

It was unforgettable. 1 rem em ber look ing at 

the slideshow and crying because o f  the 

beauty o f  his images. Afterwards, I went up 

to him, and he was so approachable. From 

that point on, there was no one I wanted to 

be m ore than Monte."

W ith  the onset o f  photojoum alistic wed­

ding coverage, some saw Zucker as a purveyor 

o f  an older, m ore static style o f  w edding pho­

tography. It was a rough tim e fo r him, but 

Zucker steadfastly stcxxl by his principles. 

Remarkably, he has maintained an adm ira­

tion and appreciation o f  other photographers, 

even those who have denigrated his style.

“That’s one o f  the most impressive 

things about M onte, his love o f  people,” says 

Ellen Miehelson. M .Photog.Cr., a longtim e 

friend and student o f  Zucker’s. “People have 

said negative things about Monte, and he 

continues to  care about them and love them 

despite that. I haven’t seen that sentiment 

equaled in anyone else. I ’ve fo llowed him 

not just because he’s an expert in lighting 

and posing, but also because o f  his love for 

human beings, his unfailing ability to
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forgive, and his ability to  care fo r people no 

matter what they've said about him."

M odem  photographers ow e something 

to /ticker, whether or not they acknowledge 

it. His posing and lighting techniques have 

become part o f  the basic lessons o f  

professional photography. His methods are

I  d o n ’t  photograph the world as it is; 
I photograph the world as I would 

like it to be,” says Zucker.
“So I editorialize a little. Through

so widespread that many photographers use 

his techniques without even realizing it.

Clay Hlackmore, M.Photog.Cr., CPP, 

another successful Zucker protege, agrees 

completely. “M onte ’s work shows us that fine 

portraiture is not dead.” he says. “Today, people 

take snapshots and call it art. Som e photog­

raphers shoot 5,000 pictures at a wedding ;uid 

pull out 100 decent shots. W ith  Monte, it was 

about making even shot special. Every portrait 

meant something. Every tim e he went out.

my photography, I ’ve tried to tell 
people how lucky we are to he alive, 

how lucky' we are to be together 
in one big family, how lucky 
we are to live in a world that

accepts variance and diversity.
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he was at his best. 1 le never settled.”

Preparing fo r  the final stage o f  his life, 

Zueker invited fam ily members to  select 

items from  his personal possessions. O f  all 

the treasures lie's accumulated over the 

years, the highest demand was fo r old fam ily 

portraits. “Ultimately, that's what people 

w ant," he sa\-s. “As a photographer, you should 

create images not just fo r today, but for 

generations to come. Your images should be

a lasting testament long after you are gone."

That’s the heart o f  Zucker’s enduring con­

tribution, the people his images have touched 

over the years. H is legacy w ill be defined by 

a lifetim e o f  creating happy memories. He 

recorded the world through his eyes, w ith his 

unique interpretation. He did things on his 

terms, and that is how he will be remembered.

Looking back on a long and distinguished 

career, Zueker measures his success not by

the m oney and awards he's garnered, but by 

the inspiration he’s generated. “Success as a 

person is to affect people’s lives in a positive 

way,” he says. “All I ’ve ever wanted to do is give 

people an appreciation o f  the things that 

surround us every day. I f  I ’ve accomplished 

that to  any degree, then I feel that 1 have 

contributed something that is worthwhile.” ■

For more on Zueker and his work, visit 
xtmw.mcmtezucker.com.



american color imaging A D V E R T IS E M E N T

“They are an easy sale and add profit to my bottom line.”
Doug Box, M.Photog.Cr.,

Press Printed Photo Memory Books
From the moment a digital camera 
first magically appeared on the 
scene, the professional 
photographer has been faced 
with tough questions.
Film or digital?
Upload or CD?
Paper or plastic?

One professional color lab is working 
at taking the hard questions and 
providing easy answers. American 
Color Imaging in Cedar Falls, Iowa, 
set out to take the complications out 
of digital technology many years ago 
when it introduced its onPrint On-line 
ordering software to the professional 
marketplace. The concept behind 
onPrint was to make the digital 
ordering process as easy as 
possible, which it has accomplished.

American Color is now taking the 
complications out of professional off­
set printing and - as a bonus - adding 
products that are not only reasonably 
priced for profit but that have an 
incredible quality.

“When we added digital offset press 
printing to our services,” explained 
ACI President Mark Lane, “we want­
ed to make sure we purchased 
equipment that would provide a high 
quality product at a cost that photog­
raphers could use to turn a profit.
Our equipment is not only of the 
highest quality but it gives us the 
opportunity to provide a number of 
items and not just limit ourselves to 
cards and bookmarks.”

And from that was born the American 
Color Memory Book. A high quality, 
coffee table style book that is 
available in five different covers with 
various page styles and layout 
options. There are as many style 
combinations as there are 
photographers to create it. Better

yet is the capability to use either cus­
tom pages as created in Photoshop 
or any other software or templates 
that are available in the ordering 
software which allow a quick and 
easy layout with professional results.

“I love the memory books for parent 
albums, engagement albums, bridal 
portrait albums, children's photogra­
phy and even vacation photos,” says 
Doug Box, M.Photog.Cr., of Doug 
Box Master Photography in Caldwell, 
Texas
“They are an easy sale and add 

profit to my bottom line.”
Box also promotes the concepts of the 
Memory Books through his personal 
teaching.
(www.TexasPhotographicWorkshops.com).

“I tell my students, just get some 
sample books, they sell themselves. 
And the customer service is 
amazing. Sometimes I feel like I am 
American Color’s only customer.

Craig Kienast of IMAGES in Clear 
Lake, IA, (www.photock.com) also 
swears by the Memory Book. “All 
aspects of our client base purchase 
these and LOVE them....they have 
replaced the eight-up folios with a 
vengeance,” said Kienast. “You just 
have to show them and they sell.
We have about five or more samples 
in the studio in various client styles 
but we also have very artistic styles 
at the local coffee shops and other 
places where people spend time.”

Kienast agrees with Box on the ease 
of ordering and customer service of 
American Color.
“The best customer service on the 
planet,” he added.

Senior photographers Gary and 
Pamela Box of Oklahoma show the 
Memory Books as options to senior 
parents who are looking for that little 
extra and as an add on to many

senior orders. Their exclusive designs 
for each senior pushes their sales up 
and beyond standard packages.
“The best labs are based on quality 
and service,” said Gary. “American 
Color Imaging is tops in both.”

“We find that the Memory 
Book works great with every 
line we have,”
said Kalen Henderson ,
M.Photog .Cr., MEI.CEI.CPP.API.EA- 
ASP, of Henderson Photography, Inc., 
in Mt. Pleasant, Iowa “We’ve sold 
them to seniors, brides, moms and 
even sports teams. If you have the 
opportunity to shoot an “event", then 
you can create one memory book 
and sell many copies of it."

"What we absolutely love is the ability 
to have a product that we can sell at 
a profit," Henderson added. “There 
are so many cool things out there but 
by the time you add a markup, they 
are beyond a client's price point. With 
a 20-page book at less than $25 and 
the quality that it has, we can easily 
mark it up and have a great looking 
product out there that people love 
and will buy.”

A soft cover, 10 page (20 sided), 8x8 
book is under $25.00 and with 
American Color’s current promotion 
of 50% off the first memory book 
order, the first book of this type is 
less than $15.00. Information on 
cover and page styles is available on 
American Color’s website at 
www.acilab.com as well as design 
templates. “The software is so easy 
to use," said Henderson. “It gives you 
the option of laying in one page that 
you designed in Photoshop and 
maybe the next page is a template. 
The options are endless.”

For additional information or to 
learn how to place a memory book 
order, contact American Color at 
800-728-2722 or visit their website 
at www.acilab.com.

http://www.TexasPhotographicWorkshops.com
http://www.photock.com
http://www.acilab.com
http://www.acilab.com
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"D-SLR* D ig ita l SLR Camera 
Seif (leaning Sensor mth Dust Delete Data system
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Uses Canon Ef lenses |16i bdori 
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• Super SteadyShot image stabilization & dust
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• 12 S MegaPt*h • 436S x 2912 Manmum ResAc*
• 2 S'ICD Montor • SIR viewfinder * > fps Burs: r»
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• 16 7 MegaPixeh • 4992 * 3328 Maximum ResoMb
• 2*lCDMonitor -SIP. viewfiode' -4tpsBtsrsirat
• UsesCanonEF lenses -150100 1600 -fire**?-a 
‘  50 & Cf, MP cart stars • Optional WFT-Ei Wrrtei
• Single. Ccnbnuous. ox Manual Focus • Program. 

Aperture. Shutter. Depth-of-fett [-1711 Aurfs 
Manual flash Metered Manua! • Uses NP-E3 3a»»

• Dimemions61x6.2x31'-Weight 45 oz. Body#

8
EOS-ID Mart BN Body Only___________ KAE1D2N

C an o n  EOS- 1  D M a rk  II N
"D-SLR" D ig ita l SLR Camera 
with RAW-JPEG simultaneous records
• 8 2 MegjPuers • 3504» 23 36 Maumum Rest** 
•25 'ICDMonitor ‘ SlRwewfinder -hrewte
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PENTAX
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5499.95
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Nikon DX ED-IF Lenses for Digital Only
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18-55/35-
G AF-S (77e)____________________
56 G  AF-S(52©i. . ______________
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CALL

18-7035-45 GAF-S (67©)________________ CALL

16200132>-5.6 G AF-S (72o)_______________ CALL
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N ikon D-Typ« AF Lens«s
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28/2.8 D {•tie). _ 234.95 35/2.0D(52e).. 319.95
5Q/18 D ( 114.95 50/14 0 (5 2 © )- 279.95
60/28 DA4icro(620)(1:1) ----------- -------------- 399.95
85/18 DC62o) w ith Hood_________________ 399.95
85/1 4 DU 1024.95
85/28 PC S M t M aroal (77o)__ ___________ 1329.95

AF-S ED-tf VR Micro (620)____ CALL
C D w ith Hood (72a).------------------- 924.95

1079.95
180/28 D ED-IF (72o)----------------------------------- 759.95
200/4 OED IF Micro w/Case (62a).............. ... 1 349.95

VR 3999.95
300/4.0 D AF $ ED-IF (77©) .......... _ ............... 1124.95

VR 4499.00

600/40 x f

l f t - K /4 * 4  9n i77«y
24-85.35* 309.95

24-1203! - o A? VR 514.95
Et>-IF (77e)

28-105/3.5-4.5 D (62©)__________________ 249.95
28-200/35-5.6 G (72o).... -____ ___________ 319.95
35-70/2 8 47995
70-200/28 G AF-S ED* VKlTte________________ 1614.95

80 -2 0 0 :i 89 99 5
80400/4 VR 142995
20CM0CL4iGA?-S£D- VR .-o 5099 95
TC-14F ill[ l 4*} te*ay*er~  _ . 409.95

[1 7»)

7C-206 (2 299.95

Canon
Canon EF-S Lenses for Digital Only

Compatible with the 20D, 30D & Digital Rebel only
60/2 8 U5M Macro (620) 384*
' 3 : ; / 3.5-4J .J S V i '- c  6899:

999 r

139 9:
Canon EF Lenses
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309.9!
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"L" Lenses
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!- 500 Body Only 
it with 14-45mm Zuiko.
It with 14-45 and 40-1 SO Zuiko

O L Y M P U S  EVOLT E-500
"D-SLR" D ig ita l SLR Camera
• Supersonic Wave Filter
• 8 Megapixels- 17.3x13*4/3 FFKCD
• 3264 x 2448 Max Res. • 2 5 fps Burst • IS0100-1600
• 2.5*ICO monitor • SIR Pentaprism viewfinder • USB 20
• 4/3 Full Frame Zuiko Specific Lenses • Cf, M0 & xO Card vor
• Auto or Manual Focus • Program, Aperture, Shutter, 

Manual, Bracketing, bp Comp. • Uses BIM-1 Battery
• Dimensions 5 x 37 x 2.6* • Weight 15.3 oz Body Only

Kit with Leica OVano-Elmant 14-50/2.8-3 5 
MEGA O.I.S. Aspherical.... ......... ...........

Panasonic Lu m ix d m c -l i
"D-SLR" D ig ita l SLR Camera 
Four-Thirds System (17.3 x 13mm) CCD
• 7.5 Megapixels • 3136 x 2352 Maximum Resolution
•
•Uses 4/3 Full Frame Leica-Panasonic- 

Olympus Lenses (1.5x factor) 7 ^
• Image Stabilization  • Auto O' Manual 1F

c :
• ISO 100-1600 • UsesCGR-S6Q3 Battery • USB2.0
• Dimensions 5 7 x 3.4 x 3* ‘ Weight 18 7 oz. body only

O L Y M P U S  EVOLT E 330
"D-SLR" D ig ita l SLR Camera
• Supersonic Wave Filter
• 7.9Megapixels -17.3 x 13’ 4/3 FFKCD
•2 5’ Uve View ICD monitor • SIR viewfinder • USB 2.0
• 4/3 Full Frame Zuiko Specific Lenses • ( f. MD Card Slot
• 3 fps 8urst • Auto or Manual Focus ‘ Select IS0100-1600
• Program, Aperture. Shutter, Manual, Bracketing,

Exposure Compensation • Uses IBH-1 Battery
• Dimensions 5.5 x 3 4 x 2.8' ‘ Weight 19 4 oz. Body Only

M i K  dso
"D-SLR" D ig ita l SLR Camera
.

• 3008 x 2000 Maximum Resolution • ISO 200-1600
• 7” LCD Monitor • SIR Viewfinder • Auto or Manual Focus
• Adepts Nikon Af Lenses (1 Sx (actor) • 7 5 fps Burst
• SD/MMC Card Slot • Program. Vari Program, Aperture. 

Shutter, Manual, Exp. Comp., Bracketing • Uses EN-EL3 
Battery • Nikon Inc. limited warranty included

• Dimensions 5.2 x 4 x 3' • Weight 19 oz Body Only

/A.W tec. • D80 
"D-SLR" D ig ita l SLR Camera 
•
• 2 S' L(D Monitor • SIR viewfinder • Hot 5hoe
• Uses Nikon Af lenses (15x factor) • Auto or 

Manual Focus • SD/S0HC (High Capacity) Card Slot
• Program, Aperture, Shutter, Bracketing Manual, LxpOSUff 

Compensatkm • Optional wireless Irammitter
• 5 fps Burst • ISO 100-1600 • Uses EN-Elie battery
• USB 21 • Nikon Inc. limited warranty included
• Dimensions 4.1 x 5.2 X Y  • Weight 20 6 oz Body Only

1 2
D2Xs Body Only

I - E le ctro n ic  F la sh e s
ST PENTAX

AF Flash System
Af-360fGZ. .
AB40FGZ............. .......... ...

SWIPRK
'M  Auto Handle Mount____
522 Soper Handle Mount 
with Zoom Head________

3 27-07 AF Flash System IMP 
74.95* 179.95
39.95* 119.95

SB-400..........................—

l2995 S*600...  CALLCALL
R1 Wireless Twin Flash.......

>99.95

USA

Canon
EOS Flash System IMP

114.95
4306X. CALL

CALL
_ MR-ME.X Ringlight ..

CALL •
CALL 
CALL
CALL ■.7 36 AM...
CALL TVL F56AM.

USA
119.95 

CALL RF ! 
CALL SRI

449.95
649.95

O L Y M P U S
D igita l Flash System

Ringlight 
I Ringlight

S O N Y E Z

F U J 1 F IL IV 1  FinePix S5 Pro
MD-SLR" Digital SLR Camera
• 12.1 MegaPixels • 23 x 15.5mm Super CCD SRII
• 4;$6 x 2848 Max Resolution • 3 fps Burst Mode

•
• Uses Nikon AF lenses (factor 1 Sx) • Auto or Manual Focus
• Program. Multi Program, Aperture, Shutter Manual
• AE Bracketing • Hot Shoe/P( for External Flash
• Nikon i-Tfl flash Control & Built-in Flash * USB 2 o
• IS0 100-3200 • Uses NP-150 liitwuro-lon Batter,
• Dimensions 5.8 x 4.4 x 2.9* • Weight 29.3 oz. body only

. D200
"D-SLR" D ig ita l SLR Camera
with imaging processing engine o f the D2x
• 10 2 MegaFMs • 3872x2597 Max Res • I ) 700 160

• Uses ENf lie  Battery w/Fuel gauge him lion 
• Nikon Inc. limited warranty imludtd

. Dunenuons 4 5 * 5 81 7 9* • Weight 79 3 oz

. D2Xs
"D-SLR" D ig ita l SLR Camera
• 17 4 Megapixels • 4788«7848 Manmum M u fe ft

• Uses Nikon AF lenses (15> (actor) • Instant powrt up 
. Uses N4onAf tenses {I Sxfaclwi -OptwrvilWi h
• CF. M0 Card Slot • Auio or Manual Focus • High Speed 

Crop Function • Continuous S fps • Program. Apertme 
Shutter 8t«  ietmq. Manual • Uses EN (14a Battery

• Nikon Inc. limited warranty Induded
• Dimenscm6 2 * 5 9 x 3 4*. Weight 38 4 oz body Only

p fS u z n
4 M /4 Standard 379.95

374.95 S4 M74 Digital 369.95
229.95 : AF 1 Digital 289.95
479.95 for (anon Digital 359.95
449.95 for Nikon Digital 329.95
629.95 Handle Mount Flash System

with Battery ft Charger
598.95

622.00 4! " / f it  1026.95
711 00 899.95

B M
PHOTO-VIDEO-PRO AUDIO

The Professional's 
Source

•  Support before 
and after sale

•  Online live support
•  Massive online presence
•  Huge inventory 

available for 
worldwide shipping

•  Educate yourself 
in our product 
resource center

Film Print & Slide L ig h t in g
COLOR PRINT FILM

K o d a k
Portra 160NC ...

Portia 800 
Ultra (ok* K

FUJIfllM
35mm 
36 Exp

Roil
120 220

2.59 2.49 _
tewOMOQ.. 1.69 1.99 _
**W«CA-20(/ 1.79 _
*WUOM(X) . 1.99 _ __
w w ojiew 5.25 _ _
fifBQ-aOO__ 325 _ _
*■ )£________ 4.99 329 6.50

--------------- 4.69 3.14 5.99
***&<. 3.99 3.45 5.55

4.69

COLOR SLIDE FILM
fUJIflLM 36 Exp

Roil

^  W-ioo____ 5.55 4.19 8.39
taHWMOOf. 5.20 4.19 7.99
^flDPlOOf 4.59 3.49 6.99

7.35 525 —
7.99 4.85 —

WOW

20.75
20.75 44.95
21.50 42.95
4.30 42.95

25.45 51.00
20.45 —

5)2125 —
23.75 —

B&W PRINT

12.49
11.49

11.70
1520

49.50
47.00

ILFORD

FUJIFILM

Kodak

____— 8WT-

$329.95

24 Exp 36 bp
3.19 4.49 3.09
3.09 3.49 2.75
3-14 4.39 265
3.49 4.69 2.99

Jfrfap.........1$, . 220
4.30 269
2.99 2.74
3.99 —

4.99 17.89
— 16.99 33.99

3.69 3.15
4.99 15.45 . .. —
4.99 3.19
6.49 — —
4.69 2125

US IW P  Tota-Light Kit
♦ 2 Tola Lights

* 2- Lowel White Tota Umbrellas

•
• 1 - Impact Light Kir Bag 3

. m $384.95

w n o r m a n  ML600 M ono ligh t K it
• 2  Norman ML600 Monoflgbls 
600 Watt/Seconds (1 JO-120V AC)

•2  Impact 10'Air Cushioned Light Stands Black
• 2- Impact 43 'W hite Translucent Umbrellas
• 1- Impact Light Kit Bag

$ 1 154.95

f tu  IOOOws 2-Head Kit
• 1000 W/S Power Pack with Radio Slave
• 2- 2040 Fan-Cooled lam phead
• Household to  PC Sync cord
• impact ■ Light Kit Bag
• 2 Year Warranty

$ 1 959.95

MicroSync D ig ita l Radio Slave Kit
• 4 Channel Radio Slave System

• Shutter speed up to 1 /ISO sec • Up to 1OO feet 
Kit Includes:
• Radio Steve Receiver w ith Monoplug * Batteries
• • . . .

$299.95

We w ill be closed on: 
M arch 4th, and  

A p ril 2 n d -1 0 th , 2007

“ □ " s i  ■

M in im um  
Sh ipp ing  USA 

(Except AK & HI) 
$7.95, up  to  1 lb. 
A d d  95c fo r each 

ad d itio n a l lb.
For insurance 

add 50c per $100.

©  2007 B&H 
P hoto  - V ideo.

Prices are valid  th ru  
M arch 9 th  2007.

N o t responsib le  fo r  
typ o g ra p h ica l errors.



All images ©Susan Stripling

For Susa n Stripling, 
a wedding is a world 

of enchantment





efore she became a professional photographer 
specializing in weddings, Susan Stripling
had been sorely disappointed by the photographs o f  her own wedding. 

“When I got my proof book, I started to cry,” says Stripling, who says

she hadn't really known w hat to look for in a 

wedding | ihotographer hark then. " I lia t  experi­

ence sparkl'd my ow n desire to provide some­

thing better, but at the time, I had no idea 

that I was pushing toward a career path."

Striplings career didn't commence until 

the birth o f  her daughter; she just couldn’t

put down her camera, it was a 35m m  Canon w edding before and was definitely not a

Rebel. On a fluke. Stripling's husband asked 

her to shoot stills fo r his company’s W eb site, 

and a co-worker o f  his was so impressed 

w ith Stripling’s eye that she asked her to 

cover her wedding.

"I told her that I had never shot a

professional,” says Stripling, “but she 

persisted and I eventually said ‘yes.’"

W ith  the wedding six months away, 

Stripling pushed herself to become proficient. 

She sought out photography forums on the 

Internet and read tutorials on com m on



-

scions decision to stopI made the
■ pursuing

destihiatidli weddings... t% t was^a huge
turning point m my businessT



shooting and lighting issues. She also added 

som e equipment, such as a flash, another 

lens, and a ton o f  film .

“ I realized pretty quickly where m y faults 

were,” says Stripling. “But I also wound up 

shooting some really nice stuff. I still have a 

print that I just love from  that w edding 

hanging in m y studio.”

H er spirits buoyed by  the experience, 

Stripling realized she m ight be onto som e­

thing. She had business cards printed and 

signed up fo r a local bridal fair. “ I went to 

that fa ir w ith about six or seven black-and- 

white prints under mats, a handful o f  business 

cards, and that was it,” she says. “Every one 

went nuts thinking it was so artsy, but it was 

really just bare and simple. I booked 26 

weddings from  that one fair."

Stripling invested even m ore tim e and 

energy into learning her craft, perusing as 

many books and online courses as she could 

find. A fte r purchasing her first d igital 

camera, she tested herself w ith difficult self- 

assignments to 1 roost her technical know ledge. 

She converted her garage into a studio, and 

from  2002 to 2004, photographed 

weddings fo r residents in and around her 

home in Tallahassee, Fla.

“ Eventually, 1 m ade the conscious 

decision to  stop pursuing local w eddings 

and go after destination weddings,” says 

Strip ling, w ho ’s w ith in  a three-hour drive 

o f  m any popular beaches, and frequently 

hops a plane to  m ore exotic w edd ing 

locales. “That was a huge turning point 

in m y business.”

Now  in a larger studio space outside o f  

her home. Stripling limits her wedding 

commissions to about 28 a year, leaving 

tim e to travel and manage her portrait 

business, and spend tim e with her family. 

H er only paid advertisement is a full page in 

The Knot's Florida edition. The ad, she says 

is really more about putting her name in





I just go in there and 
look for beauty.

front o f  area wedd ing vendors than 

attracting new  clients. H er popularity is due 

m ainly to word-of-m outh referrals. She 

frequently updates the b log on her W eb  site, 

which also pulls in brides. Stripling believes 

in keeping her site clean and simple, but 

updates her b log after nearly every event.

“ I ’ve been b logg in g  since before b log­

g in g  w:is com m on, and it ’s b ecom ing more 

and m ore difficu lt to track how  peop le find 

me,” says Strip ling. “T h e  In ternet really 

makes it so much easier to spread your 

name everywhere. Som eone w ill ge t on  a 

message board, then read a w edd ing b log 

w ith  som eone’s recom m endation. I t ’s 

really fun to  have peop le find m e in these 

unique ways.”

Stripling says w edding clients are more 

savvy than ever. They invest a great deal o f  

tim e researching photographers, often 

look ing at studios nationwide. “ It ’s really a 

big decision fo r them,” she says. “The com ­

petition for destination weddings is strong.”

Though Strip ling doesn’t like to restrict 

herself to any one photographic style, she 

describes her work as mostly modern jour­

nalism. “M y  style is crisp and classic, w ith 

bright colors and great emotion,” she 

explains. “ I think what sets m e apart is my 

ability to illustrate the relationship between 

tw o people in a clean, straightforward, yet 

pretty manner.”

W ith  a degree in theater, Stripling is well 

versed in visual art. She also spent tim e 

working in graphics, and though she actually 

liked working w ith the imagery, d idn ’t feel a 

strong connection in the field itself. In 

w edding photography, however, she found a 

career that combined her computer skills 

w ith her love o f  art and the drama o f  theater.

“ I love how  visually beautiful weddings 

are," she says. “ From  dresses to  flowers to 

how  am azing a bride looks when she smiles, 

everyth ing about it is so inexplicably



MARK YOUR CALENDARS!
-------APRIL 4-6,2007 • BOSTON, MA--------
P ho to sho p  W orld is com ing to  Boston, and prom ises to  
be th e  b iggest and best Adobe P hotoshop' educational 
experience ever! Learn and share ideas w ith  people ju s t 
like you from  across the coun try  and around the  w o rld -  
as we ll as the  b iggest-nam e legends in the  indu stry  -  
r ig h t in the  heart o f "Beantown".

Photoshop World is the Annual Convention of the 
National Association of Photoshop Professionals

Non-NAPP member
(before March 2,20 07 ) includes a full-year NAPP membership 

(after March 2 ,2 0 0 7 ) includes a tun-year NAPP membership

s499
*599

NAPP member
*399(before March 2,2007)

(after March 2, 2007) *499

REGISTER TODAY! VISIT WWW.PHOTOSHOPWORLD.COM OR CALL 800-738-8513
sponsors

EHta Canon M4.L Microsoft 

Co* )  EPSON fjjpiStockphoto M
*a°t>e and Photoshop are registered trademarks of Adobe Systems Incorporated

Peachpit
Press

nhntnihnn w ’m APri146' 2007[IIIUlUul IU jl f \  t John B. Hynes Convention Center

c o n f e r e n c e  &  e x p o  Adobe www.photoshopworld.com

http://WWW.PHOTOSHOPWORLD.COM
http://www.photoshopworld.com


(let inspired with more ofStiipling's style 
nt unicjiusa nst ri/)li ng.com.
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gorgeous and grand, no matter how  sim ple 

the event."

Stripling's packages start at $6 ,000  and 

go as high as $ ‘23,000, depending on the 

travel involved, the amount o f  tim e she 

invests, and what tin- client wants as an 

end product. She hits no qualms about 

handing over a D VD  o f  digital files i f  that's 

what the client prefers, but she does offer 

a range o f  albums.

“ 1 have a lot o f  media-savvy clients who 

already know what they want to do with 

their files. 1 aim high to provide my clients 

with a beautiful, full set o f  images, not just 

a handful o f  great images in an album,” 

says Stripling. “You want your clients to 

remember everything alxnit their w edding 

20  y ears later. I just go  in there and look 

for beauty." ■

http://www.ppmag.com


THE ULTIM ATE IN PHO TO  SH O P PIN G :
w w w . a d o r a m a . c o m

FLASHPOINT

FLASHPOINT

Softbox Rashtubc
(or 620 $39.18
1220/1820 $49.95

CO M PARISO N CHART

Flashpoint Accessories

Adorama Imaging Resource Center

^  Guided Tours of Popular DSLRs

^  Picture-taking tips for 
beginners, hobbyists, & pros

Business advice and creative ideas 
for professional photographers

A D Q M A i A
Source for the Educated Photographer

Customer Relations 800-815-0702 212-741-0466 

Mon-Thur. 9 -4 :30 , Fri. 9-1, EST •  FAX # 212-463-7223

STORE: 212 -6 7 5 -6 7 8 9  

HOURS. Mon.-Thurs. 9-6:30pm  •  Fri to  1 :00 

• Sun. 9:30-5:30

Get 10% Off On Accessories When Purchased With A Monolight

www.adorama.com/AIRC
Log on and learn!!

Hundreds of articles you need to help 
you upgrade your photography, 

written by our team of world-class experts.
And it’s all FREE!

4 Leaf Barndoor 
$39.95

—

Snoot
$44.50

. 7
10’ Sync Cord 
$12.95

16” Soft _
Flood
Reflector (Beauty Dish) 
S49.95

Modeling Lamp 
for 620 $12.95
1220/1820 $14.95

Great lighting: Adorama Flashpoint II Monolights deiiver-at an astonishingly high level of 
sophistication and quality and at remarkably low cost. Flashpoint Monolights deliver 
all the power you need-m ore blitz for the buck than any competitive units on the 
market (see comparison chart below). Flashpoint II Monolights are the real deal- 
pro-caliber units you can rely on the give your images a competitive edge.

Calumet Travelite 375 220 1.7 Sec 675 lbs. 15* $469.99

Calumet Travelite 750 350 2.1 Sec 7.5 lbs. 15* $569.99

While Lighting

White Lighting $669 99

Buy a Flashpoint Kit & Save
F lashpoint II k it
Includes: 1 Monolight, 10 'Air Cushion Stand 
& a 40" Umbrella (White w/Black Cover)
620 Kit $239.95 1220 Kit $339.95
1820 Kit $389.95

P ortra it W edding k it
Includes: 2 Flashpoint II Monolights 
2-10' Air Cushion Stands, 2-40" Umbrellas. * 
Snoot. Filter kit & Carrying Case 
620 Kit $549.95 1220 Kit $749.95

FLASHPOINT

White Lighting

Recycle Weight Sync Price

6v $199.95

6v $399.00

http://www.adorama.com
http://www.adorama.com/AIRC


c a len d a r

unary 10-12, 20 10
Nashville, Tenn.

For iii/iiriiuitioii on PPA Evmtt, call

March 3 0 -A p ril 4
C: Heart of America, KCI Expo Center/Hilton Hotel, 
Kansas City, Mo.; Stephen Harvey, 620-624-4102; 
sharveyks@sbcglobal. net; www. hoappa .com

April 9
S: Twin Cities PPA, HTC Eden Prairie, Minn,; 
Mark Kiefer; 952-442-5436; mark@vip-gallery.net; 
www.tcppa.org/program s/April/index.htm l

April 13-17
C: PP of Michigan, Dearborn Inn, Dearborn, 
Mich.; Scott Green, 248-318-5182; 
edir@ppm.org; www.ppm.org

Subm it your organiza tion 's convention, workshop, seminar, or exhib ition dates to  Professional 
Photographer at least six m onths in advance. Editors reserve the righ t to  select events to  be 
announced on these pages, and to  determ ine when announcements w ill appear. Editors are not 
responsible fo r conflic ting  or incorrect dates. For readers' convenience, each event is identified 
by a code preceding its  name: C = Convention, W =W orkshop, S=Seminar, C/E^Approved PPA 
Continuing Education Seminar, E=Exhibit. Send all Calendar o f Events add itions or corrections 
to: Kelly W ilder, Professional Photographer, 229 Peachtree S t., NE, Suite 2200, A tlan ta , GA 
30303; FAX: 4 0 4 -6 1 4 -6 4 0 4 ; kwilder@ ppa.com .

April 14-18
C: PP of Canada, Fairmont Winnipeg, Winnipeg, 
Manitoba; Carmen Matthews, 204-467-1907; 
photobc@mts.net; ppoc@rogers.com 

April 15-17
C: Montana PPA, Billings Hotel & Convention 
Center, Billings, Mont.; Clark Marten, 406-322- 
5544; clarkm@mcn.net; info@montanappa.org

April 16
S: PP of Massachusetts; Linda Pedi, 
9 7 8 -68 6-65 35 ; www.ppam.com

Ap ril 21-24
C: New Hampshire PPA, N. Conway Grand Hotel, 
N. Conway, N.H.; Louise Supple, 6 0 3 -4 7 2 - 
5674; isupple@comcast.net; www.nhppa.com

April 22-25
C: PPA of Pennsylvania, Radisson Penn Harris 
Hotel & Convention Center, Camp Hill, Pa.; 
Genevieve W ilt, 301-463-2827; ppaofpa.org

June 17-19
S: PP of Oregon, Kahneeta Resort, Warm 
Springs, Ore.; Arlene Welsh; 8 0 0 -37 0-56 57 ; 
pporegon@teleport.com; www.pporegon.com

June 18
S: PP of Massachusetts; Linda Pedi, 
978 -6 8 6 -6 5 3 5 ; www.ppam.com

June 24-25
S: Kentucky PPA; Embassy Suites,
Lexington, Ky.; Randy Fraley, 606 -92 8-53 33 ; 
rgimagel@aol.com; www.kyppa.com

June 24-27
C: PP of Mississippi-Alabama; M arriott Shoals, 
Muscle Shoals, Ala.; Terry Collins; 205-901-8651; 
tcollinsfoto@bellsouth.net; www.ppma.net

July 15
S: PP o f Colorado Pro-SHARE, Lone Tree, 
Colo., Thomas J. Hissong, 303-933-9461; 
ppcolorado@aol.com; www.ppcolorado.com I

August 11-15
C: Tennessee PPA, Cool Springs M arriott, 
Franklin, Tenn.; Ernie K. Johnson, 
615-509-5737; www.masterfoto@ aol.com; 
www.tnppa.com

September 8-11
C: PPA o f New England, Sturbridge Host, 
Sturbridge, Mass.; Roland Laramie, P.O. Box 
316, W illimantic, CT 06226; ppaneri@aol.com

September 21-24
C: PP o f Oklahoma, Radisson Hotel on East 
41st, Tulsa, Okla.; Ken Helt; 918-252-5124; 1
www.ppok.org

Septem ber 21-27
C: Georgia PPA, Augusta, Ga.;
Tom McCollum, 770-972-8552; 
gppaed@ bellsouth.net; www.gppa.com

October 15
S: PP o f Massachusetts; Linda Pedi, 
9 7 8 -6 8 6 -6 5 3 6 ; www.ppam.com

October 27-29
C: PP of Colorado, Denver, Colo., Thomas J. 
Hissong, 303-933-9461; ppcolorado@aol.com; 
ppcolorado.com

October 2 8 -2 9
S: PP o f Iowa, A irport Holiday Inn, Des 
Moines, Iowa; Christy Brinkopf, P.O. Box 108, 
Sumner, IA 50674; 563-578-1126; 
ppichris@iowatelecom.net; www.ppiowa.com

April 14-17
C: SEPPA, Atlanta, Ga.; Tom McCollum, 770-972- 
8552; seppa@bellsouth.net; www.4seppa.com PPA C E R TIF IC A TIO N  EXAM  & IM AGE R EV IEW S

April 14-18
C: Minnesota PPA, Arrowwood Resort & 
Conference Center, Alexander, M inn.; Tom 
Stanley, 412 Central Ave., Faribault, MN 55021; 
507-334-9645; tomcstan@ qwest.net; Pam 
Carlson, 525 Tilden Street, Fairmont, MN 
56031; 8 0 0 -3 6 2 -5 8 5 5

T h e  follow ing are exam  dates and locations fo r the PP A  Certified Professional Photographer Exant- 

For Certification inform ation o r an  application packet, call 800 -786-6277- Y our state Certification 

liaison may know o f  additional exam dates in your area. (F o r a  directory o f  liaisons, go  to wxvw.ppaeom.) 

Candidates m ust contact P PA  headquarters at least fiv e business days before the exam  to reserve a 

place (800 -339 -5451 , ext.228). Picture identification will lx- required n|x>n arrival at the testing site.

. 1/0/7 2 2 : Certification  exam . May 4 : Im age  review deadline.

N o rth  C onway. N .H .  P P A  H eadquarters, A tlan ta

120 • www.ppmag.com
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3 Small Steps
FOR GIANT PAYOUTS!W E  W A N T  T O  B U Y  

your used or unused Photo equipment
We can arrange a FREE UPS 
insured pickup in the USA, 
or you can send it to us at 
your convenience.

Expect one of our agents to 
contact you as soon as your 
equipment is evaluated.

Your check or trade will be 
sent out promptly. If you are 
not pleased with our offer 
we will return your equip­
ment to you fully insured. 
Remember shipping is 
Adorama’s expense.

Enjoy our online quote feature at www.adorama.com/sell
To find out the value of 
your equipment, 
contact us

▼

Adorama spent millions 

of dollars in 2005 buying 

35mm, Medium & Large 

Format, Scopes, Video 

and Digital equipment.

'W  ~

Our customers happily 

traded or cashed in their 

equipment. We were 

able to satisfy them 

BY SIMPLY PAYING ABOVE 

MARKET VALUE.

Adorama pays top dollar 

for individual items, rare 

pieces, collections and 

estates.
eMail:

used@adorama.com
Please Include your phone Number 
when you eMail.

Adorama has over 100,000 new items and more than 20,000 used items in stock.

W E  P A Y T O P  D O L L A R  P LU S
For Current Models

E X T R A  C A S H  B O N U S E S
for Telephoto lenses of any brand name

400MMA

B rin g  it
42 West 18th Street 
New York NY 10011

Att. Used Department. 
Adorama 
7 Slater Drive 
Elizabeth, N J 07206.

42 West 18th Street I New York, NY 10011 I 800.223.2500

http://www.adorama.com/sell
mailto:used@adorama.com


HOW

TO

PROPERLY

EXPOSE

A

POLITICIAN.

Learn how a balanced fill flash 
throws just the right light on the 

subject 24/7 at the

Canon______
D ig ita l Lea rn ing  Center

w w w .photow orkshop.com /canon

Canon
mageANYWARE

© 2006 Canon U S A . Inc Canon «  a regetered trademark of 
Canon Inc m  the United Steles and may also be a regtsh.'rec) 
trademark or trademark rt other countries IMAGEANYWARE « 
a trademark erf Canon A* rights reserved

2007 PPA-AFFILIATED SCHOOLS
A p ril 1-4
International Photographic A rts  School, 

M ario tt I lo te l &  Conference Center, 

Indianapolis, Ind.; Patrick Rice, 
440-343-74-00; prfisheye@  aol.com ; 

www.apag.net/intemational_arts_school.htm

A p ril 22-27
Texts School, Texas A & M  University, College 

Station, Texas; Donald Dickson, 806-296- 

2276; ddickson@ lonestarhbs.com ; 
www.tppa.org/school.htm

A p ril 29-May 4
Georgia School, N. Georgia Tech, Clarkesville, 

Ga.; Tom  M cCollum . 770-972-8552; 

gppaed@ bellsou th .net; www.gppa.eom

A p ril 29-May 4
M A R S  (M id -A t la n t ic  R eg iona l School), 

G ra n d  Hotel, C ape  May, N .J .; A de le  

Bastinck, 888 -267 -6277 ; 
m arschoo l@  nac.net; www.m arsschool.com

M ay 8-11 &  13-16
Wisconsin Professional Photographers School, 
U W  Stevens Point-Treehaven, Tom ahawk, 

W is.; Phil Ziesemer, 715-536-4540; 
philz @  pzphoto.com ; 

www.wiprophotoschool.org

M a y 20-23
Im aging  Workshops o f  Colorado, L ittleton, 
Colo.; Thom as Hissong, 303-933-9461; 

im agingw orkshops@ aol.com ; 

www.coloradoworkshops.com

June 3-7
Florida School o f  Photography, Daytona Beach 

Community College, Daytona Beach, Florida; 
Teri Crownover, te r i@  fppon line.org; 800 - 
330 -0532 ; M arybeth Jackson-Hamberger, 

m ham berger@ com cast.net; 

www.fppfloridaschool.com

June 3-7
Illinois Workshops, Grafton, 111.; Bret W ade; 

217-2+5-5418; in fo@  ilworkshops.com ; 
w w w . i lworkshops.com

June 3-7
Kansas Professional Photographer School, 
Bethel College, Newton, Kan.: Ron Clevenger. 

785-242-7710;rnstudio@sw hell.net; 
www.kpps.com

June 3-7
M id-A m erica  Institute, University o f  

Northern Iowa, Charles Lee, 641-799-8957; 
lees@pcsia.net; www.maipp.com; Al DeWild, 

D irector; am dew ild@ iow atelecom .en t

June 10-14
PP  Oklahom a School, St. G eogory ’s 

University ; G len Cope; 580-628-6438; 
gm cope@ sbcglobal.net; www.ppok.org/school

June 10-15
G reat Lakes Institute o f  Photography ; 

N orth w estern  C ollege, Traverse City, M ich .; 

M ark  A llen ; 989 -686 -6917 ; 
m a rk lfo to @ a o l.c o m ; w w w .g lip .o rg

June 17-22
W est Coast School, University o f  San D iego, 

San D iego, Calif.; Lisa Jaeger, K ip  Cothran; 
800-439-5839 ; lisa@ prophotoca .com ; 

kipphoto(5 aol.com; wwv.projrfiotoca.com/wics

June 17-22
Golden Gate School, M ills College, Oakland, 

Calif.; Julie Olson; 650-548-0889; 
ggs @  goldengateschool.com ; 
www.goldengateschool.com

Ju ly  15-19
Im age Explorations, Shawnigan Lake, 
British Colum bia, Can.; Don M acGregor; 

604-731-7225; don@  macgregorstudios.com; 
www.imageexplorations.ca/

July 22-27
P P S N Y  Photo W orkshop, H obart/W illiam  

Smith Colleges, Geneva, N.Y.; L inda 
Hutchings; 607-733-6563; ppsnyworkshop 
@  pw sl893.com ; w w w .PPSNY.com

August 5-9
East Coast School. D ow ntow n  Raleigh 

Sheraton, Raleigh, N.C.; Rick G ibbons; 

336-883-7104: r ickg@ triadb iz.rr.com ; 
www.eastcoastschool.com

August 6-9
Long Island Photo W orkshop, Sheraton 
Hotel, Smithtown, D ing Island; Jerry Small; 

jerry@ jsm allphoto.com ; 
www.liphotoworkshop.com

PPA-APPROVED CONTINUING EDUCATION SEMINARS
April 29 May 7
C/E: TEP with Doug Cordon, West Seneca, C/E: Photoshop for the People, Batavia, III.,
N.Y., www.bnpp.org 630-761-1904

April 30-May 4  May 7
C/E: David Ziser’s Digital Master Class; C/E: Study Abroad with Paul Wingler in
Cincinnati, Ohio; Susan, 800-292-2994; Copan, Honduras; 919-471-6206;
www.davidziser.com pwphoto@mindspring.com
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October 29-31
C: Triangle PA, Creentree Holiday Inn, 
Pittsburgh, Pa.; Becky Homich, 724-869-5455; 
trianglephotographers@verizon.net; 
www.trianglephotographers.org

November 4 -5
S: APP of Illinois; Peoria, III.; Pere Marquette, 
8 0 0 -8 3 8 -A P P I; www.appillinois.org

November 11-12
C: PP of Ohio, Hilton Easton, Columbus, 
Ohio; Carol W orthington; carol@ppofohio.org

Future Events
January 14, 2 0 0 8
S: PP of Massachusetts; Susan White & Mark 
O'Connell "From Diapers to Diplomas"; Linda 
Pedi, 978-686-6536; www.ppam.com

January 2 4 -2 8 , 2 0 0 8
C: Kentucky PPA, Cincinnati M arrio tt at 
River Center, Covington, Ky.; Randy Fraley; 
606 -92 8-53 33; rgimagel@aol.com; 
www.kyppa.com

February 1-5, 2 0 0 8
C: PP o f Michigan, M arrio tt Ann 
Arbor/Ypsilanti at Eagle Crest Conference 
Resort; Scott Green, 248-318-5182; 
edir@ppm.org; www.ppm.org

February 2-5 , 2 0 0 8
S: PP of Iowa, A irport Holiday Inn, Des 
Moines, Iowa; Christy Brinkopf, P.O. Box 
108, Sumner, IA 50674; 563-578-1126; 
ppichris@iowatelecom.net; www.ppiowa.com

February 16-20, 2 0 0 8
C: Southwest PPA, Arlington Wyndham 
Hotel & Convention Center, Arlington,
Texas; Michael Scalf, Sr., P.O. Box 890727, 
Houston, TX 77289-0727;
281-332-1880; michael@swppa.com; 
www.swppa.com

March 7-12, 2 0 0 8
C: PP o f North Carolina, Inc., Sheraton 
Imperial Hotel, Durham, N.C.; Loretta Byrd,
459 Greenleaf Road, Angier, NC 27501; 8 8 8 - 
404-7762; ppnc@ earthlink.net; 
www.ppofnc.com

June 22-23, 2 0 0 8
S: Kentucky PPA; Embassy Suites,
Lexington, Ky.; Randy Fraley, 6 0 6 -9 2 8 - 
5333; rgimagel@aol.com; www.kyppa.com

November 9 -10, 2 0 0 8
C: PP of Ohio, Hilton Easton, Columbus, 
Ohio; Carol W orthington, carol@ppofohio.org

February 26-M arch 4 , 2 0 0 9
C: PP of North Carolina; Sheraton Imperial 
Hotel, Durham, N.C.; Loretta Byrd, 8 8 8 -4 0 4 -  
7762; ppnc@earthlink.net; www.ppofnc.com

October 5 -6 , 2 0 0 8
S: Kentucky PPA; Hyatt Regency, Lexington, 
Ky.; Randy Fraley, 606-92 8-53 33 ; 
rgimagel@aol.com; www.kyppa.com

March 14-17, 2 00 9
C: Minnesota PPA, Arrowwood Resort and 
Convention Center; Joanie Ford, 7723 
Brooklyn Boulevard., Brooklyn Park, MN 55443; 
763-560-7783; fordstudio@ comcast.net; 
www.mnppa.com

November 15-16, 2 0 0 9
C; PP of Ohio, Hilton Easton, Columbus, 
Ohio; Carol W orthington, carol@ppofohio.org
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116th Annual
PPA INTERNATIONAL PRINT COMPETITION

YOUR photo

International Print Competition
Enter your best work in th is world renowned competition!] 

Your print could become part of the International Print |  

Exhibition at Imaging USA, where thousands o f your pee-' 

will behold your unique talent. Your image m ight even get 

published in PPA's Annual Loan Collection book. You'll be 

earning m erits and getting the recognition you deserve!

Your participation, whether your firs t tim e or your fiftieth 

will give you a sense o f satisfaction and accomplishment.

P ro fe s s io n a l  P h o to g ra p h e r s  
o f  A m e r ic a

www.ppa.com

2007JUDGES
WORKSHOP
Are you interested in learning what goes on behind the scenes 
during print judging? Now is the perfect time to learn!

WHEN: Sun., July 22 - Wed., July 25,2007

WHERE: Daytona Beach Community College
Daytona Beach, FL

TUITION: $525 (does not include meals)

HOUSING: Hampton Inn, Daytona Beach 
Make room reservations by calling Jim Dingwell, 
PEC Administrator, at 866-591-9190 or by email 
at jdingwell@ppa.com.

Join PPA-approved jury chairmen Barry Rankin 
and Dennis Craft as they demystify the world of 
image judging. Held in conjunction with the 
International Print Competition in Daytona 
Beach, Florida, this class will explore the ins and 
outs of what makes a print "merit worthy" and 
will provide students with the opportunity to 
observe competition process and protocol. 
You'll leave this course feeling confident in your 
ability to identify merit images.

$100 per night single occupancy 
$50 per night double occupancy

GENERAL INFORMATION:

PPA members with ten exhibition merits will receive PEC credit for attending the workshop.
This workshop fulfills one of the requirements for becoming a PPA approved affiliated juror. Each 
attendee should bring four competition quality prints.

• Free continental breakfast at hotel
• Welcome barbeque on Monday night
• Lunch available Monday-Friday in on-campus cafeteria
• You are responsible for all meal costs (except Welcome 

BBQ). Several restaurants are located by campus.

REGISTER: online at httpV/events.ppa.com 
by phone at 800-786-6277.

Q p Q ? Professional Photographers of America

http://www.ppa.com
mailto:jdingwell@ppa.com


JACK REZNICKI 2007-2008 PPA PRESIDENT
CR.PHOTOG.,API

The Value of Community
Over many years and through 
the several associations I’ve 
worked in, the one question 
that floats up and frustrates 
me the most is “Why should I 
join?” With PPA the answers 
have been very easy. There 
are many obvious choices to 
talk about: indemnity, a voice 
on Capitol Hill, education, 
Studio Management Services 
for business help, a phone 
with a person to simply hear 
you and help you, and on and 

on. These are the obvious “cost" benefits. But when you look at 
any association, the real reason for many to become a member 
is the “value" benefits. As the saying goes, some people 
understand the cost of something, but not the value. They are 
two very different ideas and concepts. When one phone call to 
PPA gets you out of a jam that could have killed or crippled your 
business, your concept of cost, value and worth changes.

Those members presented a plaque to PPA at Imaging USA 
2007, telling the world (as engraved on the plaque), “Forever 
Grateful.” That’s a community coming together. That's value.

I’m writing this first column as President immediately after the 
Imaging USA convention in San Antonio. What a great gathering 
of our community! Many people who couldn't attend still used 
the OurPPA.com Forums to find out what attendees saw, what 
they learned, what they walked away with. The underlying feeling 
I walked away with was a feeling of family, a feeling of 
community. The education was great, the parties were 
awesome, the toy show that we call the Expo was as fun as 
always. But those were just the obvious things The value of 
membership and the value I got out of that great convention 
was being with my “clan," my community, my family. It's the 
intangible feeling of friends gathering that has the greatest 
value for me.

The convention, as usual, drew photographers from all over the 
world. We don't all speak the same language, as far as English, 
Spanish, Chinese, Korean, Japanese. Canadian (Ehy?), and so 
many more, but we all spoke the language of photography

When Katrina hit members in the Gulf Coast area, PPA didn't 
just ask others to contribute: PPA opened its own wallet and 
committed hundreds of thousands of dollars because it was 
faster and more immediate. PPA well understood that it could 
not make those members whole. But when your world has 
been turned upside down and inside out, a freely given check 
of several thousand dollars has greater value than the amount 
on that check. It’s a hand reached out to say, “We know. We 
will not forget you.”

So when someone asks me the value of joining PPA, I have to 
ask if they want the cost benefits or the value benefits I can go 
for hours on either.

Jack Reznicki, Cr.Photog., API 
Jack Reznicki Studio, Inc. 
New York, NY

IMAGING USA 2007 WAS GREAT! SEE YOU NEXT YEAR IN TAMPA!



News & Notes[pH a] Today
News from the World's Largest Professional Photography Association

PPA'SNEW PRESIDENT
Jack Reznicki, Cr.Photog.,APl 

PPA Member since 1988 

Shoots: Commercial/Advertising

Location: New York

Ja ck  Reznicki on the Importance of Education
For PPA s  incom ing  president, the strength  o f  the  association  
is its c o m m itm en t to n e w  kn o w led g e  
B y Je ff Kent

Since the mid-1970s, Jack Reznicki has been making a name 
for himself with his bright, conceptually strong images. Running 
a successful commercial studio in New York. Reznicki 
specializes in photographs of people, which appear in ads for 
clients such as Toys ‘R’ Us. Procter & Gamble, Eastman Kodak, 
Reader's Digest. Johnson & Johnson, AT&T, Tylenol, Jose 
Cuervo, Hyatt. Crest, Playtex, Time magazine and others. Over 
the years, Reznicki has cultivated a unique style through 
constant shooting, attention to conceptual movements and 
inspiration derived from the likes of Edward Steichen, Jay 
Maisel, Howard Schatz and Gregory Heisler.

Perhaps the most important factor in Reznicki's success has 
been his concentration on education. From the day he first 
picked up a Russian-built imitation Leica camera at age 12, he 
has constantly sought to increase his photographic knowledge. 
When he entered professional practice, Reznicki made himself a 
student not only of the art form, but of the business and politics 
of professional photography as well.

This attention to education is what first drew Reznicki to PPA 
back in 1988 Already established in the business and active 
in a couple professional organizations, he was encouraged by 
some PPA members to get more involved in their association. 
Impressed by PPA's focus on continuing professional education, 
Reznicki started attending PPA events and seminars. Then one 
day. while attending the PPA national convention, he wandered 
into a PPA council meeting. “I wasn't a member at the time, but 
I was invited in and welcomed," remembers Reznicki.
“Everything was very open. I was impressed by the 
professionalism of the meeting and how efficiently it was 
conducted. I liked seeing how issues floated up from the 
members and received real attention."

Reznicki joined PPA and became active immediately. He worked 
with a few different committees and signed on as a trustee of 
the Winona School. He tried to learn about and interact with as 
many different areas of the association as possible. A little over 
a decade later, his contributions were recognized by PPA’s 
board of directors, and they asked him to join their ranks.

In his time on the board, Reznicki has seen a lot of change in 
the association. There have been improvements in the 
functioning of the board, the communication with members 
and in several areas of internal management. However, one 
of the most exciting changes involves a turnaround in the 
perception of PPA within the industry. “When I first got involved 
with PPA. my associates in the commercial field looked at me 
a little strangely,” says Reznicki. "Now all of those 
photographers, and all the members of our sister associations, 
recognize that PPA is the premier association in the industry.
If there's a push in Washington [on behalf of professional 
photographers] and PPA isn't involved, then it’s going to be 
a very difficult initiative to achieve.”

Reznicki feels that PPA has become the dominant force in 
professional photography because it backs up its words with 
action. “PPA doesn't just talk the talk; it walks the walk," he says. 
“We provide real benefits for our members and we actively lobby 
the government on their behalf.”

Among those real benefits. Reznicki highlights his original 
inspiration to join: education. He feels that PPA’s commitment 
to educating the 21st Century photographer, particularly when it 
comes to business practices, is what sets it apart. “The 
business information we provide is unparalleled, and that has 
been particularly appealing to the younger generation of 
photographers," says Reznicki. “Five to seven years ago, when 
we d produce a business class, it was like pulling teeth to get 
people to show up. Today, when we sponsor a business class, 
it’s packed. If you look in the audience, there are a lot of 
younger people. These photographers realize that they get more 
than a medal or ribbon out of their membership in PPA; they get 
a real knowledge base that puts money in their pockets."

The influx of business-sawy younger photographers has 
helped PPA reach an all time high in membership. As Reznicki 
points out, the numbers don't lie; and with more than 17.000 
members. PPA is truly the biggest and brightest star in the 
pro photo galaxy

“During my time on the board, I’ve seen what was a good 
association become a great association," he says proudly. “The 
way things are going now, I believe that trend will continue."

VISIT h t t p ://BOARD.PPA.COM TO READ ABOUT OTHER MEMBERS OF PPA'S BOARD OF DIRECTORS.

P2 Professional Photographers of America | www.ppa.com
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STUDIO M AN AGEM EN T
SERVICES

Workshop
Monday, May 7?-?Wednesday, May 9, 2007 | Morton, Illinois at Haven, an Educational Retreat located at vGallery Studio

Register today so you don’t miss the opportunity to participate in this intensive, hands-on workshop.

Put your studio on the road to increased profitability in 2007 by attending PPA’s 3-day Business Plan Workshop. 
You will receive practical, down-to-earth instruction in both a group setting and one-on-one consultations on 
these essential elements for business success:

Sales levels that assure profitability 
Pricing photography for profit
Knowing where your business stands through easy-to-understand managerial accounting 
Creating a compelling business concept and brand 
Strategies for marketing your business image 
Building marketing partnerships to increase business volume 
Marketing back to existing clients 
Comfortable sales techniques that increase profitability  
Can you afford to hire employees?
What is an appropriate business model for your studio?
Making the most of your studio space -  home studio or retail location

Instructors:

1

Vickie Taufer 
M.Photog.Cr., CPP 

j  SMS Consultant

Scott Kurkian, PPA Chief Financial Officer 
and Director of Studio Management Services

9

Lori Nordstrom 
M.Photog.Cr., CPP, ABI 
SMS Consultant

Ann Monteith 
M.Photog.Cr., CPP, ABI. API 

SMS Consultant

Register Today -  call PPA’s Customer Service Center at 800-786-6277.
You must be a PPA member to  attend the workshop, in addition, you must have produced at least $25,000 in gross sales during 2006 to  qualify for this o r future 
Studio Management Services workshops.You must also complete a studio information questionnaire and submit your 2006 business tax return. 2006 financial records, 
marketing materials and price list. (For more information about these requirements call 800-786-6277). An SMS accountant w ill use that information to  compare your 
financial results to  industry averages and best-performing studios in your category. An instructor will then create an easily understood 2007 financial plan that 
maximizes your pro fit potential.

Workshop fee:
$899.00 per person / 2nd person from same studio can attend fo r $299.00. A  $300 non-refundable deposit is required to  hold a spot in the class: the balance will be due no 
later than April 25.2007. If you w ork w ith your spouse o r business partner, it  is strongly recommended that both attend.

This workshop is limited to  18 studios. In order to  be guaranteed a space in the workshop, all required information, along with a $300 non-refundable deposit, must be 
submitted to  PPA no later than April 25. 2007.

Future classes in 2007 wilt be held as follows: June T8-20 Houston. TX I August 20-22 San Francisco. CA I December 3-5 Atlanta. GA
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News from the World's Largest Professional Photography Association

M EET PPA'S 2 0 0 7 - 2 0 0 8  BOARD OF DIRECTORS
Guiding the world's largest professional photography association is a tough job, and PPA is fortunate to have the right visionaries at 
the helm. Our board of directors understands exactly what you face daily and knows the programs, education, benefits, and services 
you need to be successful. After all, they are professional working photographers just like you. We are pleased to introduce the three 
newest members to your Board of Directors. Check out www.ppa.com for full biographies on your entire Board of Directors.

Jack Reznicki, President
M PhotogCr., API, F-ASP

Dennis D. Craft, President-Elect
M Photog Cr, CPP API. F-ASP

Ron Nichols, Vice President-Treasurer
M Photog Cr . API

Michael G. Taylor 
Chairman of the Board
M Photog CrHon-M  Photog. API. F-ASP

Ronnie Norton
ABI. Qualified European Photographer

Louis Tonsmeire
Cr. Photog.. API

Don Dickson
M Photog.Cr., CPP

Sandy (Sam) Puc'
M Photog Cr. CPP ABI

Ralph Romaguera, Sr.
M Photog. Cr.

Carol Andrews
M. Photog. Cr.

Susan Michal
M. Photog. Cr., CPP ABI

Tim Walden
M Photog Cr, F-ASP

Michael Green, VP of Sales & Marketing
Unique Photo - Industry Advisor

Carol Andrews
M Photog Cr.
A PPA member since 1986, Carol has 
served many roles in professional 
photography For instance, she has been 
a PPA Studio Management Services 
Consultant in 2005 and 2006. And in 
addition to her membership in the Texas 
Professional Photographers Association 

(of which she was on the Board) and leadership in different 
PPA committees, she was the 2006 Chairman of the PPA 
Business Initiative Committee.

Carol's ability to soulfully connect with her subjects on an 
individual basis has earned her the reputation for being the 
"Oueen of Hearts," with all she embraces in her photography, 
consulting, and coaching, as well as her life. Carol is known 
as one who loves the magic in photographs, and you can see 
it in her work Her award-winning photography has been jurored 
and accepted at the world's largest exhibition of photography, 
Fotofest. not to mention exhibitions at Epcot, in Germany, and 
various PPA Loan Collections.

Susan Michal
M Photog Cr.. CPP ABI 
Susan Michal is an internationally 
published, award-winning portrait and 
wedding photographer. Susan holds the 
PPA Master of Photography and 
Photographic Craftsman Degrees and is a 
Certified Professional Photographer She 
has been named North Florida's 
photographer of the year and is an active 

member of several professional photography groups, along with 
PPA. In addition, Susan has won numerous awards and has had

the distinction of having five of her images included in PPA’s 
Loan Collection. Susan’s unique photographic images have 
been featured in calendars, greeting cards, and posters around 
the world. Her specialty is capturing what is special and unique 
about individual sessions to create memories that will be 
treasured for generations.

% '
Tim Walden
M. Photog. Cr, F-ASP 
Tim earned his PPA Master of 
Photography Degree at the age of 25. 
with his Craftsman Degree following 
soon afterwards. In Kentucky, his 
home state, his work has won many 
awards, including Best of Show and 
Master Photographer of the Year 
several times. In Kentucky, Tim 
scored a perfect 100 on his print “His 

Father’s Eyes,” breaking all previous records of combined point 
total. He also scored a 100 on his print “Hands of Time,” 
winning the top scoring print in at the Mid-East Regional 
Convention. His work can be seen in many Loan Collection 
publications, and Kodak has recognized his work through 
Gallery Awards, a Gallery Elite, and publication in their Portrait 
Book He has shared his ideas at Kodak Pro-Team meetings 
and is a Kodak Mentor. In 2004, he received the Imaging 
Excellence Award and in 2007, PPA awarded him the Gold Level 
Photographer of the Year Award for two entries being accepted 
into the Loan Collection. Tim is a member of the Society of XXV, 
a qualified National Juror, an accomplished lecturer, and has 
been named a Fellow by the American Society of 
Photographers. At Imaging USA 2007, Tim and his wife Beverly 
were awarded the coveted Gerhard Bakker Award for 
outstanding photographic education.
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M E D IT E R R A N E A N  CRU ISE

J U L Y  7 - 1 4 ,  2 0 0 7  | D E P A R T S  F R O M  B A R C E L O N A ,  S P A I N

H osted by th e  Texas School o f P rofessional P h o to gra p h y

Ready fo r  th e  tr ip  o f  a life tim e ?  D o n 't miss th is  seven-day cru ise th a t 
sails ro u n d -tr ip  fro m  Barcelona and w ill s top  in six ports  o f  call:

Barcelona | Naples | Civitavecchia | Livorno | Villefranche | Palermo
PPA's M e d ite rra ne a n  Cruise is th e  p e rfe c t w a y  to  com bine  a g re a t t ravel experience w ith  to p  n o tch  e du ca tion . A f te r  e n jo y in g  

the b re a th ta k in g  b e a u ty  o f  each c ity , th e  ship w ill head back o u t to  sea and th e  e duca tiona l sem inars w ill be cond u cte d . You 'll 

learn va luab le  tip s  and techn iques fro m  some o f th e  m ost ta le n te d  and successful pho tog ra ph e rs  in th e  in d u s try .

The seven-day cruise leaves o u t o f Barcelona, Spain on July 7  and re tu rn s  on  Ju ly 1 4 . In te r io r  s ta te ro o m s s ta rt a t $1 ,3 1 9  plus 

tax. A d epos it o f $ 3 5 0  per person is requ ired  and a lim ite d  n u m b e r o f cabins are availab le  a t these special rates. Full p a ym e n t is 
due 7 0  days p rio r to  dep a rtu re .

For more in fo rm a tio n  a bo ut th is fabu lous educationa l tr ip , please contact Joe o r V is it h ttp ://even ts.ppa.com  to  dow nload a reservation form
Vicki W r ig h t a t Southw est Passage a t 8 0 0 .593 .0 0 7 3 , o r  v is it h ttp ://even ts .ppa.com .

\.  v -  / - - - V /  ... W -  '■/• • . 7 % - y y  V v  - .• %
*/•*>. V ,  .

P ro fess iona l im aging sem inars o ffe red  in s tud ios w o rld w id e  m

s u p e r m o n a a y
1  A P R I L  7  9 n  n  72 0 0 7

Coming to a neighborhood near you.
PPA's Super Monday seminars offer you affordable, nearby photography education. It's also a day that unites 
you with photographers around the world! Join your colleagues in a local studio for a day that will introduce 
you to new methods, broaden your horizons, and bring you new vision.

Choose the location and subject matter that suits you best. But don’t delay—register by March 12, 2007 to 
receive discounted registration (only S99). On-site registration is S120.

To register, or for course listings in an area near you, go to http://events.ppa.com or call 800.786.6277.

N e w  S k i l l s

I m p r o v e d

B u s i n e s s

I n c r e a s e d  

P r o f i t  M a r g i n s
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News fro m  th e  W orld's Largest Professional P h o to gra p h y Association

NOW ONLINE...
2007 COUNCIL 
MEETING ATTENDANCE
PPA's Council is the association’s elected 
legislative body, which meets annually to 
review progress, monitor programs, and 
approve or decline action items. The 2007 
Council meeting was held January 15 at 
Imaging USA in San Antonio. Texas. A record 
of attendance is available in the Council 
section of www ppa.com.

CONGRATULATIONS TO PPA's 
AWARD & DEGREE RECIPIENTS
People came from all around to take part in 
this year's Awards & Degree Ceremony For a 
complete list of award and degree recipients, 
please visit the Competition & Awards section 
o fwww.ppa.com.

NEW MEMBER SECTIONS AT 
OURPPA.COM
You asked for it, you got it! OurPPA.com 
now has three new members-only sections: 
Studio Operations, Pricing & Marketing, 
and Member Open. Check them out today 
at www.OurPPA.com.

K a n sa s  P ro fe s s io n a l 
P h o to g ra p h e rs  S ch o o l
June 3 - 7, 2007 | Bethel College 
Newton, KS
C o n ta c t: Mark Weber 
mark@wichers.com | 785-271-5355 
W e b s ite : www.kpps.com 
T u it io n : Full and half-week classes:
$495 full week or $295 half week with 
early enrollment 
C o u rse  in fo rm a tio n :
Foamology - John Burroughs 
Advanced Photoshop - Eddie Tapp 
Discovering your Unique Factor - Rod Evans 
Cooking Your Files - Jett Locklear and Bentley Skeie 
Basic Wedding Photography ■ Don Brent 
Beginning Photoshop - Steve Attig and Fred Taylor 
Background Painting Plus - Susan Trett 
Tony Wichers 1 Basic Photography - Date Williams 
Advanced Photoshop - Steve Attig and Fred Taylor 
Beginning Environmental Portraiture - T Michael Stanley 
Dip a Paintbrush into your Photographs with 

Corel Painter - John Derry
Introduction to the Complete Digital Studio - Stan Retmer 
Additional courses - Bruce Hudson and Jen Hillenga

F lo r id a  S ch o o l o f P h o to g ra p h y
June 3 - 7 ,  2007 | Daytona Beach 
Community College | Daytona Beach, FL 
C o n ta c t:  School Registration 
Teri Crownover | 800-330-0532 
teri@fpponline.org
W e b s ite : www.fppfloridaschool.com 
T u it io n : $475 for FPP/PPA members, 
$600 Non Members 
C o u rs e  in fo rm a tio n :
Photoshop Fundamentals - At Audleman 
TurboCharge your Workflow - Mark Campbell 
Leading Edge Digital Techniques - Frank Cricchio 
From Brides to Babies - Rick & Debra Ferro 
Seniors 911 - Katen Henderson 
Portrait & Wedding Photography - Huth & Booth 
Becoming a Digital DaVinci - Kevin Kubota 
Print Competition - Barry Rankin 
Portraiture - the Simones 
Business with Attitude - Greg Stangl 
Where Art & Business Come Together - 

the Waldens & Ann Montieth 
Painter - Helen Taney

I ll in o is  W o rk s h o p s
June 3 - 7, 2007 | Pere Marquette State 
Park I Grafton, IL 
C o n ta c t: Bret Wade 
info@ilworkshops.com | 217-245-5418 
W e b s ite : www.ilworkshops.com 
T u it io n : $595 
C o u rs e  in fo rm a tio n :
Basic Course - Louis Tonsmeire 
Children - Lori Nordstrom 
Portraiture - Carl Caylor 
Creativity/PhotoShop - Thom Rouse 
Portraiture/Marketing - Monica Sigmon 
The popular Masters Class - 

various topics and instructors

IN MEMORY
PPA extends its condolences to the family and friends of long-time 
PPA member from Pennsylvania. Jerry Interval. A fine teacher and 
wonderful portraitist. Jerry passed away December 4, 2006. at the 
age of 83 He worked fulltime as a photographer from the early 
1960s until 2001 Jerry was a member of the Triangle Photographers 
Association and the American Society of Photographers, and was a 
speaker in the 2005 Legends Super Monday programs. As good 
friend Bob Knuff said Jerry would give you the shirt off his back" 
and was always ready to lend advice

LAST CALL TO BE COUNTED IN ^
March 31.2007 is the last day to" join PPA's 
Sweepstakes Marketing Cooperative. Don’t 
miss this profit-raising program, which will 
help you draw more high school seniors, 
families, and wedding clients to your 
business. Visit www.lmageSvreepstakes.com 
to join or get more information.
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WHERE THE PROS GO FOR THE BEST IN REPRODUCTION SERVICES

' V , -

m

G R O U P  P H O T O G R A P H E R S  A S S O C I A T I O N
WHOLESALE YOUTH SPORTS PHOTO LAB

• Convenient Data Entry Options
• Color Analyzing f - i s
• Print Size Cropping 1 jgg£p -
• r Mobile Order & Data Entry
Visit us online at www.groupphotographers.com 
or call 800-558-5010 x114 for a complete info packet.

“'What1 love most about 
'Portrait City is the personal, 
one-on-one relationships 
that we develop with each 
of our clients."

Portrait Cityill Care Is Our ‘Fimshtna Touch
www.portrailcity.net a Custom Color Company

Call a personal team leader at 877-875-1234

:

Valid on unlimited quantities for a limned time 
only. May not be combined with any other offer 
Visit our website for details.

www.bayphotopro.com

The Nation's Premier ROES Lab

r ~ / ~
p r o l a b

e x p r e s s

—  Visit us at www.prolabexpress.com! 
or sive us a call! 1 -8 8 8 - 537-1304

I n d u s t r y  L e a d i n s  S o l u t i o n s  
F o r  t h e  P r o f e s s i o n a l  P h o t o s r a p h e r !

Qua ty- 26 years Professional Experience •  Integrated Client Fulfillment Center 
Film or Digital • W indows or Macintosh •  200 -  Ready-Made Templates 

Proof Boors •fin ished Albums •  Double-Sided Press Printed Greeting Cards

Express Prints in 24 Hours! »FREE Shippms on Most Orders!

McKennaProlp
Fast ... Guaranteed

1  d a y  portraits 2 d a y  e v e n ts  3 d a y  u n d erc la ss

V is it us at WPPI, Booth 1318, and win a FREE t-s h ir t .
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WHERE THE PROS GO FOR THE BEST IN REPRODUCTION SERVICES

No other rebates 
or discounts apply.

• Trader Cards • Magnets
• Memory Mates • Bag Tags
• Magazine Covers • Pennants 

Available for other sports, too.

i Advanced cam-800-241-9234
! E S S E F *b O l U I l O n S  advancedphoto.com

___________

% ALLIED
|) H O I O (| It A |)H I (

and all the products & services 
you w ould ever need

St >: :ug l yhoUlffaplvr> / ‘>5/

o . * u uu  . vllit tlpltoio.t om

Download iobPrints submit your order teterencing code 
PPAM AR07 . $75  cred it

•  •vttnc.
w w w .o lite d p h o to .c o m  
t nfcv 1 ’ o il ied ph o to  .com 

1 8 0 0 3 6 8 6 1 1 3
Lab

experience excellence

$1,65 8x10 | 24hr turn-around free shipping

See us at WPPI colorincorporated
Booth “729 colorincprolab.com rzi

ACKPRINT
B R IG H T R O O M  F U L F IL L M E N T  S E R V IC E S

F in a lly .. A S e rv ic e  th a t w o rk s  as h a rd  as YOU do! 

C u s to m  s to re  f r o n ts  w ith  e -c o m m e rc e  c a p a b il ity

S u p e rio r to o ls  b u ilt  to  m a rk e t and se ll p h o to s
S im p le  p r ic in q  - No h id d e n  FEES

W e u se  o n ly  K o d a k  P r o fe s s io n a l E n d u ra  P a p e r

Toil Free 866 343 5692 backp rin t.co m  partnersh ips * b ackp rint.com

ARK-LA'IEX
Your Source for

U N D E R C L A S S  

P R I N T I N G  

&  A D D - O N S

✓  100 %  of Deadlines Met
✓  8x10 Units as low as 98c 

✓  Excellent Quality
✓  Free Ordering Software
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Coffee Ta6Ce W edding <Boofe (Designed, (Printed,
and(PCacedin an A f6u m  S ta rtin g  a t

H H  / I  ^
|||| Hallmark Imaging|H'Hallmark Imaging

w w w .  ( i a C ( m a r f { C a 6 s .  c o m  1  - 8 0 0 -  7 3 2 -  7 3 0 0

Metallic Paper Cover 
Press Printed Pages 
Available in 4x5 to 8x8
Starting at just S25  
per album!

800.827.7101 www.LustreColor.com

Maximize your Potential Profits with 
LustreColor's Paperback Companion Albums

Expand Your Options w ith...

CPQ Press
P RODUCT S

A *
• Now get CPQ quality using our :i S»

new indigo Press digital 
publishing options ___ ^

• Perfect for calendars, proof n i  
books, brochures, posters, etc. W

• New Hardback Cover Books
• Easy Online Ordering.

800.537.8399
site for more details.

www.cpq.net

C L I C K .  P R I N T .  A n d . . . _____________

V  Quality
^  V'* Service

V  Great Prices

No wait. No delays. Go to proofsRus.com 
and uploadorder your proofs... today!

At proofsRus.com
we've made it easy 
to order quality, 
affordable 
prints!

V  FREE Shipping

8x10's-1.92 
11x14 s - 3.85 

16x20 s - 12.56

Let CCS gu ide  you in m arketing your team s & leagues
online vs. 1he traditional m ethod o f pre-pay,

In addition to complete E-Commerce Solutions, CCS offers:
• 2-Day Print Turnaround
• Weekly Direct Deposits
• Shipping Direct to Vour Customer
• Hundreds o f Sports Graphics
• Free Webex Training

S h o o t .  C l i c k .  D o n e .
Call 1-800-336-4550 (x 251) • www.candid.com
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WHERE THE PROS CO FOR THE BEST IN REPRODUCTION SERVICES

Photographic and press printed products

W e ' r e  o l d  e n o u g h  t o  k n o w  b e t t e r

american color imaging

40 years - and growing...because a GREAT photo lab just doesn't happen overnight!

www.acilab.com/wise 800-728-2722

Now is the time to market 1 H . V  
graduation cards to the class i M 
of 2007! We offer a variety of 1 ■ f c X M  
unique cards styles to choose 
from. Check them out today!

Photograph* by Chris lommoi Photography©

* Otter vobd urtfi ApttMS. 2007 Cords n the tmog* Express catalog start of 
SO 40 with the 2$S off offer Not «uM with ony other offers We reserve the nght to
dstoetinue or modfy thrs offer at any hme AB cords fxiud* envelopes

Log on to download free software:
► ►  800.533.8030 www.HJPro.com

Get 30% Offal

Sw/e 30% offseled ll/umcr'* Photo Products, ProPhotoCreationsm and large 
ProPrjn^frodumWay through March 3I“. Simply coll 1-8007477371 or 

visit www. apollo-imagizing for more details. / \ p Q / l Q

Weddings
rs TO 30x40 • Ac BUM Templates

Sports «*
• Ucmoov Mates • Our

R O ES

Wallets to 30x40 • Album Templates • Mounts Package Piwnting • Goto on Seven Stamping

Packacss • UtMonv Mates • Buttons • Tramps F*a* c* Dotal • Slats op Bavce • Ritoucmmg

Portraits
;t Pwntimg • Goto on Seven St

ProShots

M j
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Fram ing an d  M atting - Retouching - Free R O ES S oftw are -

l i   ̂ t j
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Qualify Prints • Outstandina Turn Around Time

w1vw.michi9anphoto.com

The Urgett Selection of 
Original Artwork on the Web

Complete Product Suiter 
meet all your needs in one place

Large Variety of 
Sport & Landmark Products

^ D IG IT A L  O PTIO N S!
frife sTUoio soptwâ '

'  W eddings • P o rtra its  • Packages • Sports

E a sy  O nline Ordering O ptions
• P a ck a g e r - Custo m  print design er
• P resenter - S lide show  d esig n er
• P a ge r -  C u sto m  layouts design er

Sim ple O nline Print O rdering
• H osting - Album  design er

Fast Im age Ordering P o A I I id o ’
We support nonacc I Quality Assurance Tools 

I • End your color worries now!

?t3 South 7yk» Avarue 
lakeland. Ptaerta 338C'

w w w . p r o p h o t o i m a g i n g . c o m  1 - 8 0 0 - 2 3 7 - 6 4 2 9

oices^B 
7t. *

All the choices 
you want.

All the service 
you expect &

$ 1 0 0
JL 8x10 prints

F  I L  M E T

8 0 0 .2 5 5 .9 0 0 0
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T W m m S m,W ̂ n 0 M M j l l

The prolab solutions you 
W e’ ll give you $25 in free prints 
Try us out risk free 

www.photoprisnKolorlab.com for details

Ad size: 37/' x 2'A
12x rate: $385.00 gross per month

Sign a 12x contract and receive a double size 
feature ad twice during your contract year at no 
extra charge.

www photoprismcolorlab com 
in foiephot oprtsmcokirUb.com 
Toll Free - 866 928 0400 
1L - 847.928 0400

Contact Bart Engels, Western Regional Manager, 
847-854-8182; or Kristian Klipsch-Smith, Eastern 

I Regional Manager, 4 0 4-522 -8600, ext. 279;
I  for more information.
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C h e c k  o u t  o u r  n e w  p r o d u c t s  w w w . c h n s i m o g i n g . c o m

f
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2007 ■  * .

~  C h r i s t o p h e r

20 10x10 prints $179 
30 10x10 prints $239

(off** stf* <7voaat> >] —

'  61 years of Superior Quality

Fully assembled Albums 
printed and mounted 

for one low package price

KUliEftiU

C  '// ; C * / / / //<• . n  /
Impress your clients with a presentation that showcases 

your photography.

PC L WEST
IM A G IN G

Toll free: (866) 725-9378  
w w w .pclw est.com

We help you create your own
signature brand w ith  our: 

ROES online software
In-house custom design of your album pages 
In-house print and binding services 
Commitment to exceptional quality

N e v e r  g o  u n n o t i c e d .

When you entrust your creativity to Full Color, you can be 

certain that we'll deliver customized, affordable photographic 

solutions that help you stand out from the crowd.

F U L L C O L O R

For more information please visit fullcolor.com.

©2006MCok>r H O P T O B V

PHOTO
Difference w m m m

C o u n t  C e s s  

O p t i o n s . . .
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B u y e r s

Gallery
T H IS  SEC TIO N  IS 

THE M O N T H L Y  

RESOURCE 

PH O TO G R A P H E R S  

USE TO  FIND 

THE PR O D UC TS 

TH EY NEED. PU T 

YO U R  M ESSAGE 

P R O M IN E N TLY  

IN FR O N T OF 

IN D U STR Y PROS 

A N D  START 

T U R N IN G  

BR O W SER S 

IN TO  BUYERS.

FREE 2007 
CATALOG
13 2  PAGES
800-466 1755

LQHLMI££S
8 ’k 16'-$39.00 
10’X20’ -S99.00 
16'  witte available J

ORDER ONLINE at..
WWW.backdropoutlct com 
Save 5%  Web code *1PPA

b a c k d r o p

Canvas

prices.
More
Styles
online

2215 S Michigan avc • Chicago* II.* 60616 
312 8-12 6550 312 842 6546 (FAX)

8 0 0 - 4 6 6 - 1 7 5 5

NEW
Petal Mat
3’X3’-S39.00
6 ’x6 ’-$119.00

BACKDROP OUTLET

A LLS C E N IC S  ON SALE 
8X10 C anvas - S149.00 
10 ’x20 ’ M uslin  - S199.00

mention 
for i

Albums Unlimited
www.albumsunlimited.com

--------------------------  New Acrylic
Kingston 
Covers ottered 
exclusively 
by Albums

Sett 
Mount Albums 
by TAP

TAP and
Topflight
Distributor

1- 800-6-ALBU M S 
1 -888 -6 -ALBUM S FAX

Traditional Flora or 
Impenal Albums. 
More Variety - 
More Choices-

♦
♦

<•
❖
o
e
♦
<•

Any/AII s ize s
Custom Imprinting 
Leather and 
Leatherette 
F T P  capability 
Bind Only 
Print and Bind 
Design, Print and Bind 
Studio Demo Discounts 
Lifetime Warranty 
Photo covers

Serving photographers since 1978!

Studio Packages • Backdrops 

Digital Backdrops 

Lighting • Equipment

Call 1-800-767-3122 for 
a FREE Catalog!

w w w .ow ens-orig ina ls.com

Picture this...

No more loose batteries!
•  Store your batteries in a compact 

easy-to-use caddy.

• Great for photographers, pilots, campers 
boaters, musicians and more.

• Available in  many styles and colors.

*7 am finally able to keep all my 
rechargeable batteries in one place and know 

which ones are good and which are used.”
—  Michael Anthony, Michael Anthony Studios

www.personalbatterycaddy.com 
toll free 866.540.7260
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ustom
rack e ts

Camera & Flash Rotating Brackets

Eliminates unwanted red eye and shadows 
Professional looking compact design 

Anodized aluminum for lightweight & strength 
Effortless rotation using roller bearings 

Fits into camera bags

See our website for more brackets

Made m U SA

800-530-2289
w w w .custom brackets.com

@ Pi cto Books
f r o m  p i c t u r e s  t o  b o o k s

Custom Design/Printmg/Binding 
Digital Flush Mount 
Inhousc Production

Pictobooks Website!
+ Online Ordering + Online Template Design 

+ FTP Service + M uch M uch m ore!

Free PictoTools Version 1.7 

Available O nline
50% discount E a s y  d r a g  a n d  d r o p
Studio Samples T e m p la te  d e s ig n

S o ft w a r e  w ith  F T P

1.888.MYPICTO (697 4286) / www.pictobooks.com

Rf.NlALSSANt-T Ti

R f-N A L S W

E l o q u e n c e  S P  .
fSLHEGUSRD

florav
F l o r f n t i n a YANKEE

email infocftmichelcompany com 
1151 S Northpoint Blvd • W aukegan. IL 60085

High School 
Mailing Lists

Student Marketing Group can 
generate all types of High School 

lists to promote your photographic 
services. Select by class year, state, 

county, even zip code. Now you 
can target the right audience —  
at the lowest rates available

516.593.8877 • fa* 516.593.4705 
email: info@studentmar1ceting.net 

www.studentmar1ceting.net

QUALITY M OUNT BOARD

iUFO R OVER 20 /EARS
INKJET PAPER
• Glossy

• Pearl Luster

• 100% C otton

• Acid Free

• Instant Drying

RVIN'
MOUNT BOARD
• Pressure Sensitive
• Heat Activated
• Uncoated
• Double-Sided
• O dd Sizes Available
• Black Mount Board 
COLD MOUNT 
LAMINATOR
• Sizes: 14", 24", 28", 

36" and 48"

FREE SHIPPING on qualified orders

Call today (or prices & samples
Toil free 8 6 6 .4 7 3 .2 5 8 0

-S723 S Washington.Tacoma. WA 98409

pacificmount.com ^ 8

digiproofs
Simple 

and Easy
Easy to view & order... 
technology driven 
yet simple ...

Integrated
Ordering

Redeem prepaid & 
ordering on line ... or 
just ordering online ...

Integrated
Fulfillment

Upload photos, set 
your prices & we will 
take care of the rest ...

Increased
Choices

Single, multi or action 
poses... more choices ... 
higher sales .„

More Than 
Just Prints

Trader cards, magazine 
covers, border prints, 
multi-image collages ...

Personalize
Online

User selects products, 
positions photos, and 
personalizes te x t...

www.digiproofs.com
650-691-4040
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Over 85 Years 
o f  Excellence
• Ready-Made Frames

• Custom Frames

• Graduation Frames 

» Easel Back Frames

■ Wedding Album s

• P roof Books

• Photomounts

> Now Available on C D  

i l l  to frame by LE VIN

Distributors of: faprell Loomis,
Penn Photomounts,Ioj>flight, flora. Renaissance, Renaissance mThe Riutk" and l.evin Impresario i I hums.

THE LEVIN COMPANY
m i W Walnut Street 
Compton. CA 90220 

18001 345-4999 • (310) 608-7418 Fax 
w w w  levinf re m et com

PORTFOLIO
WEBSITES

ttHiK w/.i uifyts

W IT H  UNLIMITED. FLAT-FEE 
NO CO M M ISSIO N, BUILT-IN

I EVENT PROOFING
QUICK. EASY. AUTOMATED. 
S199/YEAR. FREE DOMAIN.

w hy !
TOLL FREE: 1 8 8 8  7 5 5  85 1 8
BIGBLACKBAG.COM

8 0 0 . 5 2 3 . 9 9 4 4  
www. veachco. com

H ot F o il S tam p in g  K its

P o s in g  
R is e r s  

■ P o rtab le  
A ffo rd a b le  
- F lex ib le

Jones 
Rotating 
Brackets- 
Ideal for 

Digital SLRs 
$179.95

Posing
Benches
- Folable 

L ightw e ight
-  Strong

INSANELY REALISTIC DIGITAL MATS
•  Any size and shape mat openings to 40"

• Completely customizable colors & textiles
•  Single or multiple openings (up to 40)

•  Hot a program or a plug-in—  
easy to learn if you have Photoshop

Add $164 to each sale: John shows you
how he does it!

A

s e a Great prices on 
CD/DVD Duplicators, 

Printers,
Publishing Stations

-----and------
Duplication Services

(specializing in short runs)

w w w .duplica tors4 less.com  
Phone 630-550-8592

We stock and 
discount A L L  

TAP PRODUCTS!
Here’s an example:

Buy 6 Folios, 
get 1 F R E E !

Buy 9 Albums, 
get 1 F R E E !

7 %  off mixed 
merchandise 
TAP orders!** *

'  FREE item equal or lesser value.
"M ix e d  orders o(S100.00 or more.
Cannot be combined with other otters.
Otter good thru Oecember 31.2007

Tyndett 1.800-82-SMART /A
(8 0 0 -8 2 7 -6 2 7 8 )  f

www.tyndellphotographic.com
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ILm m m ooo

A ll-Panoramic, No-Split, 
Flush M ount A lbums

A ll  M o m  In c lu d e  
Printing, Binding, and Canting

D ream G arden  A lbum 
4373 Santa A nita A ve 
E l M o n t e , CA 91731 
T e l . (626)443-7288

dreamgardenalbum@yahoo.com
w w w . dreamgardenalbum. com

en

PROFITABLE LISTS
FOR PHOTOGRAPHERS!

i M evvborns

Brides-fo-fie
i p e l  O w n e r s

Professionals

a n d r n o r e ^

Need advice ? Ask us...we c a n  help!

Yea* M s 'U ie t

Contact us today for counts tor your area!
PHONE AND FAX TOLL-FREE 
PH: 800-870-4358 • FAX: 888-710-3956 
EMAIL: in fo @ n d m serv ices .co m  
w w w . n d m s e r v i c e s . c o m

800- 578-7252
www.excclpicturvfrnmeif.ctnn 

Fax: 877-949-1396  , Heady Made Frame»

a. Custom Moulding

3 . Custom Presentation 
Packages

4 . Graduation and Easel 
Back Frames

5. Framing/Photographic 
Supplies

h. Album and Folders

Who else wants to 

Backup images 

in just 60 seconds?

<4 □
& □

backupandburn
800-620-8611

www.ba u p : burn com

Download (he Free 15-Dav Trial Today!

White Glove
FIRST EDITION BOOKS, INC.

The Original
Coffee Table Book"

It's all about choices.

714 841 6900 
www.wgbooks.com

t i t *  /

'  Canvas

Muslin

Props

Muslin Track 

Lift Systems

Free C atalog 800 .2 3 7 .1 8 8 3  
backgroundsbym aheu.com
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M rePhotos
Internet Photo Sales Solution

A Few Kev Features:
• Build your own Portfolio
• Integrates with Existing Website
• Website Design Template Tools
• Web Hosting Included (optional)
• Dynamic Shopping Cart 

Designed for Selling Photos 
Art Galleries to Weddings

•  Multiple Languages

Find us in Adobe Software

www.morephotos.com
888.968.5565 ext 4

TAKE CONTROL
Lighting • Focus - Color - Mood

www.3dLightMaster.com

The Morris Co.
w w w . t h e m o r r i s c o m p a n y . c o m

In t ro d u c in g  th e : 
4-Channel Radio 
Flash Trigger

• Fire rem ote flash units by 
encoded radio frequencies
• 150ft / 50m range w ith 
transm itter on camera 
hotshoe

Includes:
Transm itter, Receiver, 3.5mm 
sync adapter, 12”  sync cord

info@themorriscompany.com 
call us: 312.421.4050 • fax: 312.421.5079 
1205 W Jackson Blvd • Chicago IL 60607

High School 4
Mailing Lists /
for Graduation 
Pictures
Contact us for 
a new view to 
an age old problem.
American Student List lias been providing 
high school student mailing lists to hundreds 

portrait photographers since

Contact a sales representative or visit our 
website at w w w .studentlist.com  for
additional information

New York
Toil Free 888-462-5600 
Florida
Toll Free 888-550-8548

A m e r ic a n  St u d e n t  L is t

A Service or Euso rscc 4D»

The Most Tru»ted Name In Youth Marketing

\  Nouveau Collection 
BY M a x i m a

Flush mounted or

1 matted, your

v photos come IJP P r

2  alive with Nouveau’s

|  flexible mount system.

^  K a m b a ra  U SA , Inc.
18355 S.W. Teton Avenue.Tualatin, OR 97062

WIN A $3000
HOT ONE SHOPPING 

SPREE!

Enter to win a $ 3 ,0 0 0  
Professional Photographer/
HOT ONE SHOPPING 
SPREE!

Every year. Professional 
Photographer presents 
the coveted HOT ONE 
Award to the best pro imaging products in 
more than a dozen categories.

If you are the winner of our HOT ONE
SHOPPING SPREE, you will have 
the opportunity to select up to $3,000 
worth of our 2007 HOT ONE award­
winning products. Don't miss your 
chance to  be a winner!

DEADUNE TO ENTER: MARCH 30, 2007

GO TO WWW.PPMAG.COM 
TO ENTER

N o purchase necessary to enter or win.
O ffer void where prohibited.

O ffic ial rules and additional de tails  available at 
www.ppmag.com
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SOMETHING HERE 
YOU NEED...

C U STO M  ALBU M S
PRESS P R IN T E D  P R O D U C T S
TR U E  B LA C K  & W H IT E  
D IG IT A L  P R IN T S
S C H O O L. SP O R TS  & 
PA C K A G E P R IN T IN G
G IC LE E  F IN E  A R T  
P R IN T S  &  C A N V A S  _
O N L IN E  O R D E R IN G  
SYSTEM S

1.800.445.0264
D A L L A S  | B W C . N E T

JUIC
nrTTm rm i

O M N I -B O U N C E
Used by Professionals around the world, lo achieve 
soft natural lighting with most of the popular brand flash 
wwls Meal for wide angle shots, macro work, portraits 
and news coverage Custom mounting with no Velcro 
required Specify your strobe when ordering 
Only: $19.95 + $2.00 shipping. Visa & Mastercard 

ST0-FEN PRODUCTS • 800-538-0730 
PO Box 7609. Santa Cru/. CA 95061. USA 1

Painted Portraits/Backdrops
l-eam Corel I ’ainter f f
and art concepLsfrom p  a  t ™
Karen Sperling, or add ' £  ^
her painted backdrops I  4 /  -  A M
to vour photos. P  1
81 8-9 81 -2 80 3 f A,
ksperling@aol.com www .artislRm ag .com

1 • 8 0 0 * 8 4 4 * 5 6 1 6
<yww.photonovelty.com

NOTECARDS
NOW 4 card sizes

to request a FREE SAM PLE call, TOLL FREE

1. 888 .355.2211
w w w .n o teca rd .in fo

V -IilU  I'yJoiUi:

• j-fil-J i'A'jj'jl'j]

American J c s .  
PhotographicResjjjuJCes Inc

Spring props 
galore!

Giant Easter Egg.
Benches, Fences,
Chicks, Geese,
Ducks. Rabbits, 
and M ore1 i

jgjL.1

Free shipping 
on orders 

over S100!

H a n d c r a f t e d  
F l u s h  M o u n t  A l b u m  

T h e  C o f f e e  Ta b l e  B o o k

213.688.8886 v w w v .a rth a n d s in c .c o m

Do it yourself, easy to install and virtually goof proof

Now available from the Picto Store at 
www.pictobooks.com or order by phone!

• 1 888 MYPICTO (697 42861 •

Premium Photo Tile
K e e p s a k e  Boxes!

•  Y o u r P h o to s  On C e ra m ic  T ile  

4 0 %  O ff  F or P h o to g ra p h e rs
• F ree  Sa m p le ! - See W e b s ite !

Piano Finish Boxes - 7 Coats Of High-Gloss Lacquer!"

www.PerceptiveKeepsakes.com

BACK D RO PS
Backdrops that:

• Last longer
• Cost less
• Ship faster
• Give you 

winning photos

F R E E  
C A T A L O G

STUDIO DYNAMICS
7703 Alondra Blvd, Paramount, CA 90723

1-800-595-4273
www.studiodynamics.com

P l a t i n u m  G i c l e e  1
D i g it a l  B l a c k  a W h it e  P r i n t m a k i n g

J o n a t h a n  P e n n e y , I n c . 

631-874-3409 wwwjonathanpenney com

7
u  '  r h k m i h a

^topfiightalbums.com

o— Manufacturing Co., Inc.
lAjatolr P r f  smd !%.+*> I mtUf

The World's Largest Manufacturer of
Backdrop*. Props and Related Studio Accessories.

2006 estates cover shat on ser

Order your FREE catalog today!

800.844.5616
www.dennymfg.com
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Classified Advertising
Classified rates: • $1.50 per word; • $2.00 per word/ 
words with all caps or bold face. • $10.00 per issue— 
Confidential Reply Bo* Ads <0ptional)-$30 minimum 
per ad. Closing date is 20th of the second month pro­

order. NO ADS ACCEPTED BY PHONE. Remittance to 
Professional Photographer Classified Ads, 229 Peachtree 
NE, Ste. 2200, Atlanta, GA 30303; 800-339-5451, ext 
221; FAX 404-614-6405.

ALBU M S

ALBUMS for DIGITAL from GENERAL PRODUCTS
L.L.C. New Eclipse Digital Albums, Digital Vision 
Collection Albums, Custom Album Designer Software and

many traditional album styles. All of our albums are MADE 
IN THE USA General Products albums are available 
exclusively through professional photographers. For a 
FREE catalog or more information, contact G P. at 
wWw.gpalbums.com or 1-800-888-1934.

BACKGROUNDS

THE DENNY MFG. CO., INC. is the World's Largest 
Manufacture of Hand Painted Backgrounds, Computer 
Painted Backgrounds, Muslin Backgrounds, Studio Sets, 
Props, Lift Systems, and related Studio Accessories. 
Contact us today to receive our FREE 180 page color 
catalog filled with exquisite products and ideas to help you 
succeed in Photography. Write P.O. Box 7200 Mobile, AL 
36670; Call 1-800-844-5616 or visit our Web site at

STUDIO DYNAMICS' muslm and canvas backdrops offer 
quality and value at outlet prices! Call 1-800-595-4273

BOSS BACKDROPS-WRINKLE FREE, washable, dryer 
safe, Diffused, light weight, easy to carry & store. Most 
under $100. Free clamps. Call 630-254-1253 or visit us at 
www.bossbackdrops.com

CHICAGO CANVAS 5 SUPPLY-Wide Seamless Canvas and 
Muslin, Duvetyn, Commando Cloth, Theatrical Gauze, Velour, 
Sharkstooth Scrim, Leno Scrim, Gaffers Tape, Primed Canvas, 
Gesso, and Deka Fabric Dyes -  Fabrication Available. Curtain 
Track & Hardware for Moveable Curtains and Backdrops -Easily 
installed. Quick turn around time. Our prices can't be beat. Visit 
our website or call for a free catalog and samples 773-478-5700; 
www.chicagocanvas.com; Email@chicagocanvas.com

CAM ER A REPAIR

HASSELBLAD OWNERS: David S. Odess is a factory 
trained technician with 30 years experience servicing the 
Hasselblad system exclusively. Previously with Victor 
Hasselblad. Free estimates, prompt service, reasonable

South Main St., #104, Randolph, MA 02368, 781-963- 
1166; www.david-odess.com.___________________

CAN VAS M O U NTING

CANVAS MOUNTING, STRETCHING, FINISH LACQUERING. 
Original McDonald Method. Considered best AVAILABLE 
Realistic canvas texture. Large sizes a specialty. 
WHITMIRE ASSOCIATES, YAKIMA, WA. 509-248-6700. 
WWW.CANVASMOUNT.COM

COM PU TER /SO FTW AR E

SUCCESSWARE®— Studio Management Software available 
for both Windows" and Macintosh*. Recommended by 
Ann Monteith, the nation's foremost Studio management 
consultant. Call today for a FREE SuccessWare' Tour 
800-593-3767 or visit our Web site www.SuccessWare.net.

WATERMARK FACTORY-Protect your copyrights by

comments, date-stamps,''eXIF/IPTC info. A must-have 
software for every professional photographer. 

FREE trial version at www.WatermarkFactory.com

Learn how you can revolutionize customer and order tracking 
and ignite your marketing fire with customized software 
that knows what's going on in YOUR business-even when 
you don't I More professional photographers trust Photo 
One Software, powered by Granite Bear than ail other studio

5 days to customize your Photo One to match your studio; 
personalized phone training for you and your staff; 75 minute 
no-hassle guaranteed support call-back time; 365 days of 
unlimited support and usable upgrades and a 365 day unmatched 
money back guaranteel Zero-Risk. Only $299.00 deposit 
gets you started. Call 888-428-2824 now for your free 
working demo or visit www.photoonesoftware.com. Photo

DIGITAL

DIGITAL PHOTOGRAPHERS—Kessler Color produces STUN­
NING images from digital files. Try our rapid FTP site and get a 
FREE 16 x 20. New Service-E-Vents from Kessler Color. Get 
8x10 units for $.90. info@kesslercolor.com. 800-KES-LABS.

SCHOOL PHOTOGRAPHERS— Kessler Color s digital units 
start at $.90 each. Beautiful color and great value! Call 
800-KES-LABS.

ED U C ATIO N /W O R KSHO PS

WALL PORTRAIT CONFERENCE. April 15-20, 2007. Six days 
Wall Portraiture concept to completion. The original wall portrait 
school. Has changed the lives of many! Emphasis on public 
acceptance, concepts, sales, portrait finishing and more 
Yakima, Washington 509-248-6700; www.wallportrait.com

EQ UIPM ENT FOR SALE

NORMAN 200B AND 400B BATTERIES. New
Hi-capacity. Use your original Norman chargers. Kirkham's 
Studio, 235 N. Getty, Uvalde, TX 78801; 800-355-4417 
eddiekirkham@sbcglobal.net, VISA, MC, DISCOVER.

DIGITAL PRINTERS; FUJI-NORITSU; MINILABS; NEW 
5 USED, FACTORY AUTHORIZED. INSTALLATION AND 
TRAINING. FINANCING—$600 UP. DELIVERY-INSURED. 
WWW.DIRECT-RESOURCES.COM; 877-318-3015.

ESECO Speedmaster Paper Processor 
Model 56 RA 50 T 4-Tank (Waterless Wash) 

ROLLMA
Auto paper & film dispenser/cutter, Model AS 12” Wide 

SPEEDMASTER Digital Color Analyzer 
Model SM800A

4-Bronica SQ-A bodies & backs
5- Bronica PS 150 mm lenses
6- Bronica PS 80 mm lenses

3-Fuji GW 690111
e-mail for more details photobabes@myactv.net

CHILD PROPS FOR SALE-PHOTOGENIC FLASHMASTER 
LIGHTING EQUIPMENT; PHOTOGENIC POWERLIGHTS.
Please tell me what you are interested in, I can send 
pictures. Please e-mail R_M_P@msn.com

HELP W ANTED

STUDIO / FASHION / SPORTS PHOTOGRAPHER
Due to our overwhelming growth Woodard Photographic is 
seeking career oriented, experienced professional photog­
raphers to join our high end portrait studios,

• Minimum of 2 years experience in studio, fashion, and 
candid photography,

• Digital photography experience is required, leadership

• Full time, year round positions including nights and weekends
• No overnight travel or underclass
• Positions available in Columbus, Cleveland and Toledo Ohio

Compensation is commensurate with experience. Submit 
resume by email to Jennifer@Woodardphoto.com or fax to 
419-483-5505, attn Jennifer Sheba.

HELP WANTED: Assistant photographers for contem­
porary photojournalistic wedding coverages in SoCal. Must 
have digital SLR and flash. Wedding experience preferred. 
Contact John 562-404-7822.

INCORPORATION SERVICES

INCORPORATE OR FORM an LLC today! Your art is 
a business. Treat it like one. The Company Corporation can 
help you incorporate or form a limited liability company in 
as little as ten minutes. We are fast, accurate and

of usfngVn attorney. Call 1-800-206-7276 or visit

LAB SERVICES

ACADEMY PRODUCTIONS INC. 
INNOVATIVE PRINTING SOLUTION

Complete Imaging Service for today's professional 
photographer Processing—Proofing—Film—Digital Files 

-SOS-
Self Ordering System powered by ROES
• High Volume Packages — Kodak Products

• Schools — Daycares — Sports — Proms — Seniors
• Studios — Store Promotions — Fundraisers—Weddings

• Composites — Collages— Other Unique Products 
• High Tech Printing Equipment-Scanning Services

• Free Marketing Seminars-Expert Product Designers 
Superior Customer Service-Detailed Technical Support

• Competitive Pricing-Quick Turn Around
CALL US TODAY. 800-421-3523 

6100 ORR ROAD • CHARLOTTE, NC 28213 
www.PicAcademy.com

FREE 20X30
Wallets to 6"xl4"

Goldencolor 9020 W. Olympic Blvd.
Beverly Hills, CA 90211 

310-274-3445 www.goldencolor.com

PECHMAN PROFESSIONAL IMAGING
(Digital or Film)

Portraits & Units 8x10
Prints-By-Inch $1.45
Studio-Color-Corrected $1.90
Lab-Color-Corrected $2.57
Raw-File-Services $3.15
• Undergrad-Sport-Event Pkgs. 8x10 @
• Fully Assembled Albums-lOxlO prints

16x20
$5.80
$11.99
$13.99
$16.40
$.96,

induded-9 to 18 pages from $149.99,

•Proofs from $.25,
•Proof Books-spiral bound- 8x10 page @ $1.60, 
•48 Wal Gold Stamp Special-next 48 free, 
•Spray— Mount—Texture,
•Digital Retouch $2.50, Art-$1.00 per minute

LABPRINTS, PROSHOTS, FTP OR DISK.
800-777-0221 www.Pechmanlmaging.com

PLATINUM GICLEE™ FINE ART B&W from your digital 
file or negative up to 40 x 60. New DuraFiber™ Media pro­
vides deep blacks and waterproof, non-scuff-surface, great 
for hand-coloring. Also available in sepia, color, split-tone. 
Call for free sample. Jonathan Penney, Inc., Master 
Printmakers. 631-874-3409. www.jonathanpenney.com

HAND PAINTED OILS; Transparent, Deluxe, and Canvas 
Stretched up to 40x60. A complete photo art lab serving 
photographers since 1965. Traditional and Digital printing 
services Fiber based B&W up to 30x40. Gidee Fine Art 
prints. Restoration. Free estimates & pricing guide. 800- 
922-7459 Venetian Arts www.venetianarts.com

SPORTS PHOTOGRAPHERS The most versatile sports 
program available. Digital or film, quality & service is our 
motto. See www.sportsphoto.cbm

v.ppmag.c
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UNITED PROMOTIONS, INC.
• FULL SERVICE DICITAL & FILM LAB- 

10% DISCOUNT from our low List Price for prebuilt orders 
submitted in ROES (free software). Photolynx, OzE,

site, FTP or on CD's Fast Delivery. Wallets to 40" wide prints. 
VOLUME PACKAGE PRINTS - Pre Schools, Day 

Cares, Underclass, Proms/Dance, Cap &
Gown, Store/Malls, Glamour, Church, Fund 
Raising and Family Packages.

SPORTS & EVENT PACKAGE PRINTS 
WEDDING - SENIORS - CANDID - STUDIO PRINTS 
ADD ONS TO ORDERS Retouching, Proofs on 

Envelopes, School Service Items, CD's, Fun Packs 
(laminated & die cut), Plastic ID Cards, Groups, Big 
Prints, Composites, Trader Cards (2 sides), Magazine 
Covers, Memorymates, Digital Groupmates, Photo 
Magnet Cutouts, Statuettes, Buttons, Magnets, 
Mirrors, Calendars, Locker Prints, Photo Pennants, 
Mouse Pads, Fun Posters, Admission Tickets, Sticker 
Prints, Banner Prints, Collages, Cold Foil Stamping 
Laminating, Mounting, Posting Images Online and many 
more services for the professional photographer.

NEW PRODUCTS - Dye-Sub Photo Plaques and 
Gallery Wraps on Canvas,

UNITED PROMOTIONS, INC.
433 Lawton Road 

Charlotte, NC 28216-3317 
(800) 362-4441 - Toll Free

sales@upilab com

M AR KETIN G

Finally, a monthly client newsletter that's DONE FOR 
YOU! Go to www.TheStudioNewsletter.com and test-

PH O TO  RESTO RATIO N

1st PHOTO RESTORATION FREE! Try us, you'll like us! 
Point & click easy. No sign up cost. 100% guarantee. 
Online leader since 1993. Wholesale only to professionals. 
www.hollywoodfotofix.com or call 888-700-3686.

PH O TO  SU PPLIES

KODAK PHOTO PAPER
5 X 577 SUPRA ENDURA E-200 ROLLS 

5 X 577 PORTA III E-60 ROLLS 
3 1/2 X 577 PORTA III E-400 ROLLS 

MAKE OFFER FOR PART OR ALL. 
CALL AARON AT 660-826-1764

PRESEN TATIO N  BO XES

BOXES-FREE SAMPLE PRESENTATION BOX-FROM 
THE ORIGINAL BLACK BOX MANUFACTURE-Fast
delivery. Finest quality 4"x5“, 5"x5", 4"x6", 8"xl0“, 
11" x 14", 16"x20", 20"x24 AUFENGER BOX, 4800 COLLEY 
AVENUE, NORFOLK, VIRGINIA 23508; 757-440-1147 
(phone); 757-440-1149 (fax); 888-440-1146 (toll free).

PRESENTATION BOXES available for immediate shipment, 
19 sizes— 4 stock colors. For FREE catalog & samples call 
800-969-2697 or fax request 800-861-4528. BUY 
DIRECT AND SAVE. NPD Box Company, 3000 Quigley 
Road, Cleveland, OH 44113. www.NPDBox.com

BOX MANUFACTURER-EASY ORDER website Powered by 
Paypal. Buy direct and Save. A Complete line of Print and 
Proof Boxes, DVD Solutions. Better quality, better prices. 
All print boxes pre-loaded with tissue and loops, pick your 
color. Add logo, or change colors for easy Customizing, H- 
B Packaging Group 401-725-3646 www.h-bphoto.com

RETO UCHING

WHEN YOUR NAME is on the line, nothing but the

altered and the lowest prices in the industry. If you demand 
the best log onto www.retouchup.com and your first 10 
retouches are free just to prove our claims— the best— the 
fastest and the least expensive or call 801 -358-5864

SALES A ID S

BOXES-FROM THE ORIGINAL BLACK BOX MANU­
FACTURE-FREE SAMPLE-Fast delivery, Finest quality 
4"x5", 5"x5", 4"x6", 8"xl0" H"xl4", 16"x20", 20"x24". 
AUFENGER BOX, 4800 COLLEY AVENUE, NORFOLK, 
VIRGINIA 23508; 757-440-1147 (phone); 757-440-1149 
(fax); 888-440-1146 (toll free), www.aufengerbox.com

CREATIVE FRAMES...Our NEW FREE CATALOG, 
designed for wedding and portrait photographs is here! We

mfo@creativeframe.com or call 888-673-3386.

5000 PHOTO BUSINESS CARD for $69.95, 5000 Flyers 
for $159. Shipping $20. Phone 877-895-4990.

S T U D IO  FOR SALE

AMAZING OPPORTUNITY for motivated photographer(s) to 
own a vibrant, established portrait business. Enjoy an abundant 
lifestyle in this fast-growing Colorado community. Photograph 
outdoors 347 days each year! Only $99K makes you the owner. 
Turnkey. Complete details from retiring owner, davis@dhdavis.com.

Are you a PORTRAIT PHOTOGRAPHER who loves to 
shoot but hates to keep the books and generate business? 
My NORTHERN CALIFORNIA high-end studio has 
been in operation for 55 years and is well established 
and respected in the community. My loyal staff of three

the business fully. Gross $435,000 annually and work 
four days a week! Need help transitioning into business 
owner, I can work for you. Terms Negotiable, contact 
kjpix@sbcglobal.net

ST U D IO S W AN TED

COLUMBUS CAMERA GROUP, INC. buys whole studios 
or any part including cameras, film, darkroom, long roll, 
lighting, and misc. No quantities too small. Call 800-325- 
7664. Ask for Eric.

YEAR BO O KS

ELEMENTARY & MIDDLE SCHOOL Yearbook Printing 

www.yearbookpros.com; 800-643-5376.

March 2007 • Professional Photographer • 145

http://www.TheStudioNewsletter.com
http://www.hollywoodfotofix.com
http://www.NPDBox.com
http://www.h-bphoto.com
http://www.retouchup.com
http://www.aufengerbox.com
mailto:mfo@creativeframe.com
mailto:davis@dhdavis.com
mailto:kjpix@sbcglobal.net
http://www.yearbookpros.com


good works

rights to tlie images so the families could 

copy and distribute them however they 

wanted. The appreciation the recipients dis­

played was beyond Eskridge’s and her fel­

low AZPPA members’ imagining. “At one 

point I looked over at the director o f the 

Golden Gate Community Center, and she 

looked so sad," says Eskridge. “ I walked up 

and asked her what was wrong, and she 

started crying. She said no one had ever 

done anything as special as this for the cen­

ter or for the neighborhood. She was just 

overwhelmed.”

In addition to the warm response to their 

contribution, the participating photogra­

phers were treated to a day o f professional 

bonding with their fellow image-makers. “It 

was amazing to see all o f  these talented pho­

tographers give up time with their families 

on a Sunday and team up to accomplish this 

project," says Eskridge. “When there would 

be a lull at one station, people would go over 

and see what another photographer was 

doing. When things got a little slow around 

the noon hour, we did an impromptu light­

ing and (xising seminar, where several pho­

tographers got up and talked about their 

techniques. It was just great experience.” ■  

-JeffKent

For more information on the Golden 
Gate Community Center, visit 
Teierw.goldengatecenter.org. AZPPA's home 
page is at www.arizimappa.com.

S hare  y o u r goo d  w o rk s  e xperience  w ith  us 
by e -m a ilin g  C am eron  B is h o p p  a t 
cb ish o pp @ p p a.co m

A day of sm iles
WHEN PHOTOGRAPHERS TEAM WITH CHARITABLE 
ORGANIZATIONS, GREAT THINGS CAN HAPPEN

fam ilies in the community, and donate the 

photographs to the families. Marshalling 

resources and volunteers from  A Z PPA , 

Eskridge launched a massive portrait sitting. 

Families who came to the center to  be pho­

tographed would receive a 5x7 image in a 

nice till io, all free o f  charge.

The event took place on the last Sunday 

in September 2006. A ZPPA  set up eight por- 

trait stations, each staffed by three or four 

photographers. Many o f  the families who came 

to the center had never been aide to afford por­

traits. A  lair in the area. Greenway Moto Photo, 

donated the 5x7 prints, and D N L  Photo 

Packaging provided the complimentary folios.

s a member o f  the Golden Gate Guild,

Kay Eskridge. M.Photog.Cr., CPP, w orks 

with other wom en to support the 

Golden Gate Community Center in 

Phoenix. T h e  center is in a low-

J H~.I-U'<niie :Ut a ^ 'at *';LS 1,0 commu"
nity support organizations. Eskridge is also 

a board mem ber o f  Arizona Professional 

Photographers Association (A Z P P A ). Last 

year when the association began looking for 

a beneficiary fo r a philanthropic effort. 

Eskridge knew just the organization.

Eskridge came up with a project she named 

“A  Day o f  1.000 Smiles." The goal was to 

photograph 1,000 smiles on the faces o f
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800.821.1305 www.hhcolorlab.com

http://www.hhcolorlab.com


The end of digital exposure problems!

© Sekonic L-758dr d ig it a lm a s t e r
How much highlight or shadow details are you really getting in your 

digital exposures? Stop wondering. With the world’s first programmable 

light meter you’ll know before you take the shot. The L-758dr can learn 

to respond to light just like your digital camera and alert you if you've 

exceeded its limits. Now you can nail the shot the first time with unsurpassed

accuracy and quality.

O Four Meters In One 

) Digital Camera Exposure Profiling 

)  Dynamic Range Display 

) Pre-Exposure Warning

O Wireless Triggering built-in

Learn more Sekonic.com

POWER AVE./AEV

MID. TONE M.CLEAR

L *7 5 8 d r j
DWTAMASTER

—  I


